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บทคัดย่อ 
การวิจัยในครั้งนี้มีวัตถุประสงค์เพ่ือ 1) พัฒนาแผนจัดการเรียนรู้ที่มีการออกแบบเป็นฐาน

ร่วมกับบทเรียนออนไลน์ เพ่ือส่งเสริมการพัฒนาผลสัมฤทธิ์ทางการเรียนรู้ด้านความรู้และทักษะ เรื่อง 
การสร้างเว็บไซต์ด้วยภาษา HTML5 2) พัฒนาบทเรียนออนไลน์ เรื่องการสร้างเว็บไซต์ด้วยภาษา 
HTML5 ให้มีคุณภาพและประสิทธิภาพ 3) เพ่ือเปรียบเทียบผลสัมฤทธิ์ทางการเรียนด้านความรู้และ
ทักษะ เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ระหว่างกลุ่มที่เรียนด้วยแผนการจัดการเรียนรู้โดย
ใช้การออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์กับกลุ่มที่เรียนด้วยแผนการจัดการเรียนรู้แบบปกติ  
กลุ่มตัวอย่างในการวิจัยคือ นักเรียนชั้นมัธยมศึกษาปีที่ 6 โรงเรียนศรัทธาสมุทร จังหวัดสมุทรสงคราม 
จ านวน 3 ห้องเรียน 120 คน ซึ่งได้จากการสุ่มตัวอย่างแบบแบ่งกลุ่ม ( Cluster Random Sampling ) 
เครื่องมือที่ใช้ในการวิจัยครั้งนี้ประกอบด้วย แผนการจัดการเรียนรู้ โดยใช้การออกแบบเป็นฐาน 
บทเรียนออนไลน์เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 แบบประเมินคุณภาพของแผนการจัดการ
เรียนรู้ แบบประเมินคุณภาพของบทเรียนออนไลน์ แบบวัดผลสัมฤทธิ์ด้านพุทธิพิสัย และใบงานวัด
ผลสัมฤทธิ์ด้านทักษะพิสัย สถิติที่ใช้ในการวิเคราะห์ข้อมูล ได้แก่ ค่าเฉลี่ย (x)̅ ค่าเบี่ยงเบนมาตรฐาน 
(S) และใช้สถิติการวิเคราะห์ความแปรปรวนพหุคูณ (MANOVA) โดยใช้สูตรของ Wilk’s Lambda  
ผลการวิจัยพบว่า 1) คุณภาพของแผนการจัดการเรียนรู้ที่พัฒนาขึ้นอยู่ในระดับดีมาก ( x ̅= 4.44, S = 
0.65 ) 2) คุณภาพของบทเรียนออนไลน์ อยู่ในระดับดี ( x ̅= 4.31, S = 0.49 ) และประสิทธิภาพของ
บทเรียนออนไลน์มีค่า E1/E2 เท่ากับ 80.26/81.54 3) นักเรียนกลุ่มที่เรียนด้วยแผนการจัดการเรียนรู้
โดยใช้การออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 มี
ผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัยและทักษะพิสัยมากกว่ากลุ่มที่เรียนด้วยแผนการจัดการเรียนรู้
แบบปกต ิอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 
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ABSTRACT 
The purposes of this research were 1) to develop lesson plan using design-

based learning with e-learning to enhance the learning achievement in both 
knowledges and skills on Creating Website with HTML5, 2) to develop an e-learning on 
Creating Website with HTML5 that had both quality and efficiency, and 3) to compare 
the learning achievement in both knowledges and skills on Creating Website with 
HTML5 between the students who learned with the developed lesson plan and the 
students who learned through a traditional method. The samples were 120 Grade 12 
students from 3 classrooms of Satthasamut School, Samutsongkhram, which were 
selected using Cluster Random Sampling. The research instruments consisted of 1) 
lesson plan using design-based learning, 2) e-learning on Creating Website with HTML5, 
3) the quality evaluation form of the developed lesson plan, 4) the quality evaluation 
form of the developed e-learning, 5) the achievement test of knowledge part, and 6) 
the achievement test of skill part. The statistic used in the analysis were mean (x)̅, 
standard deviation (S) and multivariate analysis of variance statistics (MANOVA) by using 
the formula of Wilk’s Lambda. The result of this research revealed that 1) the quality 
of the developed lesson plan was at very good level (  x ̅= 4.44, S = 0.65 ), 2) the 
quality of the developed e-learning was at good level (  x ̅= 4.31, S = 0.49 ) while the 
efficiency of the developed e-learning in E1/E2 = 80 .26 /81 . 54 , which was consistent 
with the expected criteria, and 3) the learning achievement in both knowledge and 
skill of the students learning through lesson plan using design-based learning combine 
with e-learning on Creating Website with HTML5 was significantly higher than that of 
regularly instructed group at .05 level. 
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กิตติกรรมประกาศ 
 

วิทยานิพนธ์ฉบับนี้ส าเร็จลุล่วงได้ด้วยความอนุเคราะห์จากสถาบันส่งเสริมการสอน
วิทยาศาสตร์และเทคโนโลยี (สสวท.) โครงการส่งเสริมการผลิตครูผู้มีความสามารถพิเศษทาง
วิทยาศาสตร์และคณิตศาสตร์ (สควค.) ที่ได้ให้ทุนสนับสนุนในการท างานวิจัย  รวมถึง ผู้ช่วย
ศาสตราจารย์ ดร.ฐิยาพร กันตาธนวัฒน์ อาจารย์ที่ปรึกษาวิทยานิพนธ์ และ ผู้ช่วยศาสตราจารย์ ดร.
สมเกียรติ ตันติวงศ์วาณิช อาจารย์ที่ปรึกษาวิทยานิพนธ์ร่วม ที่ได้กรุณาให้ค าแนะน า ช่วยเหลือ และ
ช่วยตรวจสอบแก้ไขข้อบกพร่องต่างๆ จนวิทยานิพนธ์ฉบับนี้ส าเร็จได้อย่างสมบูรณ์ 

ผู้วิจัยรู้สึกซาบซึ้งในความกรุณา และขอขอบพระคุณเป็นอย่างสูง ขอขอบพระคุณ 
คณะกรรมการการสอบวิทยานิพนธ์ทุกท่าน ที่ได้กรุณาให้ค าแนะน า ตรวจสอบ แก้ไขข้อบกพร่อง
ต่างๆ ในขั้นตอนสุดท้ายจนท าให้วิทยานิพนธ์ฉบับนี้มีความสมบูรณ์ถูกต้อง 

ขอขอบพระคุณผู้ทรงคุณวุฒิ  รองศาสตราจารย์  ดร .ปริยาภรณ์  ตั้ งคุณานันต์   
ผู้ช่วยศาสตราจารย์ ดร.อัคพงศ์ สุขมาตย์ ผู้ช่วยศาสตราจารย์ แสงอุทัย มอโท ผู้ช่วยศาสตราจารย์ 
ดร.กฤษณา คิดดี ผู้ช่วยศาสตราจารย์ ดร.ธนินทร์ รัตนโอฬาร ผู้ช่วยศาสตราจารย์ ดร.ศิริรัตน์  
เพ็ชร์แสงศรี ดร.จิรารัตน์ สิทธิวรชาติ รองศาสตราจารย์ อรรถพร ฤทธิเกิด รองศาสตราจารย์  
ดร.ไพฑูรย์ พิมดี รองศาสตราจารย์ ดร.บุญจันทร์ สีสันต์ และอาจารย์สราวุธ วงษ์จู ที่ได้กรุณา
ช่วยเหลือให้ค าแนะน าและตรวจสอบแก้ไขข้อบกพร่องต่างๆ ของเครื่องมือในการวิจัยครั้งนี้ เพ่ือปรับ
ปรุงให้มีคุณภาพและประสิทธิภาพเหมาะสมต่อการวิจัย 

ขอขอบพระคุณ นายธัตถพล คชสาร ผู้อ านวยการโรงเรียนศรัทธาสมุทร ที่ได้ให้ความ
อนุเคราะห์ผู้วิจัยในการฝึกสอน ปฏิบัติงาน และอนุญาติให้เก็บรวบรวมข้อมูลท างานวิจัยภายใน
โรงเรียน ร่วมกับคุณครูและบุคลากรในโรงเรียนศรัทธาสมุทรทุกท่าน รวมทั้งขอขอบใจนักเรียน
โรงเรียนศรัทธาสมุทร ที่ได้ให้ความร่วมมือในการเป็นกลุ่มตัวอย่างให้กับผู้วิจัยได้เก็บรวบรวมข้อมูลใน
การวิจัยได้เป็นอย่างดี 

ท้ายที่สุดก็ต้องขอขอบพระคุณบิดา มารดา ญาติพ่ีน้องต่างๆ รวมถึงผู้มีพระคุณทุกท่านที่
ไม่ได้กล่าวมา ณ ที่นี้ ที่ได้ให้ค าปรึกษา ให้การสนับสนุนในด้านต่างๆ ที่เป็นก าลังใจ และให้ความ
ช่วยเหลือด้วยดีเสมอมา 

คุณค่าและประโยชน์อันพึงมีจากวิทยานิพนธ์ฉบับนี้ ผู้วิจัยขอมอบแด่ผู้มีพระคุณทุกท่าน
ด้วยความเคารพยิ่ง หากมีข้อผิดพลาดประการใด ผู้วิจัยขออภัยมา ณ ที่นี้ด้วย 
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บทท่ี 1 
บทน า 

 
1.1  ความเป็นมาและความส าคัญของปัญหา 
 

โลกของเราในปัจจุบันได้ก้าวมาสู่ยุคที่มีหลายสิ่งหลายอย่างเกิดการเปลี่ยนแปลงอย่าง
รวดเร็วหรือที่เราเรียกกันว่า “ยุคโลกาภิวัตน์” (วรพจน์ วงศ์กิจรุ่งเรือง. 2553: 27-45) ท าให้หลาย
ประเทศได้รับผลกระทบจนต้องรีบเร่งในการพัฒนาด้านต่างๆ เพ่ือให้ประเทศของตนก้าวทันตามการ
เปลี่ยนแปลงที่รวดเร็วนี้ได้ รวมทั้งสามารถที่จะไปแข่งขันกับหลายประเทศในระดับโลกได้ การศึกษา
เองก็เป็นหนึ่งในด้านที่ได้รับผลกระทบจนท าให้หลายประเทศต้องมาพัฒนาตามให้ทันการ
เปลี่ยนแปลงนั้นเช่นกัน ในระหว่างการพัฒนานั้นท าให้เกิดแนวคิดใหม่เพ่ือรับมือกับยุคที่มีการเปลี่ยน
อย่างของหลายสิ่งอย่างรวดเร็วนี้ ซึ่งก็คือแนวคิด “ทักษะที่จ าเป็นในศตวรรษที่ 21” (วรพจน์ วงศ์กิจ
รุ่งเรือง และอธิป จิตตฤกษ์. 2556: 18-23) ที่จะตั้งเป้าไปที่การพัฒนาเด็กสมัยใหม่ที่จะเกิดมาให้
สามารถรับมือกับสิ่งต่างๆ ที่จะเกิดขึ้นในอนาคตข้างหน้าด้วยตนเองได้ ประเทศไทยเองก็เป็นหนึ่งใน
หลายประเทศที่ได้รับผลจากการเปลี่ยนแปลงนี้เช่นกัน ซึ่งในด้านการศึกษากระทรวงศึกษาธิการก็ได้
ท าการปรับหลักสูตรส าหรับระบบการศึกษาในประเทศใหม่ โดยการน าเอาแนวคิดเกี่ยวกับทักษะที่
จ าเป็นในศตวรรษที่ 21 เข้ามาเพ่ือพัฒนานักเรียนให้สามารถรับมือกับอนาคตในยุคโลกาภิวัตน์ได้ โดย
การน าแนวคิดเกี่ยวกับการพัฒนาการศึกษาจากต่างประเทศมาให้ทางโรงเรียนทั่วประเทศได้น าไปใช้ 
ทางโรงเรียนศรัทธาสมุทรซึ่งเป็นโรงเรียนที่ผู้วิจัยได้ไปฝึกสอนก็ได้มีการน าเอาแนวคิดดังกล่าวมาใช้ใน
การเรียนการสอนเช่นกัน 

ผู้วิจัยได้รับมอบหมายให้จัดการเรียนรู้ในรายวิชา การสร้างเว็บไซต์ ของนักเรียนชั้น
มัธยมศึกษาปีที่ 6 โรงเรียนศรัทธาสมุทร จังหวัดสมุทรสงคราม สังกัดส านักงานเขตพ้ืนที่การศึกษา
มัธยมศึกษาเขต 10 จึงได้ท าการสัมภาษณ์ครูผู้สอน (สราวุธ วงษ์จู. 2561: สัมภาษณ์) เกี่ยวกับรายวิชา
การสร้างเว็บไซต์ สรุปได้ว่าการสร้างเว็บไซต์มีเนื้อหาที่ยากส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 6 
เนื่องจากนักเรียนต้องใช้ความรู้ในหลายด้านมาบูรณาการเข้าด้วยกัน ตั้งแต่การจ าแท็กค าสั่ง การจ า
รูปแบบการเขียนของแต่ละภาษา ค าสั่งที่ใช้ในการปรับแต่งหน้าเว็บ ไปจนถึงการจัดวางรูปแบบ
เว็บไซต์ ท าให้ค่าเฉลี่ยของคะแนนสอบของนักเรียนหลายคนทั้งในภาคทฤษฎีและภาคปฏิบัตินั้นต่ า
กว่าเกณฑ์ที่ก าหนดไว้ แสดงให้เห็นว่านักเรียนส่วนใหญ่ยังขาดความรู้ ความเข้าใจ และทักษะในการ
สร้างเว็บไซต์ รวมทั้งความคิดสร้างสรรค์ในการออกแบบเว็บไซต์ เมื่อทราบปัญหาของรายวิชาจากทาง
โรงเรียนที่ไปฝึกสอน ท าให้ผู้วิจัยไปศึกษางานวิจัยทั้งในประเทศไทยและต่างประเทศเพ่ือหาวิธีการท า
ให้นักเรียนสามารถเรียนวิชาการสร้างเว็บไซต์ให้ได้ทั้งความรู้ ความเข้าใจ และสามารถใช้ความคิด
สร้างสรรค์ในการออกแบบชิ้นงานเว็บไซต์ตามท่ีคิดได้  

จากการศึกษาวิจัยที่เกี่ยวข้องทั้งในประเทศไทย ได้แก่ วิจัยของ ปิยาภรณ์ พุ่มแก้ว และ
คณะ(2560: 49-59) เกี่ยวกับการพัฒนาครูด้านการออกแบบการจัดการเรียนรู้บนฐานความต้องการ
ของผู้เรียน วิจัยของ รัตตมา รัตนวงศา (2559: 3-20) เกี่ยวกับการพัฒนารูปแบบการเรียนการสอนใน
สภาพแวดล้อมแบบเกมมิฟิเคชันโดยใช้การออกแบบเป็นฐานร่วมกับเครื่องมือทางทัศนะเพ่ือส่งเสริม



2 
 

 

การรู้ทางทัศนะและแรงจูงใจใฝ่สัมฤทธิ์ส าหรับนิสิตนักศึกษาระดับปริญญาบัณฑิต และวิจัยของ ลือชา 
ลดาชาติ และลฎาภา ลดาชาติ (2561: 246-260) เกี่ยวกับจากการรู้วิทยาศาสตร์และการสืบเสาะสู่สะ
เต็มศึกษาและการออกแบบ และงานวิจัยจากต่างประเทศ ได้แก่ วิจัยของ Bekker et.al. (2015: 29-
38) เกี่ยวกับการสอนความรู้เกี่ยวกับดิจิตอลกับเด็กผ่านการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน
ด้วยเครื่องมือดิจิตอลในโรงเรียน วิจัยของ Chandrasekaran et.al. (2013: 1109-1118) เกี่ยวกับ
การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานมุ่งเน้นด้านโครงการมาช่วยในการปรับมุมมองของ
นักเรียนให้ตรงกับความต้องการด้านอุตสาหกรรม วิจัยของ Fengfeng Ke (2014: 26-39) เกี่ยวกับ
การประยุกต์ใช้การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานผ่านการสร้างเกมส์คอมพิวเตอร์ส าหรับ
การศึกษา กรณีการเรียนคณิตศาสตร์ระหว่างการออกแบบและการค านวณ วิจัยของ Mehalik et.al. 
(2013: 71-85) เกี่ยวกับการเรียนวิชาวิทยาศาสตร์ในระดับมัธยมศึกษาตอนต้นเปรียบเทียบระหว่าง
การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานกับการเรียนแบบค้นหาตามต ารา และวิจัยของ Yaron 
Doppelt (2007: 55-65) เกี่ยวกับการประเมินความคิดสร้างสรรค์ในการจัดการเรียนรู้โดยใช้การ
ออกแบบเป็นฐาน ซึ่งจากการศึกษางานวิจัยเหล่านี้ท าให้ได้พบแนวคิดการจัดการเรียนแบบใหม่ใน
ต่างประเทศที่มีชื่อว่า “การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน” ซ่ึงเป็นแนวคิดที่เน้นให้
นักเรียนได้น าเอาความรู้ที่ได้มาใช้ในการออกแบบสร้างสรรค์ชิ้นงานตามความคิดของตัวเอง ซึ่งเหมาะ
กับกลุ่มวิชาที่เน้นในการสร้างสรรค์ชิ้นงานตามความคิด เพ่ือช่วยให้เกิดความสนุกสนานในการเรียนรู้
และเสริมสร้างการพัฒนาทักษะที่จ าเป็นของนักเรียนในศตวรรษที่ 21 ทั้งทักษะวิชาพ้ืนฐาน ทักษะ
การสื่อสาร และทักษะในการร่วมมือกันระหว่างคนในกลุ่ม  

นอกจากนั้นการใช้งานเทคโนโลยีในทางการศึกษาในยุคที่มีอินเทอร์เน็ตถูกใช้งานอย่าง
กว้างขวาง ท าให้มีเทคโนโลยีใหม่ๆออกมาให้ใช้งานอยู่อย่างมากมายหลายรูปแบบไม่ว่าจะเป็น
สื่อคอมพิวเตอร์ช่วยสอน หรือแหล่งการเรียนรู้ออนไลน์ E-Learning ที่ท าให้การเรียนการสอนเป็น
เรื่องง่ายมากขึ้น จากการสัมภาษณ์ครูผู้สอน (สราวุธ วงษ์จู. 2561: สัมภาษณ์) เกี่ยวกับเรื่องเทคโนโลยี
ทางการศึกษาภายในโรงเรียน พบว่า ทางโรงเรียนศรัทธาสมุทรได้มีการใช้งาน Google Apps ส าหรับ
การศึกษา แต่ก็ยังไม่แพร่หลายเนื่องจากมีเพียงครูบางกลุ่มที่ใช้งานได้ ผู้วิจัยจึงได้น าเอาเทคโนโลยี 
Google Apps ส าหรับการศึกษา ซึ่งเป็นบทเรียนออนไลน์มาใช้งานเพ่ือส่งเสริมการใช้งานเทคโนโลยี
การศึกษาภายในโรงเรียนเพ่ือช่วยในการพัฒนาการเรียนการสอนให้มีรูปแบบหลากหลายยิ่งขึ้น 
เนื่องจากแนวคิดการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานเป็นการเรียนการสอนที่เน้นให้นักเรียน
ได้น าเอาความรู้ที่ได้มาใช้ในการออกแบบสร้างสรรค์ชิ้นงานตามความคิดของตัวเอง การสร้างบทเรียน
ออนไลน์ที่ท าให้นักเรียนสามารถเข้ามาเรียนรู้ได้ด้วยตนเองเพ่ือทบทวนหรือเรียนรู้เพ่ิมเติม จน
สามารถน าไปปรับปรุงแก้ไขหรือเพ่ิมเติมต่อยอดชิ้นงานของตนเองได้ จึงเป็นการสนับสนุนแนวคิดการ
จัดการเรียนรู้นี้ 

จากการศึกษางานวิจัยสามารถสรุปได้ว่า การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานเป็น
รูปแบบการจัดการเรียนรู้แบบใหม่ที่สามารถน าไปใช้ได้หลากหลายรูปแบบ ที่สามารถน าไปประยุกต์
ในกับวิชาที่เน้นไปทางการออกแบบหรือใช้ความคิดสร้างสรรค์ได้การสร้างผลงานขึ้นมา หรืออาจจะ
เป็นการท าโครงการในวิชาพ้ืนฐาน ซึ่งการจัดการเรียนรู้รูปแบบนี้นิยมใช้กับนักเรียนตั้งแต่ระดับ
ประถมศึกษา มัธยมศึกษา ไปจนถึงระดับอุดมศึกษา โดยผลลัพธ์ที่ได้ในงานวิจัยได้ท าให้นักเรียนมี
ความสนใจในวิชามากขึ้น พัฒนาความคิดสร้างสรรค์ของนักเรียนในการออกแบบชิ้นงาน รวมทั้งการ
หาความรู้เพิ่มเพ่ือน าไปปรับปรุงงานถ้าได้ชี้แนะแหล่งเรียนรู้เพ่ิมเติม ทั้งหมดนี้จึงเป็นที่มาของงานวิจัย
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เรื่อง ผลการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์ ที่มีต่อผลสัมฤทธิ์
ทางการเรียน เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ชั้นมัธยมศึกษาปีที่ 6 
 
1.2  วัตถุประสงค์ของการวิจัย 

 
1. เพ่ือพัฒนาแผนจัดการเรียนรู้ที่มีการออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์ เพ่ือ

ส่งเสริมการพัฒนาผลสัมฤทธิ์ทางการเรียนรู้ด้านความรู้และทักษะ เรื่อง การสร้างเว็บไซต์ด้วยภาษา 
HTML5 ของชั้นมัธยมศึกษาปีที่ 6 

2. เพ่ือพัฒนาบทเรียนออนไลน์ เรื่อง “การสร้างเว็บไซต์ด้วยภาษา HTML5” ให้มีคุณภาพ 
และประสิทธิภาพ 

3. เพ่ือเปรียบเทียบผลสัมฤทธิ์ทางการเรียนด้านความรู้และทักษะ เรื่อง การสร้างเว็บไซต์
ด้วยภาษา HTML5 ระหว่างกลุ่มที่เรียนด้วยแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานร่วมกับ
บทเรียนออนไลน์กับกลุ่มที่เรียนด้วยแผนการจัดการเรียนรู้แบบปกติ 

 
1.3  สมมุติฐานของการวิจัย 

 
นักเรียนที่เรียนด้วยการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์ 

จะมีผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัยและทักษะพิสัย เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 
สูงกว่ากลุ่มที่เรียนด้วยแผนการจัดการเรียนรู้แบบปกติ 

 
1.4  กรอบแนวคิดที่ใช้ในการวิจัย 

 
1.4.1 การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน 
ผู้วิจัยได้ใช้การจัดกิจกรรมการเรียนรู้ โดยใช้การออกแบบเป็นฐาน (Design-Based 

Learning) มาเป็นแนวทางในการจัดการเรียนรู้ โดยใช้กรอบแนวคิดในการออกแบบและพัฒนาการ
จัดการเรียนรู้ของ Doreen Nelson (1980: Online) ชื่อ กระบวนการคิดย้อนกลับ 6 ขั้นตอนครึ่ง 
(The 6 ½ Steps of Backwards Thinking) แตผู่้วิจัยใช้เพียง 6 ขั้นตอนดังต่อไปนี้ 

1. ต้องการที่จะสอนอะไร 
2. ระบุปัญหาจากบทเรียน 

1/2 หาในแบบที่ไม่เคยพบเห็นมาก่อน 
3. ตั้งเกณฑ์การประเมิน 
4. ให้นักเรียนได้ลองท า 
5. สอนเนื้อหาพ้ืนฐานให้ 
6. ให้นักเรียนได้ปรับแก้งานของตน  
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1.4.2 การพัฒนาแผนการจัดการเรยีนรู้ 
ในการวิจัยครั้งนี้ ผู้วิจัยได้พัฒนาแผนการจัดการเรียนรู้ตามแนวทางของโรงเรียน 

ศรัทธาสมุทร (2559: ออนไลน์) ที่มอีงค์ประกอบหลักในการพัฒนาแผนการจัดการเรียนรู้ 
ประกอบด้วย 

1. ค าอธิบายรายวิชา 
2. มาตรฐานการเรียนรู้ / ตัวชี้วัด หรือ ผลการเรียนรู้ 
3. โครงสร้างรายวิชา 
4. การออกแบบหน่วยการเรียนรู้ 

4.1 สาระการเรียนรู้ 
4.2 สมรรถนะด้านต่างๆ ของผู้เรียน 
4.3 คุณลักษณะอันพึงประสงค์  

5. แผนการจัดการเรียนรู้รายคาบ 
5.1 กิจกรรมการเรียนรู้ 
5.2 สื่อ / นวัตกรรม 
5.3 ใบงาน / ใบกิจกรรม 
5.4 แบบประเมิน 
5.5 แบบทดสอบก่อนเรียน / หลังเรียน 
5.6 บันทึกหลังจากการใช้แผนการจัดการเรียนรู้ 

 

1.4.3 คุณภาพของแผนการจัดการเรียนรู้ 
ในการวิจัยครั้งนี้ ผู้วิจัยได้น าหลักการและกรอบแนวคิดของ สุวิทย์ มูลค า  และคณะ  

(2551: 58-64) มาใช้เป็นแนวคิดในการหาคุณภาพของแผนการจัดการเรียนรู้ที่มีการออกแบบ 
เป็นฐานและให้ผู้ทรงคุณวุฒิประเมิน โดยใช้แบบประเมินคุณภาพท่ีสร้างข้ึน ดังนี้  

1. จุดประสงค์การจัดการเรียนรู้ 
2. เนื้อหาสาระ  
3. กิจกรรมการจัดการเรียนรู้ 
4. สื่อการจัดการเรียนรู้ 
5. การวัดและประเมินผล  
6. ความสอดคล้องขององค์ประกอบต่างๆของแผนการจัดการเรียนรู้ 
 

1.4.4 บทเรียนออนไลน์ 
ในการวิจัยครั้งนี้ ผู้วิจัยจะพัฒนาบทเรียนออนไลน์เพ่ือใช้ร่วมกับแผนการจัดการเรียนรู้โดย

ใช้การออกแบบเป็นฐาน โดยการน าเอาแนวคิด ADDIE Model (มนต์ชัย เทียนทอง. 2545: 131-136) 
ซึ่งมีอยู่ 5 ขั้นตอน ดังนี้ 

1. ขั้นการวิเคราะห์ ( Analysis Phase ) 
2. ขั้นการออกแบบ ( Design Phase ) 
3. ขั้นการพัฒนา ( Development Phase ) 
4. ขั้นการน าไปใช้ ( Implementation Plase ) 
5. ขั้นการประเมินผล ( Evaluation Phase ) 
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1.4.5 คุณภาพของบทเรียนออนไลน์ 
ในการวิจัยครั้ งนี้  ผู้ วิจัยได้ใช้กรอบแนวคิดของ ไพโรจน์ ตีรณธนากุล และคณะ  

(2546: 197-202) ในการประเมินคุณภาพของบทเรียนออนไลน์ ซึ่งแบ่งออกเป็น 2 ด้าน คือ 
1. ด้านเนื้อหา 
2. ด้านเทคโนโลยีมัลติมีเดีย 

 

1.4.6 ประสิทธิภาพของบทเรียนออนไลน์ 
ในการวิจัยครั้งนี้ ผู้วิจัยได้น าแนวคิดของ ชัยยงค์ พรหมวงศ์ (2556: 7-20) ในการหา

ประสิทธิภาพของบทเรียนออนไลน์ โดยใช้สูตร E1/E2 มีดังนี ้
1. ประสิทธิภาพของกระบวนการ ( E1 ) 
2. ประสิทธิภาพของผลลัพธ์ ( E2 ) 

 

1.4.7 การวัดผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัย 
ผู้วิจัยได้น าแนวคิดด้านพุทธิพิสัยของ Bloom ที่ได้รับการปรับเปลี่ยนแก้ไขใหม่ตัวทฤษฎี

โดย Anderson & Krathwohl (2001: 213-217) มาใช้เป็นกรอบแนวคิดในการวัดผลสัมฤทธิ์ทางการ
เรียนด้านความรู้ ซ่ึงไดจ้ าแนกจุดมุ่งหมายออกเป็น 6 ระดับ ได้ดังนี ้

1. จ า 
2. เข้าใจ 
3. น าไปใช้ 
4. วิเคราะห์ 
5. ประเมิน 
6. สร้างสรรค์ 
โดยในงานของผู้วิจัยจะวัดผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัย ถึงระดับที่ 3 เท่านั้น 

ได้แก่ จ า เข้าใจ และน าไปใช้  
ในการสร้างแบบวัดผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัยได้เลือกเป็นแบบทดสอบปรนัย

แบบ 4 ตัวเลือก ตามรูปแบบที่ทางโรงเรียนศรัทธาสมุทร (2559: ออนไลน์) ใช้ในการท าแบบทดสอบ 
 

1.4.8 การวัดผลสัมฤทธิ์ทางการเรียนด้านทักษะพิสัย 
ผู้วิจัยได้น าแนวคิดในการวัดทักษะพิสัยของ กมลวรรณ ตั้งธนกานนต์ (2559: 4-6) มาใช้

เป็นแนวคิดในการวัดผลสัมฤทธิ์ทางการเรียนด้านทักษะพิสัย ซึ่งจ าแนกจุดมุ่งหมายทางการศึกษาด้าน
ทักษะพิสัยออกได้เป็น 5 ระดับ ได้ดังนี้  

1. การรับรู้และการปฏิบัติพ้ืนฐาน 
2. การเตรียมความพร้อมและการเลียนแบบ 
3. การฝึกปฏิบัติ 
4. การปฏิบัติด้วยความช านาญ 
5. การปรับเปลี่ยนหรือสร้างปฏิบัติการ 
โดยงานของผู้วิจัยจะวัดผลสัมฤทธิ์ทางการเรียนด้านทักษะพิสัย ถึงระดับที่ 4 เท่านั้น ได้แก่ 

การรับรู้และการปฏิบัติพ้ืนฐาน การเตรียมความพร้อมและการเลียนแบบ การฝึกปฏิบัติ และการ
ปฏิบัติด้วยความช านาญ  
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ในการสร้างแบบวัดผลสัมฤทธิ์ทางการเรียนด้านทักษะพิสัยได้เลือกเป็น ใช้เกณฑ์การ
ประเมินแบบรูบริก โดยการทดสอบภาคปฏิบัติที่แบ่งตามปัจจัยที่จะประเมินตามการวัดผลงาน 
(กมลวรรณ ตั้งธนกานนต์ 2559: 27-36) 

 
ตัวแปรจัดกระท า ตัวแปรตาม 

  

 
ภาพที่ 1.1 กรอบแนวคิดที่ใช้ในการวิจัย 

  

การจัดการเรียนรู้ด้วย 
1. แผนการจัดการเรียนรู้ 

ที่พัฒนาขึ้นร่วมกับ
บทเรียนออนไลน์ 

2. แผนการจัดการเรียนรู้
ตามปกติ 

 

ผลสัมฤทธิ์ทางการเรียน 
เรื่อง การสร้างเว็บไซต์ด้วยภาษา 
HTML5 

1. ด้านพุทธิพิสัย 
2. ด้านทักษะพิสัย 
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1.5  ขอบเขตของการวิจัย 
 

1.5.1 ประชากรและกลุ่มตัวอย่าง 
ประชากร คือ นักเรียนระดับมัธยมศึกษาชั้นปีที่ 6 ภาคเรียนที่ 2 ปีการศึกษา 2561 ของ

โรงเรียนศรัทธาสมุทร 8 ห้องเรียน จ านวนทั้งหมด 298 คน 
กลุ่มตัวอย่าง คือ นักเรียนระดับมัธยมศึกษาชั้นปีที่ 6 ภาคเรียนที่ 2 ปีการศึกษา 2561 

ของโรงเรียนศรัทธาสมุทร โดยท าการเลือกด้วยวิธีการสุ่มตัวอย่างแบบแบ่งกลุ่ม (Cluster Random 
Sampling) เริ่มจากแบ่งนักเรียนตามห้อง ท าการสุ่มห้องเรียนจ านวน 3 กลุ่ม น ามาจัดเป็นกลุ่มหา
ประสิทธิภาพ 1 กลุ่ม และกลุ่มตัวอย่าง 2 กลุ่ม ได้แก่ 

1. กลุ่มท่ีใช้ในการหาประสิทธิภาพของบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา 
HTML5 จ านวน 39 คน 

2. กลุ่มทดลองท่ีเรียนตามแผนการจัดการเรียนรู้ที่พัฒนาขึ้น จ านวน 42 คน 
3. กลุ่มควบคุมท่ีเรียนตามแผนการจัดการเรียนรู้แบบปกต ิจ านวน 39 คน 

 

1.5.2 ตัวแปรที่ศึกษา 
1. ตัวแปรจัดกระท า (Manipulate Variable) คือ การจัดการเรียนรู้  เรื่อง การสร้าง

เว็บไซต์ด้วยภาษา HTML5 จ าแนกเป็น 
1.1 การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์ 
1.2 การจัดการเรียนรู้แบบปกต ิ

2. ตัวแปรตาม (Dependent Variable) คือ ผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัยและ
ทักษะพิสัย เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 
 

1.5.3 เนื้อหา 
ส าหรับเนื้อหาที่ใช้ในการพัฒนาบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา 

HTML5 ประกอบด้วยหัวข้อดังต่อไปนี้ 
1. การเริ่มต้นใช้งานโปรแกรมประเภท Web Editor 
2. การเริ่มต้นสร้างไฟล์เว็บด้วยภาษา HTML5 
3. การสร้างและปรับแต่งรูปแบบหน้าเว็บ 
4. การใส่ภาพเพ่ิมเติมไปในหน้าเว็บ 
5. การสร้างลิงค์เชื่อมโยงในรูปแบบต่างๆ บนหน้าเว็บ 
6. การสร้างตารางและการจัดรูปแบบหน้าเว็บ 

 

1.5.4 ระยะเวลา 
ผู้วิจัยท าการทดลองในภาคเรียนที่ 2 ปีการศึกษา 2561 โดยก าหนดระยะเวลาในการ

ทดลอง 5 สัปดาห์ สัปดาห์ละ 2 คาบ คาบละ 50 นาที รวมทั้งสิ้น 10 คาบเรียน 
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1.6  นิยามศัพท์เฉพาะที่ใช้ในการวิจัย 
 

1.6.1 การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน หมายถึง การจัดการเรียนรู้ที่เน้น
ในการออกแบบสร้างสรรค์ผลงานเพ่ือน ามาใช้ในการแก้ไขปัญหาที่ก าหนด โดยมีพ้ืนฐานมาจากการบูร
ณาการกระบวนการคิดในการแก้ไขปัญหาด้วยการวางแผนและการออกแบบเข้ามาใช้ในชั้นเรียน ซึ่ง
จะให้นักเรียนได้ใช้ความคิดสร้างสรรค์ในการออกแบบชิ้นงานของตนเองจากความรู้ที่มี เพ่ือให้เกิด
การเรียนรู้อย่างสร้างสรรค์และสนุกสนาน ในการลองผิดลองถูกด้วยตนเอง ก่อนที่จะให้ความรู้
เพ่ิมเติมให้กลับไปปรับปรุงชื้นงานของตนเองต่อไป 

1.6.2 แผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน หมายถึง แผนการจัดการ
เรียนรู้ที่ผู้วิจัยพัฒนาขึ้น ซึ่งมีกิจกรรมการเรียนรู้ในห้องเรียนออกแบบตามแนวคิดการจัดการเรียนรู้
โดยใช้การออกแบบเป็นฐาน และมีสื่อเป็นบทเรียนออนไลน์ ที่ช่วยในการพัฒนาผลสัมฤทธิ์ทางการ
เรียนทั้งด้านพุทธิพิสัยและทักษะพิสัย เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 

1.6.3 แผนการจัดการเรียนรู้แบบปกติ หมายถึง แผนการจัดการเรียนรู้ที่ทางโรงเรียนใช้
ในการเรียนการสอนในปัจจุบัน ซึ่งมีกิจกรรมการเรียนรู้ในห้องเรียนในรูปแบบของการสาธิตโดยให้
ลองท าตาม และมีสื่อเป็นสไลด์น าเสนอ ในเรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 

1.6.4 คุณภาพของแผนการจัดการเรียนรู้  หมายถึง ผลประเมินคุณภาพของแผนการ
จัดการเรียนรู้ออกแบบตามแนวคิดการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน เรื่อง การสร้าง
เว็บไซต์ด้วยภาษา HTML5 ที่ได้รับการประเมินจากผู้ทรงคุณวุฒิที่เชี่ยวชาญด้านการหลักสูตรและการ
สอนแผนการจัดการเรียนรู้ 6 ด้าน ได้แก่ จุดประสงค์การจัดการเรียนรู้ เนื้อหาสาระ กิจกรรมการ
จัดการเรียนรู้ สื่อการจัดการเรียนรู้ การวัดและประเมินผล และความสอดคล้องขององค์ประกอบ
ต่างๆของแผนการจัดการเรียนรู้ 

1.6.5 บทเรียนออนไลน์ หมายถึง สื่อการเรียนการสอน เรื่อง การสร้างเว็บไซต์ด้วยภาษา 
HTML5 ที่พัฒนาขึ้นมาเป็นบทเรียนออนไลน์โดยใช้เทคโนโลยีดิจิตอล Google Classroom กับ 
Google Site ซึ่งในการออกแบบสื่อจะประกอบไปด้วยสื่อมัลติมีเดียหลายชนิด ได้แก่ ข้อความ 
รูปภาพ เสียง และวิดีโอ โดยแสดงผ่านเครือข่ายอินเทอร์เน็ต ที่สามารถให้นักเรียนกลับไปเรียนรู้ด้วย
ตนเองในเวลาและสถานที่ตามต้องการ 
 

1.6.6 คุณภาพของบทเรียนออนไลน์ หมายถึง ผลประเมินคุณภาพของบทเรียนออนไลน์
ด้วย Google Site เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ที่ได้รับการประเมินจากผู้ทรงคุณวุฒิที่
เชี่ยวชาญด้านเนื้อหาและด้านเทคโนโลยีมัลติมีเดีย โดยมีรายละเอียดดังนี้ 

1. ด้านเนื้อหา หมายถึง ความถูกต้องครบถ้วนชัดเจนของเนื้อหาสาระในการเรียนรู้ ที่จะ
สามารถถ่ายทอดให้นักเรียนมีความรู้และความเข้าใจได้ดี  ได้แก่ ความเหมาะสมของเนื้อหา ความ
สอดคล้องระหว่างวัตถุประสงค์กับเนื้อหา ความยากง่ายของเนื้อหาที่เหมาะสมกับนักเรียน ความ
ถูกต้องของเนื้อหา ความชัดเจนของภาษาที่ใช้ในตัวบทเรียน ความเหมาะสมของตัวอย่าง ความ
เหมาะสมของปริมาณข้อสอบหรือแบบทดสอบ รูปภาพสามารถสื่อความหมายที่เกี่ยวข้องกับเนื้อหาได้
อย่างชัดเจน และความสอดคล้องของรูปภาพหรือสื่อประกอบกับเนื้อหาในบทเรียน 
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2. ด้านเทคโนโลยีมัลติมีเดีย หมายถึง เทคโนโลยีที่ช่วยให้สื่อการเรียนรู้สามารถผสมผสาน
ระหว่างข้อความ ตัวเลข ภาพ เสียง และวิดีโอ ไว้ด้วยกัน ตลอดจนการน าเอาระบบการโต้ตอบให้มี
ปฏิสัมพันธ์กับผู้ใช้ ด้านตัวอักษร ได้แก่ ขนาดตัวอักษร ความชัดเจน สี และความถูกต้องของข้อความ
ตามหลักภาษา ด้านภาพนิ่ง ได้แก่ ขนาดภาพ สี ความชัดเจน และความเหมาะสมของรูปภาพที่ใช้ใน
การสื่อความหมาย ด้านเสียง ได้แก่ น้ าเสียงในการบรรยายกับความชัดเจนของเสียง ด้านปฏิสัมพันธ์ 
ได้แก่ การควบคุมบทเรียน การเชื่อมโยงเนื้อหาภายในหน่วย และการเชื่อมโยงระหว่างบทเรียนแต่ละ
หน่วย และด้านแบบทดสอบ ได้แก่ รูปแบบการน าเสนอแบบทดสอบและแบบฝึกหัดท้ายกับรูปแบบ
การรายงานผลการทดสอบและแบบฝึกหัดท้ายหน่วย 

1.6.7 ประสิทธิภาพของบทเรียนออนไลน์ หมายถึง ความสามารถของบทเรียนออนไลน์ 
เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ที่สร้างขึ้นในการส่งเสริมผลสัมฤทธิ์ทางการเรียนด้าน
ความรู้และทักษะของนักเรียนที่เรียน ให้เป็นไปตามเกณฑ์ที่ก าหนดไว้ คือ E1/E2 ได้ 80/80 โดยมี
รายละเอียดดังนี้ 

1. ประสิทธิภาพของกระบวนการ (E1) หมายถึง ร้อยละของผลสัมฤทธิ์ทางการเรียน
ระหว่างเรียน ค านวณจากค่าเฉลี่ยของคะแนนจากการท าแบบทดสอบระหว่างเรียนในแต่ละบท 

2. ประสิทธิภาพของผลลัพธ์ (E2) หมายถึง ร้อยละของผลสัมฤทธิ์ทางการเรียนทั้งหมด 
ซึ่งค านวณจากค่าเฉลี่ยของคะแนนจากการท าแบบทดสอบหลังจากเรียนจบเรียบร้อยทั้งหมดแล้ว 

1.6.8 ผลสัมฤทธิ์ทางการเรียน หมายถึง ผลการเรียนรู้ของนักเรียนที่ได้จากการเรียนด้วย
การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ซึ่งวัดได้จาก
ท าแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียนทั้ง 2 ด้าน คือ  

1. ด้านพุทธิพิสัย หมายถึง พฤติกรรมด้านความรู้ของนักเรียน ที่วัดเกี่ยวกับการรับรู้ การ
คิดและวิเคราะห์ จากการเรียนรู้ผ่านบทเรียน โดยวัดถึงระดับที่ 3 ได้แก่ จ า เข้าใจ และน าไปใช้ 

2. ด้านทักษะพิสัย หมายถึง พฤติกรรมด้านทักษะของนักเรียน ที่วัดเกี่ยวกับความสามารถ
ในการลงมือท างาน จากการเรียนรู้ผ่านบทเรียน โดยวัดถึงระดับที่ 4 หรือ ระดับการปฏิบัติด้วยความ
ช านาญ 

1.6.9 แบบวัดผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัย หมายถึง เครื่องมือที่ใช้ในการ
วัดผลสัมฤทธิ์ทางการเรียนด้านความรู้ของนักเรียน เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ซึ่ง
ทดสอบหลังเรียน มีลักษณะเป็นแบบทดสอบทีมีข้อสอบปรนัยแบบ 4 ตัวเลือก โดยวัดถึงระดับที่ 3 
ได้แก่ จ า เข้าใจ และน าไปใช้ 

1.6.10 แบบวัดผลสัมฤทธิ์ทางการเรียนด้านทักษะพิสัย หมายถึง เครื่องมือที่ใช้ในการ
วัดผลสัมฤทธิ์ทางการเรียนด้านทักษะของนักเรียน เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ซึ่ง
ทดสอบหลังเรียน มีลักษณะเป็นชิ้นงานตามใบงาน ใช้เกณฑ์การประเมินแบบรูบริก โดยวัดถึงระดับที่ 
4 หรือ ระดับการปฏิบัติด้วยความช านาญ 

1.6.11 นักเรียน หมายถึง นักเรียนระดับมัธยมศึกษาชั้นปีที่ 6 ที่ก าลังศึกษาอยู่ในภาค
เรียนที่ 2 ปีการศึกษา 2561 โรงเรียนศรัทธาสมุทร จังหวัดสมุทรสงคราม สังกัดส านักงานเขตพ้ืนที่
การศึกษามัธยมศึกษา เขต 10 ซึ่งในงานวิจัยนี้ได้คัดเลือกนักเรียนมา 3 กลุ่ม ได้แก่ 
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1. กลุ่มทดสอบประสิทธิภาพ หมายถึง นักเรียนกลุ่มตัวอย่างที่น ามาใช้ทดลอง
ประสิทธิภาพของบทเรียนออนไลน์ 

2. กลุ่มทดลอง หมายถึง นักเรียนกลุ่มตัวอย่างที่น ามาใช้ทดลองเรียนโดยใช้แผนการ
จัดการเรียนรู้ที่พัฒนาขึ้นร่วมกับบทเรียนออนไลน์ 

3. กลุ่มควบคุม หมายถึง นักเรียนกลุ่มตัวอย่างที่น ามาใช้เพ่ือเปรียบเทียบกับกลุ่มทดลอง 
ซึ่งเรียนโดยใช้แผนการจัดการเรียนรู้แบบปกติ 

1.6.12 การสร้างเว็บไซต์ด้วยภาษา HTML5 หมายถึง เนื้อหาสาระส่วนหนึ่งในวิชา การ
สร้างเว็บไซต์ ซึ่งอยู่ในสาระการเรียนรู้การงานอาชีพเทคโนโลยี สาระที่ 3 เทคโนโลยีสารสนเทศและ
การสื่อสาร โดยมีเนื้อหารายละเอียดเกี่ยวกับการใช้ภาษา HTML, CSS และ HTML5 เขียนเว็บไซต์ 
โดยแบ่งเนื้อหาย่อย ได้ดังต่อไปนี้ 

1. การเริ่มต้นใช้งานโปรแกรมประเภท Web Editor 
2.  การเริ่มต้นสร้างไฟล์เว็บด้วยภาษา HTML5 
3.  การสร้างและปรับแต่งรูปแบบหน้าเว็บ 
4. การใส่ภาพเพ่ิมเติมไปในหน้าเว็บ 
5. การสร้างลิงค์เชื่อมโยงในรูปแบบต่างๆ บนหน้าเว็บ 
6. การสร้างตารางและการจัดรูปแบบหน้าเว็บ 

 
 



 

 
 

บทท่ี 2 
เอกสารและงานวิจยัที่เกี่ยวข้อง 

 
ในงานวิจัย เรื่อง การพัฒนาแผนจัดการเรียนรู้โดยใช้แนวคิดการเรียนรู้ที่มีการออกแบบ 

เป็นฐาน (Design-Based Learning) ร่วมกับบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา 
HTML5 ของชั้นมัธยมศึกษาปีที่ 6 ผู้วิจัยได้ศึกษาเอกสารและงานวิจัยที่เกี่ยวข้องกับการวิจัย 
ตามล าดับดังต่อไปนี้ 

2.1 ความรู้เกี่ยวกับรายวิชา 
2.2 ความรู้เกี่ยวกับการจัดการเรียนรู้ 
2.3 ความรู้เกี่ยวกับบทเรียนออนไลน์ 
2.4 ความรู้เกี่ยวกับการวัดผลสัมฤทธิ์ทางการเรียน 
2.5 งานวิจัยที่เกี่ยวข้อง 

 
2.1  ความรู้เกี่ยวกับรายวิชา 

 
2.1.1 หลักสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศักราช 2551 
1. หลักการ 
หลักสูตรแกนกลางการศึกษาขั้นพ้ืนฐาน มุ่งพัฒนาผู้เรียนทุกคนให้เป็นมนุษย์ที่มีความ

สมดุลทั้งด้านร่างกาย ความรู้ คุณธรรม มีจิตส านึกในความเป็นพลเมืองไทยและเป็นพลโลก ยึดมั่นใน
การปกครองตามระบอบประชาธิปไตยอันมีพระมหากษัตริย์ทรงเป็นประมุข มีความรู้และทักษะ
พ้ืนฐาน รวมทั้งเจตคติที่จ าเป็นในการศึกษาต่อ การประกอบอาชีพและการศึกษาตลอดชีวิต โดย
มุ่งเน้นผู้เรียนเป็นส าคัญบนพ้ืนฐานความเชื่อว่า ทุกคนสามารถเรียนรู้และพัฒนาตนเองได้เต็มตาม
ศักยภาพ 

2. จุดหมาย 
มุ่งพัฒนาผู้เรียนให้เป็นคนดี  มีปัญญา มีความสุขช มีศักยภาพในการศึกษาต่อ และ

ประกอบอาชีพ ได้ก าหนดเป็นจุดหมายเพ่ือให้เกิดกับผู้เรียน เมื่อจบการศึกษาข้ันพื้นฐาน ดังนี้ 
2.1 มีคุณธรรม จริยธรรม และค่านิยมที่พึงประสงค์ เห็นคุณค่าของตนเอง มีวินัยและ

ปฏิบัติตนตามหลักธรรมของพระพุทธศาสนา หรือศาสนาที่ตนนับถือ ยึดหลักปรัชญาของเศรษฐกิจ
พอเพียง  

2.2 มีความรู้ ความสามารถในการสื่อสาร การคิด การแก้ปัญหา การใช้เทคโนโลยี 
และมีทักษะชีวิต 

2.3 มีสุขภาพกายและสุขภาพจิตที่ดี มีสุขนิสัย และรักการออกก าลังกาย 
2.4 มีความรักชาติ มีจิตส านึกในความเป็นพลเมืองไทยและพลโลก ยึดมั่นในวิถีชีวิต

และการปกครองตามระบอบประชาธิปไตยอันมีพระมหากษัตริย์ทรงเป็นประมุข 
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2.5 มีจิตส านึกในการอนุรักษ์วัฒนธรรมและภูมิปัญญาไทย การอนุรักษ์และพัฒนา
สิ่งแวดล้อม มีจิตสาธารณะที่มุ่งท าประโยชน์และสร้างสิ่งที่ดีงามในสังคม และอยู่ร่วมกันในสังคมอย่าง
มีความสุข 

3. สาระการเรียนรู้ 
การพัฒนาผู้เรียนให้เกิดความสมดุล ต้องค านึงถึงหลักพัฒนาการทางสมองและพหุปัญญา 

ได้ก าหนดให้ผู้เรียนเรียนรู้ 8 กลุ่มสาระการเรียนรู้ ดังนี้ 
3.1 ภาษาไทย 3.2 คณิตศาสตร์ 
3.3 วิทยาศาสตร์ 3.4 สังคมศึกษา ศาสนา และวัฒนธรรม 
3.5 สุขศึกษาและพลศึกษา 3.6 ศิลปะ 
3.7 การงานอาชีพและเทคโนโลยี 3.8 ภาษาต่างประเทศ 

ในแต่ละกลุ่มสาระการเรียนรู้ได้ก าหนดมาตรฐานการเรียนรู้เป็นเป้าหมายส าคัญของการ
พัฒนาคุณภาพผู้เรียน มาตรฐานการเรียนรู้ระบุสิ่งที่ผู้เรียนพึงรู้ ปฏิบัติได้ มีคุณธรรมจริยธรรม และ
ค่านิยมที่พึงประสงค์เมื่อจบการศึกษาขั้นพ้ืนฐาน นอกจากนั้นมาตรฐานการเรียนรู้ยังเป็นกลไกส าคัญ
ในการขับเคลื่อนพัฒนาการศึกษาทั้งระบบ 

4. ตัวช้ีวัด 
ตัวชี้วัดระบุสิ่งที่นักเรียนพึงรู้และปฏิบัติได้ รวมทั้งคุณลักษณะของผู้เรียนในแต่ละระดับชั้น 

ซึ่งสะท้อนถึงมาตรฐานการเรียนรู้ มีความเฉพาะเจาะจงและมีความเป็นรูปธรรม น าไปใช้ในการ
ก าหนดเนื้อหา จัดท าหน่วยการเรียนรู้ จัดการเรียนการสอน และเป็นเกณฑ์ส าคัญส าหรับการวัด
ประเมินผลเพื่อตรวจสอบคุณภาพผู้เรียน  

4.1 ตัวชี้วัดชั้นปี เป็นเป้าหมายในการพัฒนาผู้เรียนแต่ละชั้นปีในระดับการศึกษาภาค
บังคับ (ประถมศึกษาปีที่ 1 - มัธยมศึกษาปีที่ 3)  

4.2 ตัวชี้วัดช่วงชั้น เป็นเป้าหมายในการพัฒนาผู้เรียนในระดับมัธยมศึกษาตอนปลาย 
(มัธยมศึกษาปีที ่4 - 6) 

5. การระบุมาตราฐานการเรียนรู้กับตัวชี้วัด 
หลักสูตรได้มีการก าหนดรหัสก ากับมาตรฐานการเรียนรู้และตัวชี้วัด เพ่ือความเข้าใจและให้

สื่อสารตรงกัน เนื่องจากผู้วิจัยท าการวิจัยในวิชาสาระการงานอาชีพและเทคโนโลยีนี้ จึงได้น าเสนอ
ตัวอย่างในสาระที่ 7 เกี่ยวกับเทคโนโลยีสารสนเทศและการสื่อสาร ดังนี้ 

มาตรฐาน ง 3.1 - เข้าใจ เห็นคุณค่า และใช้กระบวนการเทคโนโลยีสารสนเทศในการ
สืบค้นข้อมูล การเรียนรู้ การสื่อสาร การแก้ปัญหา การท างาน และอาชีพอย่างมีประสิทธิภาพ 
ประสิทธิผล และมีคุณธรรม 

ช่วงชั้น ม.4 - ม.6 
ตัวชี้วัดที่ 8 - การใช้ฮาร์ดแวร์และซอฟต์แวร์ให้เหมาะสมกับงาน เป็นการเลือกคุณลักษณะ

ของฮาร์ดแวร์และซอฟต์แวร์ให้เหมาะสมกับงาน  เช่น คอมพิวเตอร์ที่ใช้ในงานสื่อประสม ควรเป็น
เครื่องที่มีสมรรถนะสูง  และใช้ซอฟต์แวร์ ที่เหมาะสม 

ง3.1 ม.4-6/8 
ม.4-6/8 ตัวชี้วัดชั้นมัธยมศึกษาตอนปลาย  ข้อที่ 8 
3.1 สาระที่ 3  มาตรฐานข้อที่ 1 
ง กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี  
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2.1.2 การพัฒนาแผนการจัดการเรยีนรู้ 
แผนการจัดการเรียนรู้ตามแนวทางของโรงเรียนศรัทธาสมุทร (2559: ออนไลน์) มี

องค์ประกอบหลักในการพัฒนาแผนการจัดการเรียนรู้ ประกอบด้วย 
1. ค าอธิบายรายวิชา 
2. มาตรฐานการเรียนรู้ / ตัวชี้วัด หรือ ผลการเรียนรู้ 
3. โครงสร้างรายวิชา 
4. การออกแบบหน่วยการเรียนรู้ 

4.1 สาระการเรียนรู้ 
4.2 สมรรถนะด้านต่างๆ ของผู้เรียน 
4.3 คุณลักษณะอันพึงประสงค์  

5. แผนการจัดการเรียนรู้รายคาบ 
5.1 กิจกรรมการเรียนรู้ 
5.2 สื่อ / นวัตกรรม 
5.3 ใบงาน / ใบกิจกรรม 
5.4 แบบประเมิน 
5.5 แบบทดสอบก่อนเรียน / หลังเรียน 
5.6 บันทึกหลังจากการใช้แผนการจัดการเรียนรู้ 

 

2.1.3 วิชาการสร้างเว็บไซต์ 
วิชาการสร้างเว็บไซต์ ของโรงเรียนศรัทธาสมุทร เป็นส่วนหนึ่งของวิชาการงานอาชีพและ

เทคโนโลยี (คอมพิวเตอร์) โดยที่ผู้วิจัยท าการเลือกหัวข้อการสร้างเว็บไซต์ด้วยภาษา HTML5 เป็น
หัวข้อที่ใช้ในการทดลอง ซึ่งใช้ระยะเวลาในการเรียนทั้งหมด 10 คาบ 

1. ค าอธิบายรายวิชา 
ศึกษาคุณสมบัติของคอมพิวเตอร์ที่ใช้งานระบบอินเทอร์เน็ต องค์ประกอบของเว็บไซต์ 

ค าสั่งของการสร้างเว็บไซต์ การใช้โปรแกรมส าเร็จในการสร้างเว็บไซต์ การสร้างเว็บไซต์โดย ไม่ต้องใช้
โปรแกรมส าเร็จ สร้างเว็บไซต์ที่มีลักษณะสวยงาม มีความคิดสร้างสรรค์เกี่ยวกับรูปแบบลีลาลูก เล่น
ต่าง ๆ ของเว็บเพ็จ และมีปฏิสัมพันธ์ระหว่างผู้เยี่ยมชมกับเว็บไซต์ มีการจัดการฐานข้อมูล ป้าย
ประกาศ การท าแบบส ารวจ การบริการจดหมายอิเล็กโทรนิกส์ ศึกษาตัวอย่างเว็บไซต์ท่ีควรศึกษา 

โดยใช้ทักษะกระบวนการท างาน ทักษะการจัดการ ทักษะกระบวนการแก้ปัญหา ทักษะ
การท างานร่วมกันและทักษะการแสวงหาความรู้ มีคุณธรรม และลักษณะนิสัยการท างาน มีจิตส านึก
ในการการใช้พลังงาน ทรัพยากรและสิ่งแสดล้อม เพ่ือการด ารงชีวิตและครอบครัว 

เพ่ือให้มีความรู้ความเข้าใจและทักษะในการสร้างเว็บไซต์โดยใช้โปรแกรมส าเร็จและไม่ใช้
โปรแกรมส าเร็จ เพ่ือสร้างเว็บไซต์ โดยอิงมาตรฐานการเรียนรู้สามารถน าความรู้ที่ได้เป็นแนวทางใน
การประกอบอาชีพหรือศึกษาต่อ และน ามาใช้ในชีวิตประจ าวันได้อย่างมีประสิทธิภาพ รักชาติ ศาสน์ 
กษัตริย์ ซื่อสัตย์สุจริต มีวินัย ใฝ่เรียนรู้ อยู่อย่างพอเพียง มุ่งมั่นในการท างาน รักความเป็นไทย มีจิต
สาธารณะและจิตส านึกในการอนุรักษ์พลังงาน ทรัพยากรและสิ่งแวดล้อม มีคุณธรรม จริยธรรม เจต
คติและลักษณะนิสัยในการท างาน 

การวัดผลและประเมินผลตามสภาพจริงด้วยวิธีการที่หลากหลาย อิงมาตรฐานการเรียนรู้ 
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2. ผลการเรียนรู้ 
2.1 เข้าใจขั้นตอนในการสร้างเว็บไซต์ รู้จักวางแผนงานศึกษาข้อมูลก่อนท าการสร้าง

เว็บไซต์ 
2.2 มีความรู้เกี่ยวกับการสร้างเว็บไซต์ด้วยภาษา HTML และสร้างเว็บไซต์ภาษา 

HTML เบื้องต้นได้ 
2.3 มีความรู้เกี่ยวกับการสร้างเว็บไซต์ด้วยโปรแกรม Web Editor และสร้างเว็บไซต์

เบื้องต้นได้ 
2.4 มีทักษะการวางแผนสร้างเว็บไซต์ และ Upload สร้างเว็บไซต์ได้ 

3. เนื้อหารายวิชา 
วิชาการเขียนเว็บไซต์ มีเนื้อหาแบ่งออกเป็นหน่วยการเรียนรู้ต่างๆ ได้ดังนี้ 

3.1 การเริ่มต้นใช้งานโปรแกรมประเภท Web Editor 
3.2  การเริ่มต้นสร้างไฟล์เว็บด้วยภาษา HTML5 
3.3  การสร้างและปรับแต่งรูปแบบหน้าเว็บ 
3.4 การใส่ภาพเพ่ิมเติมไปในหน้าเว็บ 
3.5 การสร้างลิงค์เชื่อมโยงในรูปแบบต่างๆ บนหน้าเว็บ 
3.6 การสร้างตารางและการจัดรูปแบบหน้าเว็บ 
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โครงสร้างรายวิชา 
รหัสวิชา ง 30204 รายวิชา การสร้างเว็บไซต์  ชั้น ม.6  เวลาเรียน 40 ชั่วโมง 

 

ตารางท่ี 2.1 โครงสร้างรายวิชาการสร้างเว็บไซต์ 

ล าดับ
ที ่

รหัสตัวช้ีวัด 
/ ผลการ
เรียนรู้ 

สาระส าคัญ (Key Concept) 
ชื่อหน่วยการ

เรียนรู้ 
เวลา 

(ชั่วโมง) 
น้ าหนัก 
คะแนน 

1 1 ความหมายและคุณลักษณะของ 
- เว็บเพจ (Web Page) 
- โฮมเพจ (Homepage) 
- เว็บไซต์ (Website) 
วางวัตถุประสงค์ในการท าและ
เตรียมข้อมูล 

ความรู้เบื้องต้น
เกี่ยวกับ 
เว็บไซต์ 
(Website)  

4 10 

2 2 การสร้างเว็บไซต์ด้วยภาษา 
HTML 
- ความรู้เบื้องต้นภาษา HTML 
- โครงสร้างภาษา HTML 
- การจัดการเว็บไซต์ภาษา HTML  
หลักการและองค์ประกอบการ
ออกแบบเว็บไซต์ 

ออกแบบและ
จัดท าเว็บไซต์
ด้วยภาษา 
HTML 
 

10 20 

3 3 การสร้างเว็บไซต์โปรแกรม
ประเภท Web Editer 
- ความรู้เบื้องต้นเกี่ยวกับ
โปรแกรมประเภท Web Editer 
- เครื่องมือของโปรแกรมประเภท 
Web Editer 
- การจัดการเว็บไซต์ด้วย
โปรแกรมประเภท Web Editer 

โปรแกรม
ประเภท Web 
Editer 
 

20 20 

4 4 การสมัคร Counter และใช้งาน 
การสมัคร Webboard และใช้
งาน 
การสมัคร Web Hosting และใช้
งาน 
การ Upload เว็บไซต์ 
การบริหารและจัดการเว็บไซต์ 

การบริหารและ
การจัดการ
เว็บไซต์บน
เครือข่าย
อินเตอร์เน็ต 

6 10 

ประเมินผล (สอบกลางภาคเรียน) 20 
ประเมินผล (สอบปลายภาคเรียน) 20 

รวม 100 
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2.2 ความรู้เกี่ยวกับแผนจัดการเรียนรู้ 
 

2.2.1 แผนการจัดการเรียนรู้ 
ชนาธิป พรกุล (2555: 54) ที่ได้ให้หลักการเกี่ยวกับแผนการจัดการเรียนรู้ไว้ว่า เป็นแผนที่

ผู้สอนเขียนไว้ล่วงหน้าก่อนการสอนจริง มีองค์ประกอบต่างๆ ที่ช่วยให้นักเรียนท ากิจกรรมการเรียนรู้
จนเกิดการเรียนรู้บรรลุตามจุดประสงค์การเรียนรู้และมาตรฐานการเรียนรู้ของหลักสูตร 

รวีวัตร์ สิริภูบาล (2551: 21) ได้ให้หลักการเกี่ยวกับแผนการจัดการเรียนรู้ไว้ว่า เป็น
เครื่องมือชนิดหนึ่งที่ครูสร้างขึ้นเพ่ือความมั่นใจและความพร้อมในการจัดกิจกรรมการเรียนรู้จากการ
เตรียมการไว้ล่วงหน้าช่วยให้ครูมีแนวทางที่ชัดเจนในการด าเนินการช่วยเหลือแนะน านักเรียนและ
ก ากับ ควบคุม ดูแลกระบวนการเรียนรู้ทั้งในเรื่องเนื้อหาสาระ ระยะเวลา จุดประสงค์การเรียนรู้ 
พฤติกรรมของนักเรียน เทคนิควิธีการจัดการเรียนรู้ สื่อประกอบการเรียนรู้ การวัดและประเมินผลการ
เรียนรู้ ซึ่งการมีแผนการจัดการเรียนรู้ที่ดีย่อมส่งผลให้ครูสามารถด าเนินการจัดการเรียนรู้ได้อย่างเป็น
ระบบ ตามขั้นตอนและวิธีการที่ก าหนดไว้ จนเกิดการเปลี่ยนแปลงองค์ความรู้ขึ้นภายในตัวนักเรียน
ตามท่ีครูต้องการ โดยยึดหลักมาตรฐานและสาระการเรียนรู้ที่ก าหนดไว้ในหลักสูตรเป็นหลัก  

อาภรณ์ ใจเที่ยง (2553: 216) ที่ได้ให้ความหมายเกี่ยวกับแผนการจัดการเรียนรู้ว่าเป็น
แผนการจัดการกิจกรรมการเรียนรู้ การใช้สื่อการเรียนรู้และการวัดผลประเมินผล ที่สอดคล้องกับ 
สาระการเรียนรู้ และจุดประสงค์การเรียนรู้หรือผลการเรียนรู้ที่คาดหวังที่ก าหนดไว้ในหลักสูตร 

สรุปได้ว่า แผนการจัดการเรียนรู้หมายถึงเครื่องมือที่ผู้สอนออกแบบขึ้นล่วงหน้าเพ่ือเป็น
แนวทางในการจัดการเรียนการสอนให้กับนักเรียน มีการระบุถึงเนื้อหาสาระ จุดประสงค์การเรียนรู้ 
ขั้นตอนในการเรียนการสอน สื่อประกอบการเรียนรู้ และการวัดผลประเมินผล ให้สอดคล้องกับ
วัตถุประสงค์ในการเรียนรู้ของรายวิชาที่ก าหนดไว้ในหลักสูตร 

 

2.2.2 แนวทางการประเมินคุณภาพของแผนการจัดการเรียนรู้ 
หลักการประเมินคุณภาพของแผนการเรียนรู้ที่พัฒนาขึ้น ของสุวิทย์ มูลค า และคณะ  

(2551: 58-64) มีทั้งหมด 6 ด้าน ดังต่อไปนี้  
1. จุดประสงค์การเรียนการสอน แบ่งคุณสมบัติออกเป็น 3 ประการ ได้แก่ 

1.1 ความครอบคลุม คือ ความครอบคลุมมวลพฤติกรรม 3 ด้าน คือ ด้านความรู้ ความ
เข้าใจ ทักษะ และเจตคติ เพราะทั้ง 3 ด้านเป็นองค์ประกอบเพ่ือการเปลี่ยนแปลงพฤติกรรมอันเป็น
จุดหมายสูงสุดของการศึกษา อย่างไรก็ตามในแผนการเรียนรู้หรือบันทึกการสอนหนึ่ง อาจไม่จ าเป็น
ครบองค์ประกอบ 3 ด้านนี้เสมอไป ทั้งนี้ขึ้นอยู่กับ เวลา เนื้อหา และวัยของผู้เรียน 

1.2 ความชัดเจน คือ จุดประสงค์นั้นมีความเป็นพฤติกรรมมากพอที่จะตรวจสอบว่า มี
การบรรลุแล้วหรือไม่ เช่น ถ้าเขียนเพ่ือให้ “รู้” กับ เพ่ือให้ “ตอบได้” ค าว่า “รู้” เป็นความคิดรวบ
ยอดมากกว่าพฤติกรรม ถือว่า ไม่ชัดเจน แต่ค าว่า “ตอบ” มีลักษณะเป็นพฤติกรรมมากขึ้นโดยผู้เรียน
อาจจะพูดตอบ หรือเขียนตอบก็ได้ 

1.3 ความเหมาะสม คือ จุดประสงค์นั้นไม่สูงหรือต่ าเกินไป ทั้งนี้เมื่อค านึงถึงเวลา 
เนื้อหา และวัยของผู้เรียน 

2. เนื้อหาสาระ ส่วนเนื้อหาในแผนการเรียนรู้หรือบันทึกการสอนที่ดีนั้น จะต้อง มี
คุณสมบัติ 3 ประการ ได้แก่ 
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2.1 ความถูกต้อง คือ เนื้อหาสาระตรงกับหลักวิชา 
2.2 ความครอบคลุม คือ ปริมาณเนื้อหาตามหัวข้อนั้น มีมากพอที่จะก่อให้เกิดความคิด

รวบยอดได้หรือไม ่
2.3 ความชัดเจน คือ เนื้อหามีแบบแผนของการน าเสนอสาระท่ีไม่สับสนเข้าใจง่าย 

3. กิจกรรมการเรียนการสอนที่เน้นผู้เรียนเป็นหลัก กิจกรรมการเรียนการสอนที่ดีจะต้องมี
ความน่าสนใจ ความเหมาะสมและความคิดริเริ่ม ดังนี้ 

3.1 ความน่าสนใจ คือ กิจกรรมที่น ามาใช้ชวนให้น่าติดตามไม่เบื่อหน่าย 
3.2 ความเหมาะสม คือ กิจกรรมที่น ามาใช้จะต้องท าให้เกิดการเรียนรู้ตามจุดประสงค์

ได้จริง 
3.3 ความคิดริเริ่ม คือ การที่น าเอากิจกรรมใหม่ๆ ที่ท้าทายมาสอดแทรกช่วยให้เกิด

การเรียนรู้ 
4. สื่อการเรียนการสอนที่ดีจะต้องมีคุณสมบัติของความน่าสนใจ ความประหยัดและการ

ช่วยให้เกิดการเรียนรู้ได้เร็ว ดังนี้ 
4.1 ความน่าสนใจ คือ สื่อนั้นช่วยให้น่าติดตาม ไม่น่าเบื่อ ช่วยให้เกิดการเรียนรู้ได้เร็ว 

ต้องใช้ได้ผลในการท าให้ผู้เรียนรู้ได้จริง และตรงกับเนื้อหาที่ใช้เรียน 
4.2 ความประหยัด คือ สื่อที่ใช้นั้นราคาแพงอยู่ในระดับสถานศึกษารับผิดชอบได้ 

5. การวัดและประเมินผล ซึ่งการวัดและประเมินผลที่ระบุไว้ในแผนการเรียนรู้ที่ ดีควรมี
คุณสมบัติของความเที่ยงตรง ความเชื่อถือได้ และความสามารถประยุกต์ได้ ดังนี้ 

5.1 ความเที่ยงตรง คือ เครื่องมือวิธีการที่ใช้ในการวัดผลของแต่ละแผนนั้นๆ ต้อง
สอดคล้องและตรงตามจุดประสงค์ที่ระบุไว้ในแผนการเรียนรู้นั้นๆ และรวมทั้งตรงตามเนื้อหาที่ใช้
ประกอบการสอน 

5.2 ความเชื่อถือได้ คือ เครื่องมือ วิธีการที่ใช้ในการวัดผลของแต่ละแผนนั้นๆ ต้อง
สอดคล้อง และตรงตามจุดประสงค์ที่ระบุไว้ในแผนการเรียนรู้นั้นๆ และรวมทั้งตรงตามเนื้อหาที่ใช้
ประกอบการสอน 

5.3 ความสามารถประยุกต์ได้ คือ การประเมินที่ระบุไว้ว่าสามารถประเมินได้จริง 
6. ความสอดคล้องขององค์ประกอบต่างๆ ของแผนการเรียนรู้ ความสอดคล้องของ

แผนการเรียนรู้ ให้พิจารณาความสอดคล้องของเรื่อง จุดประสงค์การเรียนการสอน เนื้อหาสาระ 
กิจกรรมการเรียนการสอน สื่อการเรียนการสอน ประเมินผลตลอดทั้งแผนนั้นๆ 
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2.2.2 การเรียนรู้ที่มีการออกแบบเป็นฐาน 
แนวคิดการเรียนรู้ที่มีการออกแบบเป็นฐาน (Design-Based Learning) หรือเรียกอีกอย่าง

ว่าการเรียนการสอนที่มีการออกแบบเป็นฐาน (Design-Based Instruction) คือ รูปแบบการเรียนรู้
แบบหนึ่งที่เน้นในการแก้ไขปัญหา โดยมีพ้ืนฐานมาจากการบูรณาการกระบวนการคิดในการออกแบบ
เข้ามาใช้ในระดับ K-12 ของทางสหรัฐอเมริกา ซึ่งเปรียบได้กับชั้นเรียนตั้งแต่ประถมศึกษาชั้นปีที่ 1 ถึง
มัธยมศึกษาชั้นปีที่ 6 ของประเทศไทย ซึ่งสามารถพบได้ทั่วไปในหลายสาขาวิชา ตั้งแต่วิชาที่เก่ียวข้อง
กับการออกแบบโดยตรง อย่างเช่น กลุ่มศิลปะ สถาปัตยกรรม วิศวกรรม หรือการออกแบบกราฟิก 
เป็นต้น เช่นเดียวกับวิชากลุ่มอ่ืนที่ไม่ได้เกี่ยวข้องกับการออกแบบโดยตรง อย่างเช่น กลุ่มวิทยาศาสตร์ 
เทคโนโลยี ธุรกิจ หรือมนุษยศาสตร์ เป็นต้น แนวคิดนี้เป็นหนึ่งในแนวคิดที่ใช้ในการเรียนการสอน
เกี่ยวกับศตวรรษท่ี 21 อย่างเช่น การสื่อสาร การร่วมมือกัน หรือแม้กระทั้งส่งเสริมการเรียนรู้ในระดับ
ที่ยากขึ้นไป 

การเรียนรู้ในระดับที่ยากขึ้นจะเกิดขึ้นก็ต่อเมื่อนนักเรียนรู้ที่จะออกแบบและสร้างบางสิ่ง
บางอย่างที่ต้องใช้ความเข้าใจและทักษะในการใช้ความรู้ ซึ่งแนวคิดการเรียนรู้ที่มีการออกแบบเป็น
ฐาน จะช่วยให้นักเรียนสร้าง ปรับแต่ง และออกแบบโครงงานให้ดียิ่งขึ้น ซึ่งการท างานที่ซับซ้อนต้อง
อาศัยการร่วมมือและการท างานเฉพาะด้านที่ให้โอกาสนักเรียนได้ฝึกฝนจนกลายเป็นผู้เชี่ยวชาญ
เฉพาะด้าน แนวคิดการเรียนรู้นี้ต้องการให้นักเรียนตั้งเป้าหมาย หาข้อจ ากัด ความคิด และสร้างงาน
ต้นแบบจากการจ าลองสถานการณ์หรือการฝึกฝน 

การเรียนรู้ที่มีการออกแบบเป็นฐานถูกพัฒนาขึ้นในปี 1980 โดย Doreen Nelson  
(1980: ออนไลน์) ซึ่งเป็นศาสตราจารย์จากมหาวิทยาลัยแห่งแคลิฟอร์เนีย 

ส าหรับกระบวนการของการเรียนรู้ที่มีการออกแบบเป็นฐาน ได้มีแนวคิดที่กลับด้านจาก
แนวคิดของ Bloom โดยเริ่มจากให้นักเรียนสร้างสรรค์สิ่งที่เป็นความคิดออกมาก่อน จากนั้นก็น าเอา
สิ่งที่คิดมาอธิบายหลักการจากความรู้ที่เรียนจากต าราเรียน แล้วจึงกลั่นกรองออกมาเป็นความรู้ ซึ่ ง
แนวคิดนี้มีชื่อว่า “กระบวนการคิดย้อนกลับ 6 ขั้นตอนครึ่ง” (The 6 ½ Steps of Backwards 
Thinking) ซ่ึงแสดงดังภาพที่ 2.1 มีข้ันตอนดังต่อไปนี้ 

1. ต้องการที่จะสอนอะไร (What do I need to teach?) 
2. ระบุปัญหาจากบทเรียน (Identify a Problem) 

1/2  หาในแบบที่ไม่เคยพบเห็นมาก่อน (State as a “Never-Before-Seen”) 
3. ตั้งเกณฑ์การประเมิน (Set Criteria for Assessment) 
4. ให้นักเรียนได้ลองท า (Let students “give it a try.”) 
5. สอนเนื้อหาพ้ืนฐานให้ (Teach Traditional Guided Lessons) 
6. ให้นักเรียนได้ปรับแก้งานของตน (Students Revise Designs) 
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ภาพที่ 2.1 การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานของ Doreen Nelson 

 
ขั้นที่ 1 ต้องการที่จะสอนอะไร? ระบุรูปแบบหรือแนวคิดที่เป็นพ้ืนฐานในบทเรียน 
ตัวอย่าง การป้องกันเป็นแนวคิดสากล ในวิชาสังคมศาสตร์นักเรียนได้เรียนรู้เกี่ยวกับการ

ป้องกันจากองค์ประกอบต่างๆ ( ในที่พักอาศัย ) และบทบาทของกฎเกณฑ์ที่ประกันความปลอดภัยใน
ชีวิตและทรัพย์สิน ในวิชาวิทยาศาสตร์นักเรียนได้เรียนรู้เกี่ยวกับบทบาทของผิวหนังต่อร่างกายและ
ระบบแอนติบอดีในเลือด 

ขั้นที่ 2 ระบุปัญหาจากบทเรียน 
ตัวอย่าง ผู้คนหรือร่างกายของเรามีการป้องกันอย่างไรบ้าง 
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ขัน้ที่ครึ่ง เปลี่ยนปัญหาให้เป็นความท้ายทายในการออกแบบ “ที่ไม่เคยเห็นมาก่อน” 

ซึ่งสิ่งนี้สามารถเป็นแนวทางที่ “ที่ไม่เคยเห็นมาก่อน” ในการป้องกันผู้คนจากองค์ประกอบต่างๆ 
อย่างเช่น อาชญากร หรือจากการรุกราน เป็นต้น หรือป้องกันร่ายกายของเราเองโดยตรง  

ตัวอย่าง ในชั้นเรียนวิทยาศาสตร์ของนักเรียนชั้นมัธยมศึกษาชั้นที่ 4 อาจจะถูกถามให้
ออกแบบทางแก้ที่แปลกใหม่หรือไม่เคยมีมาก่อนจากความท้าทายต่อไปนี้ 

 “จะเกิดอะไรขึ้นถ้าโรคติดต่อที่อันตรายและร้ายแรงที่พบได้บ่อยๆ เกิดแพร่กระจายในตัว
เมือง และคุณเป็นเจ้าหน้าที่สาธารณะสุขที่รับผิดชอบในการหาที่ตรวจหาต้นตอของโรคภัยและ
ป้องกันไม่ให้เกิดการแพร่กระจายใหม่อีกครั้ง” 

นักเรียนเริ่มต้นคิดเกี่ยวกับเป้าหมายและพ้ืนที่ในการแก้ไขปัญหา โดยเริ่มจากการค้นหา
ด้วยค าที่เกี่ยวข้องกับโรคนั้น ก่อนที่จะได้เรียนรู้จากบทเรียนเกี่ยวกับโรคภัยหรือโรคระบาดที่รู้จักกัน
อย่างแพร่หลาย 

ขั้นที่ 3 ตั้งเกณฑ์การประเมิน ใช้เกณฑ์มาตรฐานและเนื้อหาจากบทเรียนที่ต้องการ อาจ
ท าเป็นรายการ 2 ส่วน ได้แก่ “ไม่ต้องการ” และ “จ าเป็น” 

ตัวอย่าง เกณฑ์การประเมินของการป้องการโรคภัย 
 

ตารางท่ี 2.2 เกณฑ์การประเมินของการป้องการโรคภัย 
ไม่ต้องการ จ าเป็น 

- อย่าท าให้คนอยู่แต่ในบ้านของพวกเขา - โรคภัยเริ่มเกิดข้ึนมาจากท่ีไหน 
- อย่าท าให้พวกเขาแต่งตัวด้วยชุดแปลกๆ - โรคภัยเกิดข้ึนได้อย่างไร 
- อย่าท าให้พวกเขาทานยาที่มีรสชาติแย่ - ผู้คนประเภทใดท่ีอ่อนต่อโรคภัยมากท่ีสุด 
 - ผู้คนแสดงอาการของโณคนานเท่าไหร่ 
 - โรคมีการติดต่อจากคนหนึ่งไปอีกคนได้อย่างไร 

 

 
โดยใน 2 รายการนี้จะ 
1. เป็นแนวทางและช่วยในการจัดรูปแบบการท างานของนักเรียน 
2. ตั้งมาตรฐานส าหรับนักเรียนในการประเมินงานของพวกเขา 
3. ท าหน้าที่เป็นเกณฑ์ในการประเมินระดับความส าเร็จของงานนักเรียน 
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ขั้นที่ 4 ให้นักเรียน “ได้ลองท า” 
จากกระดาษแผ่นหนึ่งที่น ามาม้วนหรือยับสามารถน ามาท าให้กลายเป็นโมเดล 3 มิติ 

(แผนภาพรูปแบบฟอง 3 มิติชนิดหนึ่ง) การท าโมเดลจะช่วยให้นักเรียนได้ใช้ทักษะในการคิดและการ
แก้ไขปัญหา และท าให้พวกเขาได้ใช้ค าศัพท์ในบทเรียนซ้ าแล้วซ้ าเล่าในขณะที่พวกเขาก าลังพูดคุย
ปรึกษาเก่ียวกับความท้าทายนี้ 

นักเรียนท าการปรับโมเดลตามความคิดเห็นจากนักเรียนคนอ่ืน นักเรียนทั้งหมดสามารถตั้ง
ค าถามได้ แม้แต่นักเรียนในกลุ่มที่มีข้อจ ากัดด้านค าศัพท์ นักเรียนพูดคุยปรึกษาซึ่งกันและกันภายใน
กลุ่มเล็กๆ เมื่อพวกเขาน ามาเสนอในชั้นเรียน พวกเขาก็ได้ใช้ค าศัพท์มาใช้ในการบันทึกในสิ่งที่พวกเขา
คิดหรือพูดคัยกัน 

ขั้นที่ 5 สอนเนื้อหาพื้นฐานให้ 
การแสดงให้เห็นถึงโมเดลของพวกเขาในขณะที่ท าการอธิบายทางแก้ที่ได้คิดขึ้น นักเรียนก็

อยากที่จะเรียนรู้เพ่ิมเติม ในหนังสือเรียนก็มีค าศัพท์ที่ได้ใช้งานจนคุ้น ร่วมกับข้อมูลใหม่ที่ได้จาก
บทเรียน นักเรียนสามารถน าเสนอกได้อย่างเป็นรูปแบบในชั้นเรียนและในรูปเล่มรายงานที่ได้เรียนรู้ใน
รูปแบบหัวข้อ สรุป กราฟ แผนภาพ แผนที่ และการค านวณ  

สิ่งที่ได้จากบทเรียน ได้แก่ 
1. การค้นหาและการอ่าน 
2. การพูด ( อาจเป็นการพูดคุยทั่วไป หรือการน าเสนอหน้าชั้นเรียน ) 
3. การเขียน ( หัวข้อ บทสรุป ความคิดใหม่ๆ ) 
4. การค านวณ 
5. การเปรียบเทียบ 
6. การสรุปผลในรูปแบบ กราฟ แผนภาพ และแผนที่ 
ขั้นที่ 6 ให้นักเรียนได้ปรับแก้งานของตน 
นักเรียนท าการสังเคราะห์สิ่งที่พวกเขาได้เรียนรู้จากการสร้างโมเดลและจากการมีส่วนร่วม

ในการสอนจากบทเรียน  
1. การปรับแก้โมเดล 
2. การเอาสิ่งที่เรียนในบทเรียนมาใช้ 
3. การประเมินผล 
4. การสังเคราะห์ 
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2.3 ความรู้เกี่ยวกับการพัฒนาบทเรียนออนไลน์ 
 

2.3.1 บทเรียนออนไลน์ 
1. ความหมายของบทเรียนออนไลน์ 
จินตวีร์ คล้ายสังข์ (2556 : 1) ได้กล่าวถึงบทเรียนออนไลน์ว่า เป็นการเรียนการสอนที่

รวมถึงการถ่ายทอดเนื้อหา การจัดกิจกรรมการเรียนการสอนตลอดจนการวัดและประเมินผล ผ่าน
ตัวอักษรภาพนิ่ง ผสมผสานกับการใช้ภาพเคลื่อนไหว วีดิทัศน์ และเสียง โดยอาศัยเทคโนโลยีของเว็บ
ในการถ่ายทอด 

ชุณหพงศ์ ไทยอุปถัมภ์ (2545 : 26-28) กล่าวถึงความหมายของค าว่า บทเรียนออนไลน์ 
หมายถึง รูปแบบการเรียนการสอนแบบใหม่ที่มีการประยุกต์ใช้เทคโนโลยี สื่ออิเล็กทรอนิกส์สมัยใหม่ 
มีวัตถุประสงค์ที่เอ้ืออ านวยให้ผู้เรียนสามารถเรียนรู้องค์ความรู้ (Knowledge) ได้โดยไม่จ ากัดเวลา
และสถานที่ (Anywhere-Anytime Learning) เพ่ือให้ระบบการเรียนการสอนเป็นไปได้อย่างมี
ประสิทธิภาพมากขึ้นและเพ่ือให้ผู้เรียนสามารถบรรลุวัตถุประสงค์ของกระบวนวิชาที่เรียนนั้นๆ 

ศุภชัย สุขะนินทร์ และ กรกนก วงศ์พานิช (2545 : 19) กล่าวถึง บทเรียนออนไลน์ คือ 
การเรียนทางไกล เป็นการเรียนที่ใช้เทคโนโลยีต่างๆ ที่มีบนโลกมาใช้เรียนผ่านทางคอมพิวเตอร์โดย
อาศัยเครือข่ายของอินเทอร์เน็ตมาช่วย เป็นการศึกษาที่ไร้ขอบเขตสามารถท ากิจกรรมบนห้องเรียน
ออนไลน์ได้โดยไม่มีข้อจ ากัดในเรื่องเวลา ระยะทาง และสถานที่ในการเรียนการสอน และยังสามารถ
ตอบสนองต่อศักยภาพและความสามารถของผู้เรียนได้ดี 

สรุปได้ว่า บทเรียนออนไลน์ หมายถึง เป็นรูปแบบการเรียนการสอนที่น าเอาเทคโนโลยี  
บนเครือข่ายอินเตอร์เน็ตผ่านทางคอมพิวเตอร์ มาใช้ในการถ่ายทอดเนื้อหา การบริหารจัดการเรียน
การสอนในด้านต่างๆ มีการปฏิสัมพันธ์และการสื่อสารที่เอ้ืออ านวยให้ผู้เรียนสามารถเรียนรู้ได้โดยไม่
จ ากัดเวลาและสถานที่ 

2. องค์ประกอบของการเรียนการสอนด้วยบทเรียนออนไลน์ 
วัชรพล วิบูลยศริน (2557: 132-134) ได้ให้แนวคิดเกี่ยวกับองค์ประกอบของการสอนบน

อินเทอร์เน็ตโดยสามารถแบ่งออกเป็น 4 องค์ประกอบ คือ 
2.1 ระบบบริหารจัดการเรียนรู้ (Learning Management System) เป็นระบบที่ช่วย

ในการจัดการห้องเรียนเสมือน มีการลงทะเบียนก่อนเข้าสู่ระบบเพ่ือใช้สิทธิเข้าเรียน จัดการรายวิชา
และเป็นแหล่งรวบรวมเครื่องมือต่างๆ เพ่ืออ านวยความสะดวกในการจัดกลุ่มเนื้อหาและกิจกรรมการ
เรียนการสอน บันทึกการเข้าเรียน การสื่อสารระหว่างผู้เรียนกับผู้สอน และการรายงานผลให้กับ
ระบบ การศึกษาเมื่อผู้เรียนท าแบบทดสอบและได้รับการประเมินบนเครือข่ายอินเทอร์เน็ต สามารถ
แบ่งเป็น 5 ส่วนย่อย คือ การจัดการหลักสูตร การจัดการเนื้อหา ระบบการทดสอบและประเมิน
เครื่องมือใน 4 รายวิชา และระบบจัดการข้อมูล 

2.2 เนื้อหาในบทเรียนอิเล็กทรอนิกส์บนเครือข่าย (Content in Courseware) เป็น
องค์ประกอบที่ส าคัญที่สุดส าหรับการสอนบนเว็บ เนื้อหาสาระผ่านระบบอินเทอร์เน็ตและเทคโนโลยี
เว็บ โดยผู้เรียนสามารถศึกษาเนื้อหาด้วยตนเองเพ่ือปรับเปลี่ยนข้อมูลเป็นความรู้ เนื้อหาดังกล่าว
น าเสนอในลักษณะของสื่อประสม ซึ่งงประกอบด้วย ตัวอักษร ภาพนิ่ง ภาพเคลื่อนไหว กราฟิก และ
เสียง เน้นการออกแบบที่ใช้ขั้นตอนวิธีการ กลยุทธ์การเรียนการสอน การมีปฏิสัมพันธ์ระหว่างผู้เรียน
กับเนื้อหาและการให้ผลป้อนกลับแก่ผู้เรียนโดยทันทีในการน าเสนอ 
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2.3 การติดต่อสื่อสาร (Communication) เป็นเครื่องมือในการติดต่อสื่อสารที่จัดให้
ผู้เรียนได้ใช้ในการติดต่อสอบถาม ปรึกษาหารือ สนทนา แลกเปลี่ยนข้อความ ความคิดเห็นระหว่าง
ผู้เรียนและผู้สอน และระหว่างผู้สอนกับเพ่ือนร่วมชั้นเรียนคนอ่ืนๆ หรือด าเนินกิจกรรมการเรียนการ
สอนในรูปแบบของการบรรยาย การสัมภาษณ์ผู้เชี่ยวชาญ การอภิปรายออนไลน์อย่างไม่จ ากัดเวลา
และสถานที่บนเครือข่ายอินเทอร์เน็ต หรืออาจจะเรียกได้ว่าเป็นห้องเรียนเสมือนก็ได้ โดยการ
ติดต่อสื่อสารอาจแบ่งได้เป็น 2 ลักษณะ คือ แบบประสานเวลา (Synchronous) เช่น การสนทนาไอซี
คิว การถ่ายทอดสัญญาณภาพและเสียงแบบสดบนเว็บ การประชุมทางไกลผ่านระบบวิดีโอ และแบบ
ไม่ประสานเวลา (Asynchronous) เช่น ไปรษณีย์อิเล็กทรอนิกส์ กลุ่มข่าว กระดานอภิปราย กระดาน 
ประกาศ และบล็อก   

2.4 การประเมิน (Assessment) เป็นการให้ผลป้อนกลับแก่ผู้เรียนเพ่ือให้ทราบถึง
ความสามารถของตนเอง อันจะน าไปสู่การปรับวิธีการเรียนหรือพฤติกรรมการเรียนได้อย่างถูกต้อง
โดยการประเมินความสามารถของผู้เรียนนี้จ าเป็นต้องทราบระดับความรู้เดิมของผู้เรียนด้วยการท า
แบบทดสอบก่อนเรียน (Pre-Test) เพ่ือให้ผู้เรียนได้เลือกเรียนเนื้อหาในบทเรียนที่เหมาะสมกับตน
และในแต่ละบทอาจมีการสอบย่อยตอนท้าย (Quiz) หรือการประเมินระหว่างทาง และสอบท้ายเทอม 
ก่อนที่จะจบหลักสูตรเป็นการประเมินปลายทาง นอกจากนี้ผู้เรียนควรประเมินผู้สอนและประเมินผล
การจัดการเรียนการสอนเพ่ือให้ผู้สอนน าข้อมูลไปปรับปรุงแก้ไขการสอนบนเว็บต่อไป 

 

2.3.2 Google App ส าหรับการศึกษา 
Google App ส าหรับการศึกษา (Google Apps for Education) คือ ชุดของอีเมลล์ฟรี

และแอปพลิเคชั่นต่างๆ ที่ถูกพัฒนาขึ้นมาโดย Google เพ่ือให้บริการด้านการศึกษาโดยเฉพาะ ที่เปิด
กว้างส าหรับทางโรงเรียน ครู และนักเรียน ให้สามารถน าไปใช้งาน เป็นเครื่องมือเสริมในการเรียนการ
สอนแบบออนไลน์ได้ โดยที่แอปพลิเคชั่นเหล่านั้น เป็นแบบระบบเปิดที่สามารถเน้นให้เกิดการท างาน
ร่วมกัน 

ส าหรับตัวแอปพลิเคชั่นใน Google App ส าหรับการศึกษา มีอยู่มากมาย ทั้งตัวที่ได้ใช้งาน
กันบ่อยๆ และตัวที่เสริมเข้ามาส าหรับการศึกษาในชั้นเรียนโดยเฉพาะ ซึ่งมีตัวอย่างดังนี้ 

1. Gmail เป็นอีเมล์ที่ใช้ในโดเมนของทางโรงเรียน 
2. Google Classroom เป็นการสร้างห้องเรียนออนไลน์ คล้ายกับ Moodle 
3. Google Drive เป็นที่เก็บข้อมูลระบบ Cloud บริการโดยโรงเรียน 
4. Google Docs เป็นโปรแกรมสร้างเอกสาร คล้ายกับ Microsoft Word 
5. Google Sheet เป็นโปรแกรมสร้างตาราง คล้ายกับ Microsoft Excel 
6. Google Slide เป็นโปรแกรมสร้างสื่อน าเสนอ คล้ายกับ Microsoft PowerPoint 
7. Google Form เป็นโปรแกรมสร้างแบบสอบถามหรือแบบทดสอบ 
8. Google Site เป็นโปรแกรมสร้างเว็บไซต์ภายใต้โดเมนของ Google 
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2.3.3 หลักการ ADDIE Model 
ADDIE Model (มนต์ชัย เทียนทอง. 2545: 131-136) เป็นกระบวนการพัฒนารูปแบบการ

สอนที่นักออกแบบการเรียนการสอนและนักพัฒนาการฝึกอบรมนิยมใช้กัน และเป็นแนวทางที่มี
ลักษณะที่ยืดหยุ่นเพ่ือให้สามารถน าไปสร้างเป็นเครื่องมือได้อย่างมีประสิทธิภาพ มีด้วยกันอยู่ 5 
ขั้นตอน ดังต่อไปนี้ 

1. ขั้นวิเคราะห์ (Analysis Phase) 
ในขั้นนี้เป็นการท าความเข้าใจปัญหา เป้าหมายและวัตถุประสงค์ที่จะสร้างขึ้นตลอดจน

ความรู้พื้นฐานและทักษะของเป้าหมายที่จ าเป็นต้องมี โดยมีรายละเอียดการวิเคราะห์ดังนี้ 
1.1 ด้านเนื้อหา ควรจะวิเคราะห์จากปัญหาและความต้องการของกลุ่มเป้าหมาย และ

เนื้อหาที่จะน ามาสร้างเป็นบทเรียน มาท าให้สอดคล้องกัน มีข้ันตอนวิเคราะห์เนื้อหา คือ 
1.1.1 ศึกษาวัตถุประสงค์ของบทเรียน 
1.1.2 คิดหัวข้อในบทเรียนให้สอดคล้องกับวัตถุประสงค์ 
1.1.3 จัดล าดับเนื้อหา 
1.1.4 แบ่งกลุ่มหัวข้อในบทเรียน 
1.1.5 จัดล าดับความส าคัญของแต่ละหัวข้อในบทเรียน 

1.2 ด้านกลุ่มเป้าหมาย ควรจะวิเคราะห์ข้อมูลเกี่ยวกับตัวเป้าหมาย 
1.3 ด้านสภาพแวดล้อม ควรจะวิเคราะห์ข้อมูลรวบตัวเป้าหมาย อย่างพวกสถานที่กับ

อุปกรณ์ท่ีอยู่รอบตัวกลุ่มเป้าหมาย 
2. การออกแบบ (Design Phase) 
ขั้นตอนการออกแบบควรจะท าอย่างเป็นระบบ มีระเบียบแบบแผนของการจ าแนก การ

พัฒนา และการประเมินแผนยุทธวิธีที่วางไว้เพื่อให้บรรลุเป้าหมาย พร้อมทั้งออกแบบโดยใช้ความคิดที่
ได้วิเคราะห์ไว้มาน าเสนอเป็นรูปธรรม ซึ่งจะแบ่งออกเป็น 3 ส่วน ดังนี้ 

2.1 ส่วนบทเรียน วิเคราะห์และออกแบบส่วนประกอบต่างๆ ได้แก่ วัตถุประสงค์ 
เนื้อหา แบบทดสอบ สื่อ กิจกรรม และวิธีการน าเสนอ 

2.2 ส่วนผังงาน (Flowchart) ออกแบบแผนภูมิที่แสดงให้เห็นขั้นตอนและวิธีการใน
การด าเนินบทเรียนให้เป็นเนื้อเรื่อง (Storyboard) ที่ประกอบด้วยหัวข้อในบทเรียนที่จัดล าดับตามที่
ได้วิเคราะห์ไว้ ในรูปแบบต่างๆ 

2.3 ส่วนหน้าจอแสดงผล ควรจะจัดพ้ืนที่และองค์ประกอบบนจอภาพที่จะใช้ในการ
น าเสนอบทเรียนในรูปแบบต่างๆ รวมทั้งต้องสอดคล้องกับกลุ่มเป้าหมาย วัตถุประสงค์ และเนื้อหา 

3. ขั้นการพัฒนา (Development Phase) 
ขั้นท่ีผู้ออกแบบต้องลงมือปฏิบัติการสร้างบทเรียนตามท่ีได้มีการออกแบบส่วนต่างๆของ

บทเรียนไวใ้นขั้นตอนก่อนหน้า 
4. ขั้นการน าไปด าเนินการ (Implementation Phase) 
ขั้นท่ีน าบทเรียนท่ีพัฒนาในรูปแบบของสื่อดิจิตอลมาเผยแพร่บนระบบเครือข่ายอินเตอร์เน็ต 

เพื่อให้กลุ่มเป้าหมายได้เรียนรู้และท ากิจกรรมต่างๆ ในบทเรียน เพื่อท าการเก็บข้อมูล ความคิดเห็น 
ข้อเสนอแนะ และปัญหาต่างๆ ท่ีพบเจอในระหว่างการใช้งาน 
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5. ขั้นการประเมินผล (Evaluation Phase) 
การประเมินผลเป็นขั้นตอนท่ีจะต้องท าในทุกขั้นตอนของโมเดลนี้ ต้ังแต่ขั้นวิเคราะห์ ขั้น

ออกแบบ ขั้นพัฒนา และขั้นน าไปใช้จริง โดยจะท าให้ผู้พัฒนาทราบถึงข้อมูลและปัญหาท่ีจะต้องน ามาใช้
ในการปรับปรุงแก้ไขข้อบกพร่องต่างๆ ซึ่งจ าแนกการประเมินได้เป็น 2 ประเภท ดังนี้ 

5.1 การประเมินระหว่างการด าเนินงาน (Formative Evaluation) 
5.2 การประเมินภายหลังการด าเนินงาน (Summative Evaluation)  

 

2.3.4 การหาคุณภาพของบทเรียน 
ส าหรับการตรวจสอบคุณภาพของบทเรียน จะต้องมีเกณฑ์ท่ีเชื่อถือได้ และต้องได้รับการ

ตรวจสอบจากผู้ทรงคุณวุฒิ ด้านสื่อและเทคนิคการผลิต ซึ่ ง  ไพโรจน์ ตีรณธนากุล และคณะ  
(2546: 197-202) ได้ระบุเกณฑ์ในการประเมินคุณภาพของบทเรียนออนไลน์ไว้ดังนี้ 

1. การตรวจสอบคุณภาพด้านเนื้อหา 
1.1 การน าเข้าสู่บทเรียนมีความน่าสนใจ 
1.2 บทเรียนมีการออกแบบให้ใช้งานง่าย ไม่ซับซ้อน  
1.3 บทเรียนมีการแบ่งเนื้อหาอย่างเหมาะสม 
1.4 เนื้อหาในบทเรียนมีความสอดคล้องกับวัตถุประสงค์  
1.5 บทเรียนมีความยากง่ายเหมาะสมกับนักเรียน 
1.6 เนื้อหามีความถูกต้อง  
1.7 ภาษาที่ใช้สามารถสื่อความหมายได้อย่างชัดเจน 
1.8 บทเรียนมีตัวอย่างท่ีจ าเป็นในปริมาณและโอกาสที่เหมาะสม 
1.9 ข้อสอบหรือแบบทดสอบมีจ านวนท่ีเหมาะสม 
1.10 รูปภาพประกอบสามารถสื่อความหมายได้ชัดเจนและสอดคล้องกับเนื้อหา  

2 การตรวจสอบคุณภาพด้านเทคโนโลยีมัลติมีเดีย 
2.1 ด้านตัวอักษร 

2.1.1 ตัวอักษรมีขนาดเหมาะสม 
2.1.2 ตัวอักษรมีรูปแบบท่ีอ่านง่ายและชัดเจน 
2.1.3 ตัวอักษรมีสีท่ีเหมาะสมกับสีพื้นหลัง 
2.1.4 ข้อความมีความถูกต้องตามหลักภาษา 

2.2 ด้านรูปภาพ 
2.2.1 ภาพมีขนาดที่เหมาะสม 
2.2.2 ภาพมีสีคมชัดและชัดเจน 
2.2.3 ภาพที่ใช้สามารถสื่อความหมายได้อย่างเหมาะสม 

2.3 ด้านเสียง 
2.3.1 เสียงประกอบมีความเหมาะสม 
2.3.2 เสียงประกอบมีความน่าสนใจ 
2.3.3 เสียงประกอบมีความชัดเจน 
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2.4 ด้านการปฏิสัมพันธ์ 
2.4.1 บทเรียนสามารถควบคุมได้ง่ายและสะดวก 
2.4.2 บทเรียนมีการเยื่อมโยงเนื้อหาภายในหัวข้อเหมาะสม 
2.4.3 บทเรียนมีการเชื่อโยงเนื้อหาระหว่างหัวข้อได้อย่างเหมาะสม 

2.5 ด้านแบบทดสอบ 
2.5.1 แบบทดสอบมีการน าเสนอข้อสอบในรูปแบบที่เหมาะสม 
2.5.2 แบบทดสอบมีการรายงานผลการทดสอบ 

 

2.3.5 การหาประสิทธิภาพ E1/E2 
เกณฑ์ประสิทธิภาพ คือ ระดับประสิทธิภาพของบทเรียนที่จะช่วยให้นักเรียนเกิดการเรียนรู้ 

เป็นระดับที่ผู้พัฒนาบทเรียนพึงพอใจว่าบทเรียนชุดนั้นมีประสิทธิภาพมากพอจนสามารถที่จะน าไปใช้
ในการเรียนการสอนได้ (ชัยยงค์ พรหมวงศ์. 2556: 7-20) 

การพัฒนาบทเรียนในรูปสื่อการเรียนการสอนหรือวิธีสอน จะต้องมีการตรวจสอบ
ประสิทธิภาพของบทเรียนที่พัฒนาขึ้น โดยทั่วไปนิยมน าเสนอในรูปของ E1/E2 ( อ่านว่า E1 ทับ E2 ) 
หรือ E1:E2 ( อ่านว่า E1 ต่อ E2 ) ซึ่งไม่ได้เป็นทั้งเศษส่วนหรืออัตราส่วน เป็นเพียงสัญลักษณ์ที่น ามา
เสนอเพ่ือการสื่อสารให้ทราบถึงประสิทธิภาพของนวัตกรรมดังกล่าวเท่านั้น  โดยที่แต่ละตัวมี
ความหมายดังนี้ 

1. E1 แสดงประสิทธิภาพของกระบวนการ คิดจากคะแนนเฉลี่ยในรูปแบบร้อยละของ
นักเรียนที่ท าแบบทดสอบระหว่างเรียนจากแบบฝึกทั้งหมด 

2. E2 แสดงประสิทธิภาพของผลลัพธ์ คิดจากคะแนนเฉลี่ยในรูปแบบร้อยละของนักเรียนที่
ท าแบบทดสอบหลังจากที่ได้เรียนมา 

เกณฑ์ประสิทธิภาพ E1/E2 โดยทั่วไปนิยมแสดงเป็นค่าเฉลี่ยร้อยละของคะแนน ปกติจะมี
เกณฑ์อยู่ระหว่างร้อยละ 70-90 โดยจะเขียนตามตัวอย่าง เช่น 80/80 หรือ 80:80 เป็นต้น 

การหาประสิทธิภาพ E1/E2 สามารหาได้จากสูตรของชัยยงค์ พรหมวงศ์ (2556: 7-20) ดังนี้ 
 

E1 =
∑x1

NA
×100  E2 =

∑x2

NB
×100  

 
เมื่อ E1 แทน ประสิทธิภาพของกระบวนการ ซึ่งเป็นค่าร้อยละของคะแนนเฉลี่ย

จากผลการเรียนรู้ที่ได้ระหว่างเรียน 
E2 แทน ประสิทธิภาพของผลลัพธ์ ซึ่งเป็นค่าร้อยละของคะแนนเฉลี่ยจากผล

การเรียนรู้ที่ได้หลังเรียน 
∑x1 แทน คะแนนรวมของผลการเรียนที่ได้รู้ระหว่างเรียน 
∑x2 แทน คะแนนรวมของผลการเรียนรู้ที่ได้หลังเรียน 
A แทน คะแนนเต็มของผลการเรียนรู้ระหว่างเรียน 
B แทน คะแนนเต็มของผลการเรียนรู้หลังเรียน 
N แทน จ านวนนักเรียน 
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2.4 ความรู้เกี่ยวกับการวัดผลสัมฤทธิ์ทางการเรียน 
 

2.4.1 ความหมายของผลสัมฤทธิ์ทางการเรียน 
พิชิต ฤทธิ์จรูญ (2556: 95) กล่าวว่า ผลสัมฤทธิ์ทางการเรียน หมายถึง แบบทดสอบวัด

ผลสัมฤทธิ์เป็นแบบทดสอบที่ใช้วัดความรู้ ทักษะ และความสามารถทางวิชาการที่ผู้เรียนได้เรียนรู้
มาแล้วว่าบรรลุผลส าเร็จตามจุดประสงค์ที่ก าหนดไว้เพียงใด 

ไพศาล หวังพานิช (2536: 89) กล่าวว่า ผลสัมฤทธิ์ทางการเรียน หมายถึง คุณลักษณะและ
ความสามารถของบุคคลอันเกิดจากการเรียนการสอนเป็นการเปลี่ยนแปลงพฤติกรรมและ
ประสบการณ์การเรียนที่ เกิดขึ้นจากการฝึกอบรมหรือการสอบ จึงเป็นการตรวจสอบระดับ
ความสามารถของบุคคลว่าเรียนแล้วมีความรู้เท่าใด 

เยาวดี วิบูลย์ศรี (2539: 23) กล่าวว่า ผลสัมฤทธิ์ทางการเรียน หมายถึง กระบวนการบ่งชี้
ผลผลิตหรือคุณลักษณะที่วัดได้ จากเครื่องมือวัดผลประเภทใดประเภทหนึ่ง อย่างมีระบบเป็น
กระบวนการทางวิทยาศาสตร์ที่เน้นปริมาณเป็นตัวเลขมากกว่าการบรรยายในเชิงคุณศัพท์ 

สรุปได้ว่า ผลสัมฤทธิ์ทางการเรียน หมายถึง คุณลักษณะรวมถึงความรู้ ความสามารถ
เฉพาะบุคคลที่เปลี่ยนแปลงพฤติกรรมในด้านต่างๆ อันเป็นผลมาจากการจัดการเรียนรู้ และสามารถ
วัดได้โดยการแสดงออกมาทั้ง 3 ด้าน คือ ด้านพุทธิพิสัย ด้านจิตพิสัย และด้านทักษะพิสัย 

 

2.4.2 ผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัย 
ในการวิจัยครั้งนี้ ผู้วิจัยได้วัดความรู้ของนักเรียนตามทฤษฎีการเรียนรู้ของ Bloom 

(Bloom’s Taxonomy of Educational Objectives) ด้านพุทธิพิสัย ซึ่งเป็นหนึ่งในทฤษฎีที่ใช้กัน
มากที่สุดในการการศึกษา คิดค้นโดยกลุ่มของนักวิจัยทางการศึกษาโดย Dr. Benjamin Bloom และ
คณะ (1956) โดยจะใช้การแบ่งสเกลหลายชั้นเพ่ือวัดระดับของผลที่นักเรียนจะได้รับ การแบ่งแบบนี้
จะท าให้เลือกชั้นเรียนให้เหมาะสมกับนักเรียนในแต่ละวิชา 

พุทธิพิสัย (Cognitive Domain) คือ พฤติกรรมเกี่ยวกับสติปัญญา ซึ่งแบ่งเป็นพฤติกรรม
ทางพุทธิพิสัยได้  6 ระดับ ดังนี้ 

1. ความรู้ (Knowledge) หมายถึง ความสามารถทางสมองในการจดจ าไว้สิ่งต่างๆ หรือ
รักษาไว้ซึ่งเรื่องราวต่างๆ ที่บุคคลได้รับมาเก็บไว้ในสมองได้อย่างถูกต้องแม่นย า จ าแนกย่อยออกเป็น 
3 ลักษณะ ได้แก่ 

1.1 ความรู้ในเรื่องเฉพาะ (Knowledge of Specifics) เป็นสมรรถภาพทางสมองที่จะ
เป็นพ้ืนฐานให้เกิดสมรรถภาพสมองที่ซับซ้อนขึ้นต่อไป เช่น นิยามศัพท์หรือความจริงบางอย่าง 
เป็นต้น 

1.2 ความรู้ในวิธีด าเนินการ (Knowledge of Ways and Means of Dealing with 
Specifics) เป็นความรู้ในเรื่องของวิธีการ และการจัดระเบียบ เช่น ระเบียบแบบแผน แนวโน้ม การ
จัดประเภท เกณฑ์ หรือวิธีการ เป็นต้น 

1.3 ความรู้รวบยอดในเรื่อง (Knowledge of the Universal and Abstractions in 
a Field) เป็นความรู้เกี่ยวกับข้อสรุปลักษณะส าคัญของสิ่งต่างๆ เช่น หลักวิชา หรือทฤษฎี เป็นต้น 
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2. ความเข้าใจ (Comprehension) หมายถึง ความสามารถในการจับประเด็นส าคัญของ

เรื่องราวหรือเหตุการณ์ที่เกิดขึ้น จนสามารถถ่ายทอดเรื่องราวเดิมออกมาในรูปแบบของตนเองได้โดย
ที่ยังมีความหมายเหมือนคงเดิม จ าแนกย่อยออกเป็น 3 ลักษณะ ได้แก่ 

2.1 การแปลความ (Translation) เป็นความสามารถในการถอดความหมายจากภาษา
หนึ่งไปสู่อีกภาษาหนึ่ง ซึ่งอาจแปลได้หลายลักษณะ เช่น การแผลจากการภาษาเทคนิคเป็นภาษา
สามัญการแปลภาษาพูดเป็นภาษาเขียน หรือการแปลจากพฤติกรรม รูปภาพ ท่าทาง ให้เป็นข้อความ 
เป็นต้น 

2.2 การตีความ ( Interpretation) เป็นความสามารถในการสรุปสิ่งที่เกิดขึ้น จาก
ภาพรวมทั้งหมดมาเป็นใจความส าคัญสั้นๆ ให้ได้ใจความที่เข้าใจได้ง่าย 

2.3 การขยายความ (Extrapolation) เป็นความสามารถในการขยายข้อมูลเกี่ยวกับสิ่ง
ต่างๆเพ่ิมเติม ให้เห็นภาพกว้างมากขึ้นจากข้อมูลเดิมอย่างสมเหตุสมผล แต่ยังสามารถรักษามจ
ความส าคัญเดิมเอาไว้ได้ 

3. การน าไปใช้ (Application) หมายถึง ความสามารถในการน าความรู้ที่ได้มาไปใช้
แก้ปัญหาในสถานการณ์ใหม่ ซึ่งอาจใกล้เคียงหรือคล้ายคลึงกับสถานการณ์ที่เคยพบเห็นมาก่อน 

4. การวิเคราะห์ (Analysis) หมายถึง ความสามารถในการแยกแยะเรื่องราวต่างๆ 
ออกเป็นหลายส่วน เพ่ือให้เกิดความเข้าใจจนสามารถน ามาเรียบเรียงและอธิบายให้เห็นสิ่งที่เกิด 
รวมทั้งหาความสัมพันธ์เหล่านั้นได้ จ าแนกย่อยออกเป็น 3 ลักษณะ ได้แก่ 

4.1 การวิเคราะห์ความส าคัญ (Analysis of Elements) เป็นความสามารถในการหา
หัวใจส าคัญของเรื่อง เพ่ือค้นหาสาเหตุ ผลลัพธ์ และจุดมุ่งหมายส าคัญของเรื่องต่างๆ 

4.2 การวิเคราะห์ความสัมพันธ์ (Analysis of Relationship) เป็นความสามารถใน
การค้นหาความเก่ียวข้องกันของสิ่งต่างๆ ที่เกิดขึ้น 

4.3 การวิเคราะห์หลักการ (Analysis of Organizational Principles) เป็นการค้นหา 
รูปแบบของสิ่งที่เกิดขึ้น โดยการยึดหลักการบางอย่าง 

5. การสังเคราะห์ (Synthesis) หมายถึง ความสามารถในการผสมผสานข้อมูลที่ได้จากการ
วิเคราะห์ข้อมูลมาผสมกับความรู้ที่มีเข้าด้วยกันเพ่ือให้เกิดเป็นสิ่งใหม่ มีคุณลักษณะโครงสร้างหรือ
หน้าที่ใหม่ที่แปลกแตกต่างไปจากของเดิม จ าแนกย่อยออกเป็น 2 ลักษณะ ได้แก่ 

5.1 การสั ง เคราะห์ข้ อความ (Production of Unique Communication) เป็น
ความสามารถในการสังเคราะห์ข้อความจากสื่อหนึ่ง เพ่ือหาข้อสรุปบางประการ 

5.2 การสังเคราะห์แผนงาน (Production of Plan or Proposed Set of Operation) 
เป็นความสามารถในการก าหนดแนวทางการในการท างานบางอย่างล่วงหน้าขึ้นมาใหม่ โดยให้
สอดคล้องกับข้อมูลและจุดมุ่งหมายที่วางเอาไว้ 

5.3 การสังเคราะห์ความสัมพันธ์ (Derivation of a Set of Abstract Relations) เป็น
ความสามารถในการน าเอาสิ่งต่างๆ มาจัดกลุ่มใหม่โดยมีหลักการบางอย่างมาก าหนดความสัมพันธ์ที่
แปลกไปจากเดิม 
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6. การประเมิน (Evaluation) หมายถึง ความสามารถในการพิจารณา ตัดสิน หรือลง

ข้อสรุป เกี่ยวกับคุณค่าของสิ่งใดสิ่งหนึ่ง โดยอาศัยเกณฑ์และมาตรฐานที่ได้ก าหนดเอาไว้ จ าแนกย่อย
ออกเป็น 2 ลักษณะ ได้แก่ 

6.1 ประเมินโดยอาศัยเกณฑ์ภายใน (Judgment in Terms of Internal Evidence) 
เป็นความสามารถในการตัดสินเหตุการณ์ โดยใช้ข้อมูลที่เกี่ยวข้องเป็นเกณฑ์ในการตัดสิน 

6.2 ประ เ มิ น โ ดยอ า ศั ย เ ก ณ ฑ์ ภ ายน อก  ( Judgment in Terms of External 
Evidence) เป็นความสามารถในการตัดสินเหตุการณ์ โดยใช้เกณฑ์หรือหลักการที่ก าหนดขึ้นมาใหม่ 
หรือหลักการที่ไม่ได้ก าหนดขึ้นตามเหตุการณ์นั้นๆ 

ต่อมา Lorin Anderson (ลูกศิษย์ของ Bloom) & David Krathwohl (2000) ได้ท าการ
เปลี่ยนบางส่วนของตัวทฤษฎี ดังต่อไปนี้ 

1. รู้ (Remember) หมายถึง ความสามารถในการดึงเอาความรู้ที่มีอยู่ในหน่วยความจ า
ระยะยาวออกมาใช้บอกลักษณะของสิ่งต่างๆได้ จ าแนกย่อยออกเป็น 2 ลักษณะ ได้แก่ 

1.1 จ้าได้ (Recogniz) 
1.2 ระลึกได้ (Recall) 

2. เข้าใจ (Understand) หมายถึง ความสามารถในการเข้าใจในความหมายของค าพูด 
ตัวอักษร หรือการสื่อสารจากสื่อต่างๆ ในแบบของตัวเองได้ จ าแนกย่อยออกเป็น 7 ลักษณะ ได้แก่ 

2.1 ตีความ (Interpret) 
2.2 ยกตัวอย่าง (Exemplify) 
2.3 จ าแนกประเภท (Classify) 
2.4 สรุป (Summarize) 
2.5 อนุมาน (Infer) 
2.6 เปรียบเทียบ (Compare) 
2.7 อธิบาย (Explain) 

3. น าไปใช้ (Apply) หมายถึง ความสามารถในการน าความรู้ที่มีมาใช้ในการแก้ไข
สถานการณ์ท่ีก าหนดให้ จ าแนกย่อยออกเป็น 2 ลักษณะ ได้แก่ 

3.1 ด้าเนินงาน (Execute) 
3.2 ใช้เป็นเครื่องมือ (Implement) 

4. วิเคราะห์ (Analyze) หมายถึง ความสามารถในการน าสิ่งต่างๆที่มีความซับซ้อน มา
เรียบเรียง เพ่ือให้สามารถเข้าใจ และจัดความสัมพันธ์ของสิ่งเหล่านั้นได้ จ าแนกย่อยออกเป็น 3 
ลักษณะ ได้แก่ 

4.1 บอกความแตกต่าง (Differentiate) 
4.2 จัดโครงสร้าง (Organize) 
4.3 ระบุคุณลักษณะ (Attribute) 

5. ประเมิน (Evaluate) หมายถึง ความสามารถในการตัดสินใจหรือประเมินสิ่งต่างๆ โดย
อาศัยความรู้ที่มีหรือเกณฑ์มาวิเคราะห์เพ่ือเปรียบเทียบๆได้ จ าแนกย่อยออกเป็น 2 ลักษณะ ได้แก่ 

5.1 ตรวจสอบ (Check) 
5.2 วิพากษ์วิจารณ์ (Criticize) 
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6. สร้างสรรค์ (Create) หมายถึง ความสามารถในการน าความรู้ที่มี มาวางแผนในการ
สร้างสรรค์สิ่งต่างๆที่มีความซับซ้อนออกมาได้ โดยมีความเชื่อมโยงกันอย่างมีเหตุผล จ าแนกย่อย
ออกเป็น 2 ลักษณะ ได้แก่ 

6.1 สร้าง (Generating) 
6.2 วางแผน (Planning) 
6.3 ผลิต (Producing) 

 

2.4.3 การวัดผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัย 
การวัดผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัย เป็นการวัดความสามารถด้านสติปัญญา 

เครื่องมือที่ ใช้วัดส่วนใหญ่จะเป็นแบบทดสอบ ซึ่งมีหลายประเภทขึ้ นอยู่กับเกณฑ์ที่ ใช้แบ่ง 
(พิชิต ฤทธิ์จรูญ. 2556 : 60-64) ได้แก่ 

1. แบ่งตามสมรรถภาพที่จะวัด จ าแนกได้เป็น 3 ประเภท ได้แก่ 
1.1 แบบทดสอบวัดผลสัมฤทธิ์  (Achievement Test) เป็นแบบทดสอบมุ่ งวัด

สมรรถภาพด้านสมอง ซ่ึงแบ่งย่อยได ้2 ประเภท ได้แก่ 
1.1.1 แบบทดสอบท่ีครูสร้างข้ึนเอง (Teacher-Made Test) 
1.1.2 แบบทดสอบมาตรฐาน (Standardized Test)  

1.2 แบบทดสอบวัดความถนัด (Aptitude test) เป็นแบบทดสอบที่ใช้วัดความสามารถ
ของผู้เรียนเพื่อใช้ในการท านายอนาคตของผู้เรียน ซึ่งแบ่งย่อยได้ 2 ประเภท ได้แก่ 

1.2.1 แบบทดสอบวัดความถนัดทางการเรียน (Scholastic Aptitude test) 
1.2.2 แบบทดสอบวัดความถนัดเฉพาะอย่าง (Specific Aptitude Test) 

1.3 แบบทดสอบบุคคล-สังคม (Personal-Social Test) เป็นแบบทดสอบที่มุ่งวัดด้าน
บุคลิกภาพ หรือการปรับตัวของบุคคล 

2. แบ่งตามจุดมุ่งหมายในการสร้าง จ าแนกได้เป็น 2 ประเภท ได้แก่ 
2.1 แบบทดสอบอัตนัยหรือความเรียง (Subjective Test or Essay Type) เป็น

แบบทดสอบข้อเขียนที่ให้อิสระในการตอบมากที่สุด โดยผู้สอบสามารถเขียนบรรยายตอบเป็นความ
เรียงภายในเวลาที่ก าหนด 

2.2 แบบทดสอบปรนัยหรือแบบให้ตอบสั้นๆ (Objective Test or Short Answer) 
เป็นแบบทดสอบที่ก้าหนดให้ตอบสั้นๆ หรือมีค าตอบเป็นตัวเลือกหลายข้อให้เลือกข้อที่ถูกต้อง ซึ่ง
แบ่งย่อยได้ 4 ประเภท ได้แก่ 

2.2.1 แบบถูก-ผิด (True-False) 
2.2.2 แบบเติมค้าหรือเติมข้อความ (Completion) 
2.2.3 แบบจับคู่ (Matching) 
2.2.4 แบบเลือกตอบ (Multiple Choice) 

3. แบ่งตามจุดมุ่งหมายในการใช้ประโยชน์ จ าแนกได้เป็น 2 ประเภท ได้แก่ 
3.1 แบบทดสอบเพ่ือวินิจฉัย (Diagnostic Test) เป็นแบบทดสอบที่ใช้หาข้อบกพร่อง

ของผู้สอบเพื่อน าไปเป็นข้อมูลในการปรับปรุงการเรียนรู้ของผู้เรียนและการสอนของครู 
3.2 แบบทดสอบเพ่ือท้านายหรือพยากรณ์ (Prognostic Test) เป็นแบบทดสอบที่ 

เหมาะส าหรับใช้ในการสอบคัดเลือก วัดความถนัด และการแนะแนว 
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4. แบ่งตามเวลาที่ก าหนดให้ จ าแนกได้เป็น 2 ประเภท ได้แก่ 
4.1 แบบทดสอบวัดความเร็ว (Speed Test) เป็นแบบทดสอบที่ข้อสอบง่าย ให้เวลา

ในการท าน้อย เพ่ือทดสอบการคิดแบบเร็ว  
4.2 แบบทดสอบวัดความสามารถสูงสุด (Power Test) เป็นแบบทดสอบที่ยาก และใช้

เวลานาน เพ่ือให้ผู้สอบได้แสดงความสามารถเต็มศักยภาพที่มีอยู่ 
5. แบ่งตามลักษณะการตอบ จ าแนกได้เป็น 3 ประเภท ได้แก่ 

5.1 แบบทดสอบภาคปฏิบัติ (Performance Test) เป็นแบบทดสอบให้ผู้เรียนปฏิบัติ 
5.2 แบบทดสอบเขียนตอบ (Paper-Pencil Test) เป็นแบบทดสอบที่ให้เขียนตอบ 
5.3 แบบทดสอบปากเปล่า (Oral-Test) เป็นการสอบโดยถามตอบแบบปากเปล่า  

6. แบบตามลักษณะและโอกาสในการใช้ จ าแนกได้เป็น 3 ประเภท ได้แก่ 
6.1  แบบทดสอบย่อย (Formative Test) เป็นการทดสอบท่ีมีค าถามไม่มาก ใช้ส าหรับ

การประเมินผลการเรียนการสอนหรือเมื่อเสร็จในแต่ละหน่วยย่อย เพ่ือมุ่งปรับปรุงการเรียนการสอน 
6.2 แบบทดสอบรวม (Summative Test) เป็นแบบทดสอบที่มีค าถามมาก ใช้ส้าหรับ

สอบปลายปีการศึกษาเมื่อจบเนื้อหาของแต่ละรายวิชา เพ่ือวัดความเข้าใจของแต่ละคนและน าไป
ตัดสินเป็นผลการเรียน 

7. แบ่งตามเกณฑ์การน้าผลการสอบไปประเมิน จ าแนกได้เป็น 3 ประเภท ได้แก่ 
7.1 แบบทดสอบอิงเกณฑ์ (Criterion Reference Test) เป็นแบบทดสอบที่ต้องการ

วัดระดับความรู้ของผู้เรียน โดยไปเทียบกับเกณฑ์ท่ีก าหนดไว้ 
7.2 แบบทดสอบอิงกลุ่ม (Norm Reference Test) เป็นแบบทดสอบที่ต้องการน าไป

เปรียบเทียบกันเพ่ือวัดระดับความสามารถของนักเรียนในกลุ่ม 
8. แบ่งตามสิ่งเร้า จ าแนกได้เป็น 2 ประเภท ได้แก่ 

8.1 แบบทดสอบทางภาษา (Verbal Test) 
8.2 แบบทดสอบแบบไม่ใช้ภาษา (Non-Verbal Test) 

 

2.4.4 ผลสัมฤทธิ์ทางการเรียนด้านทักษะพิสัย 
พฤติกรรมด้านทักษะพิสัยเป็นพฤติกรรมที่เกี่ยวข้องกับความสามารถในเชิงปฏิบัติการ

เกี่ยวข้องกับการใช้งานร่างกายในส่วนต่างๆ ที่ต้องอาศัยการประสานสัมพันธ์ของกล้ามเนื้อกับการ
ท างานของระบบประสาทที่เป็นหน่วยสั่งการ หากมีการฝึกฝนในการท างานของกล้ามเนื้อและระบบ
ประสาทให้มีการท างานที่สัมพันธ์กัน ย่อมจะท าให้เกิดความช านาญหรือทักษะในการปฏิบัติงาน โดย
การจ าแนกตามลักษณะของพฤติกรรมออกเป็น 5 ระดับ (กมลวรรณ ตั้งธนกานนต์. 2559: 4-6) ดังนี้ 

1. การรับรู้และการปฏิบัติพ้ืนฐาน หมายถึง การตอบสนองต่อสิ่งเร้าโดยอัตโนมัติ การรับรู้
ต่อสิ่งเร้าหรือเหตุการณ์ที่เกี่ยวข้องกับการปฏับัติ ซึ่งในขั้นตอนนี้จะเป็นการปฏับัติอย่างง่าย ไม่ต้อง
อาศัยการเรียนรู้ 

2. การเตรียมความพร้อมและการเลียนแบบ หมายถึง การเตรียมความพร้อมในการปฏิบัติ 
ตลอดจนการท าตามตัวแบบหรือค าแนะน าเกี่ยวกับการปฏิบัติต่างๆ ซึ่งในขั้นตอนนี้อาจจะยังไม่
สามารถท าได้อัตโนมัติหรือราบรื่นนัก 

3. การฝึกปฏิบัติ หมายถึง การกระท าซ้ ากันแบบเดิมอย่างต่อเนื่อง ซึ่งในขั้นตอนนี้จะ
ค่อยๆท าให้สามารถท าได้อัตโนมัติหรือราบรื่นได้มากยิ่งข้ึนมีละน้อย 
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4. การปฏิบัติด้วยความช านาญ หมายถึง การปฏิบัติงานได้อย่างคล่องแคล่ว แม่นย า และ
ช านาญ ซึ่งในขั้นตอนนี้การปฏิบัติงานจะเป็นไปอย่างอัตโนมัติหรือราบรื่น 

5. การปรับเปลี่ยนหรือสร้างปฏิบัติการ หมายถึง การเปลี่ยนแปลงการปฏิบัติการตาม
สถานการณ์ ซึ่งในข้ันตอนนี้สามารถท าให้เกิดการสร้างปฏิบัติการขึ้นใหม่ 

 

2.4.5 การวัดผลสัมฤทธิ์ทางการเรียนด้านทักษะพิสัย 
การวัดผลสัมฤทธิ์ทางการเรียนด้านทักษะพิสัย เป็นการทดสอบในการปฏิบัติงานบางอย่าง 

โดยส่วนใหญ่ทักษะการปฏิบัติประเมินการท างานหรือผลงานที่ได้ โดยมีประเด็นที่จะต้องการประเมิน 
เครื่องมือที่ใช้วัดและประเมิน (กมลวรรณ ตั้งธนกานนต์. 2559: 29-46) 

1. ประเด็นที่ต้องการจะประเมิน 
1.1 กระบวนการการปฏิบัติงาน (Process) เป็นการประเมินการท างานที่สะท้อนถึง

ประสิทธิภาพของการปฏิบัติงาน และความถูกต้องของการท างาน ซึ่งมีองค์ประกอบที่ใช้ในการ
ประเมินอยู่ 2 ด้าน ได้แก่ 

1.1.1 คุณภาพการปฏิบัติงาน 
1.1.2 เวลา 

1.2 ผลการการปฏิบัติงานหรือผลงาน (Product) เป็นการประเมินผลงานที่สร้างมา 
ซึ่งมีองค์ประกอบที่ใช้ในการประเมินอยู่ 2 ด้าน ได้แก่ 

1.2.1 คุณภาพผลงาน 
1.2.2 ปริมาณงาน 

2. ประเภทเครื่องมือวัดและประเมิน 
2.1 เครื่องมือประเภทที่ใช้ในการทดสอบ จะอยู่ในรูปของแบบสอบ (Test) ได้แก่ 

2.1.1 แบบสอบข้อเขียน (Paper and Pencil Test) สามารถแบ่งได้เป็น 2 
รูปแบบ คือ แบบสอบวัดความรู้ในเนื้อหาเกี่ยวกับการปฏิบัติ ( Item Test) ใช้วัดเนื้อหาเกี่ยวกับการ
ปฏิบัติ หรือวัดความรู้ เกี่ยวกฎหรือทฤษฏีที่ เกี่ยวข้องกับการปฏิบัติ  และแบบสอบที่ใช้อธิบาย
กระบวนการท างานหรือกระบวนการแก้ปัญหา (Practical Examination) ให้ตอบแบบอธิบายกระ
บวกการ วิธีการ หรือขั้นตอนการปฏิบัติงานต่างๆ แบบสอบข้อเขียนนี้สามารถท ากันเป็นกลุ่มได้ แต่มี
ข้อจ ากัดตรงเครื่องมือ ซึ่งควรใช้กับการสอบแบบปฏิบัติจริง หรือใช้แทนการปฏิบัติจริงที่มีอันตราย
เท่านั้น 

2.1.2 แบบสอบปากเปล่า (Oral Test) เป็นการสอบแบบที่ผู้สอบได้พูดคุยกับผู้
ทดสอบแบบเห็นหน้า ควรใช้เมื่อต้องการประเมินเป็นรายบุคคล แบบสอบปากเปล่านี้สามารถ
ปรับเปลี่ยนค าถามได้ตามต้องการ แต่ก็ต้องใช้เวลามาก 

2.2 เครื่องมือที่ไม่ใช้การทดสอบ ใช้ในการประกอบการสังเกต สามารถประเมินได้ทั้ง
ตอนท างานหรือประเมินจากผลงาน ประเภทของเครื่องมือที่ใช้ในการวัดทักษะปฏิบัติ สามารถแบ่ง
ตามลักษณะการประเมินได้ ดังนี้ 

2.2.1 แบบตรวจสอบรายการ (Checklist) เป็นรายการระบุพฤติกรรมหรือ
ลักษณะที่ระบุทักษะส าคัญที่ต้องการวัด แบบตรวจสอบรายการนี้ควรเป็นเครื่องมือที่สร้างง่ายและง่าย
ต่อการใช้งาน แต่จะไม่แสดงระดับ (Degree) ของคุณภาพหรือพฤติกรรมที่ชัดเจน 
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2.2.2 แบบประเมินค่า (Rating Scale) เป็นรายการที่ระบุพฤติกรรมหรือ

ลักษณะที่ระบุทักษะส าคัญที่ต้องการวัด แบบประเมินค่านี้สามารถให้ใส่ระดับคุณภาพของทักษะนั้น
ได้ แต่ระดับคุณภาพไม่มีการก าหนดด้วยค าบรรยายลักษณะหรือพฤติกรรมของทักษะที่ประเมิน 
อาจจะขาดความเที่ยงระหว่างผู้ประเมินได้ (Interrater Reliability) 

2.2.3 เกณฑ์การให้คะแนนแบบรูบริก (Scoring Rublic) เป็นระดับที่แสดง
ลักษณะหรือระดับความส าเร็จของการปฏิบัติงานหรือตัวผลงานของทักษะที่ประเมิน เกณฑ์จะมี
ค าอธิบายพฤติกรรมหรือลักษณะในแต่ละระดับ เหมาะส าหรับการประเมินทักษะที่มีความซับซ้อน 
โดยสามารถแบ่งออกได้เป็น 2 ประเภท ได้แก่ 

1. เกณฑ์การให้คะแนนแบบองค์รวม (Holistic Scoring Rublic) เป็นเกณฑ์ที่
พิจารณาองค์รวมของสิ่งที่จะประเมิน ปกติจะบรรยายคุณภาพโดยรวมไล่จากสูงสุดไปต่ าสุด การ
ประเมินแบบนี้เหมาะกับการประเมินงานใหญ่ ที่มีผู้รับประเมินจ านวนมาก 

2. เกณฑ์การให้คะแนนแบบแยกองค์ประกอบ (Analytic Scoring Rublic) เป็น
เกณฑ์ที่พิจารณาคุณภาพของสิ่งที่จะประเมินแบบแยกองค์ประกอบออกเป็นหลายส่วน ปกติจะ
บรรยายแยกองค์ประกอบโดยลดหลั่นตามระดับคุณภาพไล่จากสูงสุดไปต่ าสุด เหมาะส าหรับการ
ประเมินเพ่ือการพัฒนาผู้เรียน แต่จะใช้เวลานานกว่าเนื่องจากความซับซ้อนของการประเมินที่แบ่ง
ออกเป็นหลายส่วน 

3. ประเภทเครื่องมือวัดและประเมิน 
สุรชัย มีชาญ (2004 : 114) กล่าวว่า Rater Agreement Index หรือ RAI คือ ดัชนีความ

สอดคล้องระหว่างผู้ประเมิน เป็นตัวบ่งชี้ระดับความสอดคล้องของคะแนนที่ได้จากผู้ประเมิน 2 คนขึ้น
ไปในการใช้เกณฑ์เดียวกันตัดสินผลงานชิ้นเดียวกัน โดยสามารถมีค่าได้ระหว่าง 0 - 1 ถ้าค่าที่ได้เข้า
ใกล้ 1 แสดงว่าคะแนนที่ผู้ประเมินได้สอดคล้องกันสูงมาก แต่ถ้ามีค่าเข้าใกล้ 0 แสดงว่คะแนนที่ผู้
ประเมินได้มีความสอดคล้องกันไม่มาก 

3.1 กรณีที่มีเกณฑ์การประเมิน 1 เกณฑ์ นักเรียน 1 คน และผู้ประเมิน 2 คน 
ค านวณหาดัชนีความสอดคล้องระหว่างผู้ประเมิน ได้ดังนี้ 

 

RAI = 1 - 
|R1 - R2|

I - 1
 

 
RAI แทน ดัชนีความสอดคล้องระหว่างผู้ประเมิน 
R1 แทน คะแนนที่ได้จากผู้ประเมินคนที่ 1 
R2 แทน คะแนนที่ได้จากผู้ประเมินคนที่ 2 
I แทน จ านวนของคะแนนทั้งหมดที่เป็นไปได ้
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3.2 กรณีที่มีเกณฑ์การประเมิน 1 เกณฑ์ นักเรียน 1 คน และผู้ประเมินหลายคน 

ค านวณหาดัชนีความสอดคล้องระหว่างผู้ประเมิน ได้ดังนี้ 
 

RAI = 1 - 
∑ |Rm - R̅|M

m=1

(M - 1)(I - 1)
 

 
RAI แทน ดัชนีความสอดคล้องระหว่างผู้ประเมิน 
Rm แทน คะแนนที่ได้จากผู้ประเมินคนที่ m ( m = 1, 2, 3, ..., M ) 
R̅ แทน ค่าเฉลี่ยของคะแนนที่ ได้จากผู้ประเมินทุกคน ซึ่ งสามารถ

ค านวณหาได้จากสูตรดังต่อไปนี้ 
 

R̅ = 1 - 
∑ Rm

M
m=1

M
 

 
M แทน จ านวนของผู้ประเมินทั้งหมด 
I แทน จ านวนของคะแนนทั้งหมดที่เป็นไปได ้

3.3 กรณีที่มีเกณฑ์การประเมินหลายเกณฑ์ นักเรียน 1 คน และผู้ประเมิน 2 คน 
ค านวณหาดัชนีความสอดคล้องระหว่างผู้ประเมิน ได้ดังนี้ 

 

RAI = 1 - 
∑ |R1k - R2k|K

k=1

K(I - 1)
 

 
RAI แทน ดัชนีความสอดคล้องระหว่างผู้ประเมิน 
R1k แทน คะแนนที่ได้จากผู้ประเมินคนที่ 1 ในเกณฑ์ที่ k  

( k = 1, 2, 3, ..., K และ m = 1, 2, 3, ..., M ) 
R2k แทน คะแนนที่ได้จากผู้ประเมินคนที่ 2 ในเกณฑ์ท่ี k ( k = 1, 2, 3, ..., 

K ) 
K แทน จ านวนของเกณฑ์การประเมินทั้งหมด 
I แทน จ านวนของคะแนนทั้งหมดที่เป็นไปได ้
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3.4 กรณีที่มีเกณฑ์การประเมินหลายเกณฑ์ นักเรียน 1 คน และผู้ประเมินหลายคน 

ค านวณหาดัชนีความสอดคล้องระหว่างผู้ประเมิน ได้ดังนี้ 
 

RAI = 1 - 
∑ ∑ |Rmk - Rk̅|M

m=1
K
k=1

K(M - 1)(I - 1)
 

 
RAI แทน ดัชนีความสอดคล้องระหว่างผู้ประเมิน 
Rmk แทน คะแนนที่ได้จากผู้ประเมินคนที่ m ( m = 1, 2, 3, ..., M )  

ในเกณฑ์ที่ k ( k = 1, 2, 3, ..., K ) 
Rk̅ แทน ค่าเฉลี่ยของคะแนนที่ได้จากผู้ประเมินทุกคน ในเกณฑ์ที่ k ซึ่ง

สามารถค านวณหาได้จากสูตรดังต่อไปนี้ 
 

Rk̅ = 1 - 
∑ Rmk

M
m=1

M
 

 
M แทน จ านวนของผู้ประเมินทั้งหมด 
K แทน จ านวนของเกณฑ์การประเมินทั้งหมด 
I แทน จ านวนของคะแนนทั้งหมดที่เป็นไปได ้

3.5 กรณีที่มีเกณฑ์การประเมินหลายเกณฑ์ นักเรียนหลายคน และผู้ประเมิน 2 คน 
ค านวณหาดัชนีความสอดคล้องระหว่างผู้ประเมิน ได้ดังนี้ 

 

RAI = 1 - 
∑ ∑ |R1nk - R2nk|N

n=1
K
k=1

KN(I - 1)
 

 
RAI แทน ดัชนีความสอดคล้องระหว่างผู้ประเมิน 
R1nk แทน คะแนนที่ได้จากผู้ประเมินคนที่ 1 ของนักเรียนคนที่ n  

เกณฑ์ที่ k ( n = 1, 2, 3, ..., N และ k = 1, 2, 3, ..., K ) 
R2nk แทน คะแนนที่ได้จากผู้ประเมินคนที่ 2 ของนักเรียนคนที่ n  

เกณฑ์ที่ k ( n = 1, 2, 3, ..., N และ k = 1, 2, 3, ..., K ) 
N แทน จ านวนของนักเรียนทั้งหมด 
K แทน จ านวนของเกณฑ์การประเมินทั้งหมด 
I แทน จ านวนของคะแนนทั้งหมดที่เป็นไปได ้
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3.6 กรณีท่ีมเีกณฑ์การประเมินหลายเกณฑ์ นักเรียนหลายคน และผู้ประเมินหลายคน 

ค านวณหาดัชนีความสอดคล้องระหว่างผู้ประเมิน ได้ดังนี้ 
 

RAI = 1 - 
∑ ∑ ∑ |Rmnk - Rnk̅|M

m=1
N
n=1

K
k=1

KN(M - 1)(I - 1)
 

 
RAI แทน ดัชนีความสอดคล้องระหว่างผู้ประเมิน 
Rmnk แทน คะแนนที่ได้จากผู้ประเมินคนที่ m ของนักเรียนคนที่ n  

เกณฑ์ที่ k ( m = 1, 2, 3, ..., M ; n = 1, 2, 3, ..., N  
และ k = 1, 2, 3, ..., K ) 

Rnk̅ แทน ค่าเฉลี่ยของคะแนนที่ได้จากผู้ประเมินทุกคน ของนักเรียน 
คนที่ n  ในเกณฑ์ที่ k ซึ่งสามารถค านวณหาได้จากสูตร
ดังต่อไปนี้ 

 

Rk̅ = 1 - 
∑ Rmnk

M
m=1

M
 

 
M แทน จ านวนของผู้ประเมินทั้งหมด 
N แทน จ านวนของนักเรียนทั้งหมด 
K แทน จ านวนของเกณฑ์การประเมินทั้งหมด 
I แทน จ านวนของคะแนนทั้งหมดที่เป็นไปได ้

โดยค่าดัชนีความสอดคล้องระหว่างผู้ประเมิน (RAI) ควรมีค่าตั้งแต่ 0.5 ขึ้นไป จึงจะถือว่า
ผ่านเกณฑ ์
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2.5 งานวิจัยที่เกี่ยวข้อง 
 

2.5.1 งานวิจัยในประเทศ 
ส าหรับงานวิจัยภายในประเทศที่เกี่ยวกับการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานนั้น

ยังมีจ านวนน้อย ท าให้หางานวิจัยที่ตรงกับเรื่องที่ท าได้ยาก ผู้วิจัยจึงได้ค้นหางานวิจัยที่ใกล้เคียงกับ
เรื่องท่ีท ามาแทน ดังนี้ 

ปิยาภรณ์ พุ่มแก้ว และคณะ (2560: 49-59) ท าการวิจัยเรื่อง “การพัฒนาครูด้านการ
ออกแบบการจัดการเรียนรู้บนฐานความต้องการของผู้เรียน” ระบุไว้ว่า งานวิจัยนี้มีวัตถุประสงค์เพ่ือ
พัฒนาครูในด้านการออกแบบการเรียนรู้บนฐานความต้องการของผู้เรียน ด้วยการจัดการเรียนรู้แบบ
บูรณาการโดยใช้โครงงานเป็นฐาน กลุ่มเป้าหมายเป็นครูผู้สอนในสถานศึกษา แบ่งเป็นครูผู้สอน
ระดับชั้นมัธยมศึกษาตอนต้นและตอนปลายประมาณ 20 คน มาร่วมกิจกรรมซึ่งมี 4 ขั้นตอน ได้แก่ 
ขั้นสร้างการเรียนรู้โดยการอบรมเกี่ยวกับแนวคิดและหลักการออกแบบการเรียนรู้ ขั้นหนุนน าสู่การ
ปฏิบัติเป็นการน าผลจากการอบรมไปด าเนินการออกแบบและจัดการเรียนรู้ ขั้นชี้แนะสร้างเสริม
ก าลังใจ เป็นกิจกรรมการโค้ชครู และขั้นสะท้อนผลร่วมเรียนรู้  เครื่องมือที่ใช้ในการวิจัย เป็นแบบ
สังเกตการออกแบบกิจกรรมการเรียนรู้ของครู ผลการวิจัยพบว่า ครูมีความสามารถในการออกแบบ
การเรียนรู้บนฐานความต้องการของผู้เรียนอยู่ในระดับดีมาก 

รัตตมา รัตนวงศา (2559: 3-20) ได้ท าการวิจัยเรื่อง “การพัฒนารูปแบบการเรียนการสอน
ในสภาพแวดล้อมแบบเกมมิฟิเคชันโดยใช้การออกแบบเป็นฐานร่วมกับเครื่องมือทางทัศนะเพ่ือ
ส่งเสริมการรู้ทางทัศนะและแรงจูงใจใฝ่สัมฤทธิ์ส าหรับนิสิตนักศึกษาระดับปริญญาบัณฑิต” ซึ่งได้ระบุ
ไว้ว่า การวิจัยในครั้งนี้มีวัตถุประสงค์เพ่ือศึกษาสภาพปัญหาและความต้องการในการจัดการเรียนการ
สอน พัฒนารูปแบบ ศึกษาผลของการใช้รูปแบบ ศึกษาความสัมพันธ์ของการรู้ทางทัศนะและแรงจูงใจ
ใฝ่สัมฤทธิ์ และน าเสนอรูปแบบ โดยมีผู้เชี่ยวชาญรวมจ านวน 28 คน จากด้านเทคโนโลยีการศึกษา 
ด้านการรู้ทางทัศนะ และด้านจิตวิทยาการศึกษา มีกลุ่มทดลองคือ นิสิตนักศึกษาระดับปริญญาบัณฑิต 
68 คน ผลการวิจัยพบว่า รูปแบบที่พัฒนาขึ้นท าให้คะแนนเฉลี่ยการรู้ทางทัศนะและแรงจูงใจใฝ่
สัมฤทธิ์หลังเรียนของกลุ่มตัวอย่างสูงกว่าคะแนนเฉลี่ยก่อนเรียน 

ลือชา ลดาชาติ และลฎาภา ลดาชาติ (2561 : 246-260) ได้ท าการวิจัยเรื่อง “จากการรู้
วิทยาศาสตร์และการสืบเสาะสู่สะเต็มศึกษาและการออกแบบ” ซึ่งเป็นวิจัยประเภทส ารวจ ได้ระบุไว้
ว่าการศึกษาในปัจจุบันได้มีการน าสะเต็มศึกษามาใช้จนได้รับความสนใจมากขึ้นในช่วงไม่กี่ปีที่ผ่านมา 
โดยการเปลี่ยนแปลงจากเดิมที่เป็นการรู้วิทยาศาสตร์มาเป็นสะเต็มศึกษา อันเป็นเหตุให้เกิดการ
เปลี่ยนแปลงแนวทางการจัดการเรียนการสอน เพ่ือให้สอดคล้องกับทักษะที่จ าเป็นในศตวรรษที่ 21 
จึงได้มีการน าเสนอรูปแบบการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานเข้ามาช่วย ซึ่งจะเน้นไป
ทางด้านการออกแบบการสร้างชิ้นงานตามความคิด สามารถสร้างกระบวนการคิดและการท างานเป็น
ทีมได้ จากการวิจัยได้แสดงให้เห็นว่ารูปแบบการจัดการเรียนรู้มีการออกแบบเป็นฐานนี้ยังไม่ค่อยได้มี
การน าเข้ามาใช้ในประเทศไทยจึงถือว่าเป็นทางเลือกใหม่ส าหรับครูผู้สอนหลายคนที่จะน าไป
ประยุกต์ใช้ในห้องเรียน 
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2.5.2 งานวิจัยจากต่างประเทศ 
ส าหรับงานวิจัยจากต่างประเทศที่เกี่ยวกับการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน

นั้นที่ตรงกับเรื่องที่ท ายังมีจ านวนน้อย ท าให้ผู้วิจัยจึงได้ค้นหางานวิจัยที่ใกล้เคียงกับเรื่องที่ท ามาแทน 
ดังนี้ 

Bekker et. al. (2015: 29-38) ได้ท าการวิจัยเกี่ยวกับ การสอนความรู้เกี่ยวกับดิจิตอลกับ
เด็กผ่านการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานด้วยเครื่องมือดิจิตอลในโรงเรียน ซึ่งได้ระบุไว้ว่า
จะท าการสอนเด็กในระดับประถมและมัธยมศึกษา โดยจะเน้นไปที่การใช้เครื่องมือสนับสนุนการ
เรียนรู้ของเด็กในด้านต่างๆ มีการขอความร่วมมือจากผู้ที่เกี่ยวข้อง เช่น ครู เด็ก ค้นหาข้ออมูล รวมทั้ง
นักวิจัยทางการศึกษา มาค้นหาวิธีที่จะน าเอาการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานมา
ประยุกต์เข้ากับการเรียนการสอนในโรงเรียน เนื่องจากการออกแบบเป็นส่วนที่ส าคัญส าหรับเครื่องมือ
ดิจิตอลและขั้นตอนในการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานนี้ ในงานนี้ได้พัฒนาการจัดการ
เรียนรู้โดยใช้การออกแบบเป็นฐานใหม่โดยเพ่ิมการสะท้อนผลซึ่งเป็นความท้าทายที่จะท าให้สอดคล้อง
กับการเรียนการสอนของโรงเรียน ความสามารถของครู ความสนใจของเด็ก และให้เข้ากับข้อมูลที่ผู้
ค้นหาได้มา ทีส่ามารถสนับสนุนเป้าหมายในการเรียนการสอนตามความต้องการของรัฐบาล 

Chandrasekaran et. al. (2013: 1109 - 1118) ได้ท าการวิจัยเกี่ยวกับ การจัดการเรียนรู้
โดยใช้การออกแบบเป็นฐานมุ่งเน้นด้านโครงการมาช่วยในการปรับมุมมองของนักเรียนให้ตรงกับ
ความต้องการด้านอุตสาหกรรม ซึ่งได้ระบุไว้ว่าจะเน้นการปรับมุมมองของนักเรียน โดยเป็นการ
ร่วมมือกันของการเรียนรู้ในสถานศึกษากับความต้องการด้านอุตสาหกรรมเพ่ือให้เกิดกระบวนการที่
จะน าไปสู้การคิดแบบวิเคราะห์ที่เชื่อมไปยังทฤษฎีและการฝึกฝน เพ่ือพัฒนาความรู้และความสามารถ
ของนักเรียน เริ่มจากการใช้การจัดการเรียนรู้ที่มีปัญหาเป็นฐานที่ได้เข้าไปอยู่ในระบบของโรงเรียน
ด้านวิศวกรรมทั่วโลก ซึ่งต่อมาเป็นเรียนรู้การออกแบบวางแผนในการแก้ไขปัญหา ในทุกวันนี้โครงงาน
เน้นออกแบบได้ถูกน ามาใช้กระตุ้นและสอนนักเรียนในระดับประถม มัธยมต้น และมัธยมปลาย 
นอกจากนั้นยังใช้ช่วยในการเรียนการสอนสายวิทยาศาสตร์และวิศวกรรมอีกด้วย เนื่องจากเหตุผล
เหล่านี้ท าให้การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานใช้เป็นศูนย์กลางในการสนับสนุนการเรียนรู้
ที่มีโครงการเป็นฐานเน้นปัญหา จากการออกแบบรูปแบบของอุตสาหกรรมจากวิจัยที่สืบค้นเกี่ยวกับ
ความต้องการด้านการศึกษาและด้านอุตสาหกรรมที่เน้นให้นักเรียนมีทักษะในการออกแบบเพ่ือที่จะ
เปลี่ยนความรู้ที่ได้จากสถานศึกษามาปรับใช้ตามความต้องการของอุตสาหกรรม 

Fengfeng Ke (2014: 26-39) ได้ท าการวิจัยเกี่ยวกับ การประยุกต์ใช้การจัดการเรียนรู้โดย
ใช้การออกแบบเป็นฐานผ่านการสร้างเกมส์คอมพิวเตอร์ส าหรับการศึกษา กรณีการเรียนคณิตศาสตร์
ระหว่างการออกแบบและการค านวณ ซึ่งได้ระบุไว้ว่าการจัดการเรียนรู้วิธีผสมในกรณีนี้จะเป็นการ
ตรวจสอบความสามารถในการใช้งานคอมพิวเตอร์ในการสร้างเกมส์คณิตศาสตร์ โดยมีนักเรียนใน
โรงเรียนชั้นมัธยมคึกษาตอนต้นเข้าร่วม ซึ่งมีการค้นหาข้อมูลจากกิจกรรม การส ารวจ การวิเคราะห์ 
และการสัมภาษณ์ ผู้วิจัยได้ค้นพบว่านักเรียนที่เข้าร่วมได้พัฒนาอย่างมากในวิชาคณิตศาสตร์จากการ
สร้างเกมส์คอมพิวเตอร์ และประสบการณ์จากการออกแบบสร้างเกมส์ช่วยให้นักเรียนได้พัฒนาด้าน
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คณิตศาสตร์ด้วย แม้ว่าในทางกลับกันนักเรียนที่เข้าร่วมใช้เวลาในการออกแบบเนื้อเรื่องและรูปแบบ
เกมส์มากกว่าการน าเสนอข้อมูลคณิตศาสตร์ 

Mehalik et. al. (2013: 71-85) ได้ท าการวิจัยเกี่ยวกับ การเรียนวิชาวิทยาศาสตร์ในระดับ
มัธยมศึกษาตอนต้นเปรียบเทียบระหว่างการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานกับการเรียน
แบบค้นหาตามต ารา เพ่ือหาวิธีการเรียนรู้แก่นส าคัญวิทยาศาสตร์และการลดช่องว่างระหว่างผู้เรียน
และผู้สอน ซึ่งได้ระบุไว้ว่าการวิจัยได้ให้นักเรียนระดับมัธยมศึกษาตอนต้นลองท าการออกแบบและ
สร้างระบบเตือนภัยโดยใช้ไฟฟ้า เพ่ือส่งเสริมการเรียนรู้เกี่ยวกับความคิดรวบยอดของระบบไฟฟ้า
ภายใน 4 สัปดาห์ โดยใช้การออกแบบเชิงวิศวกรรม ซึ่งทดลองที่โรงเรียนในชุมชนแห่งหนึ่งโดย
แบ่งเป็นกลุ่มที่เรียนรู้ด้วยการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานกับกลุ่มที่เรียนสืบค้นตามต ารา
แบบปกติ ผู้วิจัยได้พบว่ากลุ่มที่เรียนรู้ด้วยการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานมีผลการ
เรียนรู้ได้มากกว่าแบบปกติ 

Yaron Doppelt (2007: 55-65) ได้ท าการวิจัยเกี่ยวกับ การประเมินความคิดสร้างสรรค์
ในการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน ซึ่งได้ระบุไว้ว่าการผสานความคิดสร้างสรรค์เข้าไปใน
กระบวนการออกแบบของการท าโครงงานไม่ได้ต้องการเพียงการเรียนการสอนในโรงเรียนเท่านั้น แต่
ต้องรับเอาการประเมินผลในรูปแบบใหม่ๆ เข้ามาใช้ด้วย ในการวิจัยได้มีผู้เข้าวิจัยประมาณ 100 คนที่
เรียนวิชาวิศวกรรมจักรกลไฟฟ้าของระดับมัธยมศึกษาตอนปลาย โดยแบ่งงานเป็น 2  ส่วน คือ ส่วน
รูปเล่มอธิบายการออกแบบวางแผน และส่วนโครงงานที่ให้ท าตามที่ออกแบบ ซึ่งผู้วิจัยได้ท าการ
ส ารวจนักเรียนในระหว่างการทดลองซึ่งค้นพบว่า อย่างแรกนักเรียนได้เรียนรู้การออกแบบในรูปเล่ม 
และอย่างที่สองนักเรียนสามารถอธิบายขั้นตอนในการออกแบบได้ ซึ่งสนับสนุนโดยหลักฐานจาก
รูปเล่มของนักเรียน แต่ก็ยังมีปัญหาในการท างานเป็นทีมของนักเรียนกับการแสดงให้เห็นถึง
ความก้าวหน้าอย่างชัดเจน 

จากการศึกษาวิจัยที่เกี่ยวข้องทั้งในและต่างประเทศ พบว่า การจัดการเรียนรู้โดยใช้การ
ออกแบบเป็นฐานเป็นรูปแบบการจัดการเรียนรู้แบบใหม่ที่สามารถน าไปใช้ได้หลากหลายรูปแบบ ทั้ง
แบบที่ช่วยส่งเสริมการจัดการเรียนรู้รูปแบบอ่ืนๆ แบบที่ช่วยส่งเสริมในการเรียนรู้แต่ละวิชา หรือแบบ
ที่น ามาใช้เป็นการจัดการเรียนรู้ในรูปแบบใหม่ ที่สามารถน าไปประยุกต์ในกับวิชาที่เน้นไปทางการ
ออกแบบหรือใช้ความคิดสร้างสรรค์ได้การสร้างผลงานขึ้นมา หรืออาจจะเป็นการท าโครงการในวิชา
พ้ืนฐาน ซึ่งการจัดการเรียนรู้รูปแบบนี้นิยมใช้กับนักเรียนตั้งแต่ระดับประถมศึกษาถึงมัธยมศึกษาตอน
ปลาย 
 



 

 
 

บทท่ี 3 
วิธีด าเนนิการวิจัย 

 
ในงานวิจัย เรื่อง ผลการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์

ที่มีต่อผลสัมฤทธิ์ทางการเรียน เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ของชั้นมัธยมศึกษาปีที่ 6 
ผู้วิจัยได้วางแผนด าเนินการวิจัยตามขั้นตอน ดังนี้ 
 
3.1 ประชากรและกลุ่มตัวอย่าง  

 
3.1.1 ประชากร คือ นักเรียนระดับมัธยมศึกษาชั้นปีที่ 6 ภาคเรียนที่ 2 ปีการศึกษา 2561 

ของโรงเรียนศรัทธาสมุทร 8 ห้องเรียน จ านวนทั้งหมด 298 คน 
 

3.1.2 กลุ่มตัวอย่าง คือ นักเรียนระดับมัธยมศึกษาชั้นปีที่ 6 ภาคเรียนที่ 2 ปีการศึกษา 
2561 ของโรงเรียนศรัทธาสมุทร โดยท าการเลือกด้วยวิธีการสุ่มตัวอย่างแบบแบ่งกลุ่ม (Cluster 
Random Sampling) เริ่มจากแบ่งนักเรียนตามห้อง ท าการสุ่มห้องเรียนจ านวน 3 กลุ่ม น ามาจัดเป็น
กลุ่มหาประสิทธิภาพ 1 กลุ่ม และกลุ่มตัวอย่าง 2 กลุ่ม ได้แก่ 

1. กลุ่มท่ีใช้ในการหาประสิทธิภาพของบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา 
HTML5 จ านวน 39 คน 

2. กลุ่มทดลองท่ีเรียนตามแผนการจัดการเรียนรู้ที่พัฒนาขึ้น จ านวน 42 คน 
3. กลุ่มควบคุมท่ีเรียนตามแผนการจัดการเรียนรู้แบบปกต ิจ านวน 39 คน 

 

3.2 เครื่องมือที่ใช้ในการวิจัย  
 

3.2.1 ลักษณะของเครื่องมือ 
1. แผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน 
2. แบบประเมินคุณภาพของแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน  
3. บทเรียนออนไลน์ 
4. แบบประเมินคุณภาพของบทเรียนออนไลน์ 
5. แบบวัดผลสัมฤทธิ์ด้านพุทธิพิสัย 
6. แบบวัดผลสัมฤทธิ์ด้านทักษะพิสัย 
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3.2.2 การสร้างเครื่องมือที่ใช้ในการวิจัย 
1. การออกแบบแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน 
ผู้วิจัยได้ออกแบบการจัดการเรียนรู้ โดยใช้การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน 

เพ่ือน าไปใช้ร่วมกับบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 โดยมีขั้นตอนดังนี้ 
1.1 ศึกษาความรู้เกี่ยวกับการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน 
1.2  วิเคราะห์ค าอธิบายรายวิชา มาตรฐานและตัวชี้วัด รวมทั้งสาระการเรียนรู้กับ

เนื้อหาของวิชา การสร้างเว็บไซต์ เพ่ือท าความเข้าใจรายวิชา 
1.3 วิเคราะห์หน่วยการเรียนรู้ โดยมีเนื้อหาย่อยในการจัดการเรียนรู้ดังนี้ 

เรื่องท่ี 1 การเริ่มต้นใช้งานโปรแกรมประเภท Web Editor 
เรื่องท่ี 2 การเริ่มต้นสร้างไฟล์เว็บด้วยภาษา HTML5 
เรื่องท่ี 3 การสร้างและปรับแต่งรูปแบบหน้าเว็บ 
เรื่องท่ี 4 การใส่ภาพเพ่ิมเติมไปในหน้าเว็บ 
เรื่องท่ี 5 การสร้างลิงค์เชื่อมโยงในรูปแบบต่างๆ บนหน้าเว็บ 
เรื่องท่ี 6 การสร้างตารางและการจัดรูปแบบหน้าเว็บ 

1.4 เขียนแผนการจัดการเรียนรู้ ตามรูปแบบกิจกรรมที่ใช้การจัดการเรียนรู้โดยใช้การ
ออกแบบเป็นฐาน โดยยึดหลักกระบวนการคิดย้อนกลับของ Nelson ( 1980: ออนไลน์ ) ได้แก่ 

ขั้นที่ 1 ต้องการที่จะสอนอะไร 
ขั้นที่ 2 ระบุปัญหาจากบทเรียน 

ขั้นที่ครึ่ง หาในแบบที่ไม่เคยพบเห็นมาก่อน  
ขั้นที่ 3 ตั้งเกณฑ์การประเมิน 
ขั้นที่ 4 ให้นักเรียนได้ลองท า 
ขั้นที่ 5 สอนเนื้อหาพ้ืนฐานให้ 
ขั้นที่ 6 ให้นักเรียนได้ปรับแก้งานของตน 

1.5 น าแผนการเรียนรู้ให้อาจารย์ที่ปรึกษาและอาจารย์ที่ปรึกษาร่วมตรวจ 
1.6 ด าเนินการปรับปรุงแก้ไขแผนการจัดการเรียนรู้ ตามข้อเสนอแนะของอาจารย์ที่

ปรึกษาและอาจารย์ที่ปรึกษาร่วม 
1.7 น าแผนการเรียนรู้ให้ผู้ทรงคุณวุฒิ 3 ท่าน ท าการประเมินคุณภาพ โดยใช้แบบ

ประเมินคุณภาพแผนการจัดการเรียนรู้ เพ่ือรับการประเมินคุณภาพของแผนการจัดการเรียนรู้ ดัง
รายนามต่อไปนี้ 

รองศาสตราจารย์ ดร. ปริยาภรณ์ ตั้งคุณานันต์  
ภาควิชาครุศาสตร์อุตสาหกรรม 
คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี 
สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 
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ผู้ช่วยศาสตราจารย์ ดร. อัคพงศ์ สุขมาตย์  
ภาควิชาครุศาสตร์อุตสาหกรรม 
คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี 
สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 

นายสราวุธ วงษ์จ ู
ครูวิชาคอมพิวเตอร์ 
กลุ่มสาระการงานอาชีพและเทคโนโลยี 
โรงเรียนศรัทธาสมุทร จังหวัดสมุทรสงคราม 

1.8 ด าเนินการปรับปรุงแก้ไขแผนการจัดการเรียนรู้ ตามข้อเสนอแนะของผู้ทรงคุณวุฒิ
ทั้ง 3 ท่าน 

1.9 ได้แผนการจัดการเรียนรู้ดังแสดงในภาคผนวกที่ ข.1 ไปใช้กับนักเรียนกลุ่ม
ตัวอย่าง ร่วมกับบทเรียนออนไลน์ เพ่ือหาประสิทธิภาพและผลสัมฤทธิ์ทางการเรียน 
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ภาพที่ 3.1 ขั้นตอนการสร้างแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน  
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2 การสร้างแบบประเมินคุณภาพแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน 
ผู้วิจัยได้ด าเนินการสร้างแบบสอบถามความคิดเพ่ือที่จะให้ผู้ทรงคุณวุติ ได้ประเมินคุณภาพ

ของแผนการจัดการเรียนรู้ที่พัฒนาขึ้น โดยมีขั้นตอนดังนี้ 
2.1 ศึกษาความรู้เกี่ยวกับการประเมินคุณภาพของแผนการจัดการเรียนรู้ 
2.2 ก าหนดหัวข้อที่จะประเมินแผนการจัดการเรียนรู้ ตามกรอบแนวคิดของกรอบ

แนวคิดของสุวิทย์ มูลค า และคณะ (2551 : 207-210) ในการตรวจสอบคุณภาพของแผนการจัดการ
เรียนรู้ ดังนี้ 

1. จุดประสงค์การจัดการเรียนรู้ 
2. เนื้อหาสาระ  
3. กิจกรรมการจัดการเรียนรู้ 
4. สื่อการจัดการเรียนรู้ 
5. การวัดและประเมินผล  
6. ความสอดคล้องขององค์ประกอบต่างๆของแผนการจัดการเรียนรู้ 

2.3 ก าหนดระดับความคิดเห็นเป็นมาตรฐานแบบประเมินค่า (Rating Scale) ตามวิธี
ของลิเคอร์ท (Likert) ซึ่งมี 5 ระดับ ดังนี้ 

5 หมายถึง คุณภาพอยู่ในระดับดีมาก 
4 หมายถึง คุณภาพอยู่ในระดับดี 
3 หมายถึง คุณภาพอยู่ในระดับปานกลาง 
2 หมายถึง คุณภาพอยู่ในระดับพอใช้ 
1 หมายถึง คุณภาพอยู่ในระดับควรปรับปรุง 

2.4 สร้างแบบประเมินแผนการจัดการเรียนรู้ 
2.5 น าแบบประเมินไปเสนออาจารย์ที่ปรึกษาและอาจารย์ที่ปรึกษาร่วม เพ่ือ

ตรวจสอบความถูกต้อง เหมาะสม ชัดเจน และครอบคลุม 
2.6 ด าเนินการปรับปรุงแก้ไขแบบประเมิน ตามข้อเสนอแนะของอาจารย์ที่ปรึกษา

และอาจารย์ที่ปรึกษาร่วม 
2.7 น าแบบประเมินที่แก้ไขแล้ว ดังที่แสดงในภาคผนวก ข.2 ไปให้ผู้ทรงคุณวุฒิท าการ

ประเมิน  
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ภาพที่ 3.2 ขั้นตอนการสร้างแบบประเมินคุณภาพของแผนการจัดการเรียนรู้ 
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3 การสร้างบทเรียนออนไลน์ 
บทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 สามารถน าข้อมูลความรู้

เกี่ยวกับบทเรียน ใบความรู้ ใบงาน วิดีโอบรรยาย หรือแบบฝึกหัดกับแบบทดสอบให้นักเรียนท าบน
เว็บไซต์ โดยพัฒนาตามหลักการ ADDIE Model (มนต์ชัย เทียนทอง. 2545: 131-136) ดังนี้ 

3.1 ขั้นการวิเคราะห์ (Analysis) 
3.1.1 วิเคราะห์ค าอธิบายรายวิชา มาตรฐานและตัวชี้วัด รวมทั้งสาระการเรียนรู้

กับเนื้อหาของวิชา การสร้างเว็บไซต์ เพ่ือท าความเข้าใจรายวิชา 
3.1.2 วิเคราะห์หน่วยการเรียนรู้ โดยมีเนื้อหาในการจัดการเรียนรู้ดังนี้ 

เรื่องท่ี 1 การเริ่มต้นใช้งานโปรแกรมประเภท Web Editor 
เรื่องท่ี 2 การเริ่มต้นสร้างไฟล์เว็บด้วยภาษา HTML5 
เรื่องท่ี 3 การสร้างและปรับแต่งรูปแบบหน้าเว็บ 
เรื่องท่ี 4 การใส่ภาพเพ่ิมเติมไปในหน้าเว็บ 
เรื่องท่ี 5 การสร้างลิงค์เชื่อมโยงในรูปแบบต่างๆ บนหน้าเว็บ 
เรื่องท่ี 6 การสร้างตารางและการจัดรูปแบบหน้าเว็บ 

3.2 ขั้นการออกแบบ (Design) 
3.2.1 ออบแบบเนื้อหาที่จะใส่ในบทเรียนออนไลน์ 
3.2.2 ออกแบบแผนงาน (Flowchart) ของบทเรียนออนไลน์  
3.2.3 ออกแบบหน้าจอการแสดงข้อมูลต่างๆ ของบทเรียนออนไลน์ 

3.3 ขั้นการพัฒนา (Development) 
3.3.1 สร้างบทเรียนออนไลน์โดยใช้ Google Site 
3.3.2 น าบทเรียนออนไลน์ไปเสนออาจารย์ที่ปรึกษาและอาจารย์ที่ปรึกษาร่วม 

เพ่ือตรวจสอบความถูกต้องและเหมาะสม รวมทั้งจุดที่ยังต้องปรับปรุงแก้ไข 
3.3.3 ปรับปรุงแก้ไขบทเรียนออนไลน์ตามที่อาจารย์ที่ปรึกษาและอาจารย์ที่

ปรึกษาร่วมให้ค าแนะน ามา 
3.3.4 น าบทเรียนออนไลน์ให้ผู้ทรงคุณวุฒิ 3 ท่าน ท าการประเมินคุณภาพของ

บทเรียนด้านเนื้อหาดังรายนามต่อไปนี้ 
รองศาสตราจารย์ ดร. ปริยาภรณ์ ตั้งคุณานันต์ 

ภาควิชาครุศาสตร์อุตสาหกรรม 
คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี 
สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 

ผู้ช่วยศาสตราจารย์ แสงอุทัย มอโท 
ภาควิชาครุศาสตร์อุตสาหกรรม 
คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี 
สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 
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นายสราวุธ วงษ์จ ู
ครูวิชาคอมพิวเตอร์ 
กลุ่มสาระการงานอาชีพและเทคโนโลยี 
โรงเรียนศรัทธาสมุทร จังหวัดสมุทรสงคราม 

3.3.5 น าบทเรียนออนไลน์ให้ผู้ทรงคุณวุฒิ 3 ท่าน ท าการประเมินคุณภาพของ
บทเรียนด้านเทคนิคดังรายนามต่อไปนี้ 

ผู้ช่วยศาสตราจารย์  ดร. ศิริรตัน์  เพ็ชร์แสงศรี 
ภาควิชาครุศาสตร์อุตสาหกรรม 
คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี 
สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 

ดร. จิรารัตน์ สิทธิวรชาติ 
ภาควิชาครุศาสตร์อุตสาหกรรม 
คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี 
สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 

รองศาสตราจารย์ อรรถพร ฤทธิเกิด 
ภาควิชาครุศาสตร์อุตสาหกรรม 
คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี 
สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 

3.3.6 ปรับปรุงแก้ไขบทเรียนออนไลน์ตามที่ผู้ทรงคุณวุฒิให้ค าแนะน ามา 
3.4 ขั้นการน าไปใช้ (Implementation) 

3.4.1 น าไปทดลองกับนักเรียน 3 กลุ่ม แบ่งเป็นกลุ่มเก่ง ปานกลาง อ่อน 
3.4.2 น าไปจริงใช้กับนักเรียน 1 ห้องเรียน 

3.5 ขั้นการประเมินผล (Evaluation) 
ท าการเก็บคะแนนของนักเรียนที่ทดลองบทเรียนออนไลน์ ทั้งระหว่างเรียนและหลัง

เรียน เพ่ือมาหาประสิทธิภาพของบทเรียน โดยใช้สูตรการหาประสิทธิภาพ E1/E2 ของชัยยงค์ พรหม
วงศ์ (2556: 7-20) ดังนี้ 
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E1 =
∑x1

NA
×100  E2 =

∑x2

NB
×100  

 
เมื่อ E1 แทน ประสิทธิภาพของกระบวนการ ซึ่งเป็นค่าร้อยละของ

คะแนนเฉลี่ยจากผลการเรียนรู้ที่ได้ระหว่างเรียน 
E2 แทน ประสิทธิภาพของผลลัพธ์ ซึ่งเป็นค่าร้อยละของคะแนน

เฉลี่ยจากผลการเรียนรู้ที่ได้หลังเรียน 
∑x1 แทน คะแนนรวมของผลการเรียนที่ได้รู้ระหว่างเรียน 
∑x2 แทน คะแนนรวมของผลการเรียนรู้ที่ได้หลังเรียน 
A แทน คะแนนเต็มของผลการเรียนรู้ระหว่างเรียน 
B แทน คะแนนเต็มของผลการเรียนรู้หลังเรียน 
N แทน จ านวนนักเรียน 
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ภาพที่ 3.3 ขั้นตอนการสร้างบทเรียนออนไลน์  
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4 การสร้างแบบประเมินคุณภาพของบทเรียนออนไลน์ 
ผู้วิจัยได้ด าเนินการสร้างแบบสอบถามความคิดเพ่ือที่จะให้ผู้ทรงคุณวุติได้ประเมินคุณภาพ

ของบทเรียนออนไลน์ โดยมีขั้นตอนดังนี้ 
4.1 ศึกษาความรู้เกี่ยวกับการประเมินคุณภาพของบทเรียนออนไลน์ 
4.2 ก าหนดจุดประสงค์และหัวข้อที่จะประเมิน 
4.3 ก าหนดระดับความคิดเห็นเป็นมาตรฐานแบบประเมินค่า (Rating Scale) ตามวิธี

ของลิเคอร์ท (Likert) ซึ่งมี 5 ระดับ ดังนี้ 
5 หมายถึง คุณภาพอยู่ในระดับดีมาก 
4 หมายถึง คุณภาพอยู่ในระดับดี 
3 หมายถึง คุณภาพอยู่ในระดับปานกลาง 
2 หมายถึง คุณภาพอยู่ในระดับพอใช้ 
1 หมายถึง คุณภาพอยู่ในระดับควรปรับปรุง 

4.4 สร้างแบบประเมินบทเรียนออนไลน์ 
4.5 น าแบบประเมินไปเสนออาจารย์ที่ปรึกษาและอาจารย์ที่ปรึกษาร่วม 
4.6 ด าเนินการปรับปรุงแก้ไขแบบประเมิน ตามข้อเสนอแนะของอาจารย์ที่ปรึกษา

และอาจารย์ที่ปรึกษาร่วม 
4.7 น าแบบประเมินที่แก้ไขแล้ว ดังที่แสดงในภาคผนวก ข.4 และ ข.5 ไปให้

ผู้ทรงคุณวุฒิท าการประเมิน 
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ภาพที่ 3.4 ขั้นตอนการสร้างแบบประเมินคุณภาพของบทเรียนออนไลน์ 
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5 การสร้างแบบวัดผลสัมฤทธิ์ด้านพุทธิพิสัย 
แบบวัดผลสัมฤทธิ์ทางการเรียนด้านความรู้ เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ซึ่ง

ผู้วิจัยได้ด าเนินการดังนี้ 
5.1 ศึกษาและรวบรวมข้อมูลเกี่ยวกับการออกแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน

ด้านความรู้ 
5.2 วิเคราะห์เนื้อหาสาระหรือผลการเรียนรู้ที่ต้องการวัด 
5.3 สร้างแผนผังข้อสอบ (Test Blueprint) จากผลการเรียนรู้ โดยแบ่งตามแนวคิดใน

การวัดผลสัมฤทธิ์ทางการเรียนด้านความรู้ด้านพุทธิพิสัยของ Bloom ที่ได้รับการปรับใหม่ตัวทฤษฎี
โดย Anderson & Krathwohl (2001: 213-217) ที่ได้ใช้ถึงระดับที่ 3 เท่านั้น ได้แก่ จ า เข้าใจ และ
น าไปใช้ มาใช้ในการแบ่งจ านวนข้อสอบ 

5.4 สร้างแบบทดสอบปรนัย 4 ตัวเลือก ที่ครอบคลุมพุทธิพิสัยทั้ง 3 ด้าน โดยมีเกณฑ์
คะแนน คือ ตอบถูกได้ 1 คะแนน ถ้าตอบผิด ไม่ได้ตอบ หรือตอบมากกว่า 1 ตัวเลือก ถือว่าผิด ได้ 0 
คะแนน ซึ่งได้มีการสร้างข้อสอบไว้เป็นจ านวนทั้งหมด 70 ข้อ 

5.5 น าแบบทดสอบที่ได้ ไปเสนออาจารย์ที่ปรึกษาและอาจารย์ที่ปรึกษาร่วม เพ่ือท า
การปรับปรุงตามค าแนะน า 

5.6 หาความเที่ยงตรงของเนื้อหา (Content Validity) โดยให้ผู้ทรงคุณวุฒิทั้ง 3 ท่าน 
ดังรายนามต่อไปนี้ 

ผู้ช่วยศาสตราจารย์ ดร. กฤษณา คิดดี 
ภาควิชาครุศาสตร์อุตสาหกรรม 
คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี 
สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 

ผู้ช่วยศาสตราจารย์ ดร. ธนินทร์ รัตนโอฬาร 
ภาควิชาครุศาสตร์อุตสาหกรรม 
คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี 
สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 

นายสราวุธ วงษ์จ ู
ครูวิชาคอมพิวเตอร์ 
กลุ่มสาระการงานอาชีพและเทคโนโลยี 
โรงเรียนศรัทธาสมุทร จังหวัดสมุทรสงคราม 

ท าการตรวจสอบใช้สูตรและเกณฑ์การให้คะแนน ดังต่อไปนี้ 
+1 เมื่อ ข้อค าถามสามารถวัดได้ตรง 
 0 เมื่อ เมื่อไม่แน่ใจว่าข้อค าถามสามารถวัดได้ 
-1 เมื่อ ข้อค าถามไม่สามารถวัดได ้
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5.7 น าผลที่ได้จากผู้ทรงคุณวุฒิ ไปค านวณด้วยสูตรการค้นหาดัชนีความสอดคล้อง 
(Index of Consistency: IOC) (พรรณี ลีกิจวัฒนะ. 2559: 195) เพ่ือคัดเลือกน าข้อสอบไปใช้ 

 

IOC = 
∑R

n
 

 
เมื่อ IOC แทน ดัชนีความสอดคล้อง 
 R แทน คะแนนรายข้อตามดุลพินิจของผู้เชี่ยวชาญ 
 ∑ แทน ผลรวมของคะแนนรายข้อตามดุลพินิจของผู้เชี่ยวชาญ 
 n แทน จ านวนผู้เชี่ยวชาญ 

ข้อค าถามท่ีเลือกใช้ ควรมีค่าดัชนีความสอดคล้องตั้งแต่ 0.50 ขึ้นไป เมื่อรวมกัน 3 ท่าน 
ควรได้ 0.67 - 1.00 จึงจะผ่านเกณฑ์ หากจ าเป็นที่จะต้องใช้ข้อค าถามที่ไม่ผ่าน ถ้าท าการปรับปรุง
ค าถามข้อนั้น น ากลับมาประเมินใหม่ แล้วผ่านเกณฑ์ก็สามารถน ากลับมาใช้ได้ จากข้อสอบทั้งหมด 
70 ข้อ มีข้อสอบที่ได้ค่าความสอดคล้องที่ 0.67 - 1.00 หรือผ่านเกณฑ์ ทั้งสิ้น 62 ข้อ ดังแสดงใน
ภาคผนวก ค.5 

5.8 น าแบบทดสอบที่ได้ไปใช้กับนักเรียนกลุ่มตัวอย่าง 
5.9 น าผลจากการทดสอบที่ได้ มาวิเคราะห์หาค่าความยากง่ายและค่าอ านาจจ าแนก 

และค่าความเชื่อถือได้ ดังต่อไปนี้ 
5.9.1 สูตรการค้นหาค่าความยากง่ ายของข้อค าถามรายข้อ ในข้อสอบ 

(Difficulty) (พรรณี ลีกิจวัฒนะ. 2559: 205-207) ดังนี้ 
 

p = 
RH+RL

n
 

 
เมื่อ  p แทน ค่าความยากง่ายของข้อค าถามรายข้อ 
 RH แทน จ านวนผู้ตอบถูกของข้อนั้นในกลุ่มสูง 
 RL แทน จ านวนผู้ตอบถูกของข้อนั้นในกลุ่มต่ า 
 n แทน จ านวนผู้เข้าสอบแต่ละกลุ่ม (มีจ านวนเท่ากัน) 

ส าหรับข้อสอบที่ใช้ได้ ควรมีค่าความยากง่ายอยู่ระหว่าง 0.20 - 0.80 โดยมีเกณฑ์
ในการพิจารณาเลือกข้อสอบ ดังต่อไปนี้ 

0.81 - 1.00 คือ ข้อสอบที่ง่ายมาก 
0.61 - 0.80 คือ ข้อสอบที่ง่าย 
0.40 - 0.60 คือ ข้อสอบที่ปานกลาง 
0.20 - 0.39 คือ ข้อสอบที่ยาก 
0.00 - 0.19 คือ ข้อสอบที่ยากมาก 
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5.9.2 สูตรการค้นหาค่าอ านาจจ าแนกของข้อค าถามรายข้อในข้อสอบ 
(Discrimination) (พรรณี ลีกิจวัฒนะ. 2559: 209-210) ดังนี้ 

 

r =
RH-RL

n
 

 

เมื่อ r แทน ค่าอ านาจจ าแนก 
 RH แทน จ านวนผู้ตอบถูกของข้อนั้นในกลุ่มสูง 
 RL แทน จ านวนผู้ตอบถูกของข้อนั้นในกลุ่มต่ า 
 n แทน จ านวนผู้เข้าสอบแต่ละกลุ่ม (มีจ านวนเท่ากัน) 

ส าหรับข้อสอบที่ใช้ได้ ควรมีค่าอ านาจจ าแนกอยู่ตั้งแต่ 0.20 ขึ้นไป โดยมีเกณฑ์ใน
การพิจารณาเลือกข้อสอบ ดังต่อไปนี้ 

0.40 - 1.00 คือ ข้อสอบมีอ านาจจ าแนกได้สูงมาก 
0.30 - 0.39 คือ ข้อสอบมีอ านาจจ าแนกได้สูง 
0.20 - 0.29 คือ ข้อสอบมีอ านาจจ าแนกได้ปานกลาง 
0.10 - 0.19 คือ ข้อสอบมีอ านาจจ าแนกได้ต่ า 
0.01 - 0.09 คือ ข้อสอบมีอ านาจจ าแนกได้ต่ ามาก 
0.00 คือ ข้อสอบไม่มีอ านาจจ าแนก 
-1.00 - -0.01 คือ ข้อสอบมีอ านาจจ าแนกผกผัน 

5.10 เลือกข้อสอบที่มีค่าความยากง่ายอยู่ระหว่าง 0.20 - 0.80 และค่าอ านาจจ าแนก
ที่มีค่าตั้งแต่ 0.20 ขึ้นไป โดยให้สอดคล้องกับแผนผังข้อสอบ โดยคัดเลือกข้อสอบที่ใช้ได้จ านวน 40 
ข้อ ดังแสดงในภาคผนวก ค.7 

5.11 หาค่าความเชื่อถือได้ของแบบทดสอบทั้งฉบับ โดยใช้สูตรการค้นหาค่าความ
เชื่อถือได้ วัดผลสัมฤทธิ์โดยใช้สูตร KR-20 ของ Kuder-Richardson (พรรณี ลีกิจวัฒนะ. 2559: 199-
202) ดังนี้ 

 

rtt = 
k

(k-1)
{1-

∑pq

S2 } 

 

เมื่อ rtt แทน ค่าความเชื่อถือได้ของเครื่องมือวัด 
 k แทน จ านวนข้อของเครื่องมือวัด 
 ∑ แทน ผลรวมของสัดส่วนผู้ตอบถูกคูณกับสัดส่วนผู้ตอบผิด 
 p แทน สัดส่วนของผู้ตอบถูกในแต่ละข้อ 
 q  แทน สัดส่วนของผู้ตอบผิดในแต่ละข้อ 
 S2  แทน ความแปรปรวนของคะแนนทั้งฉบับ 
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ส าหรับแบบทดสอบที่ใช้ได้ ควรมีค่าอ านาจจ าแนกอยู่ระหว่าง 0.70 ขึ้นไป โดยมีเกณฑ์
ในการพิจารณาเลือกข้อสอบ ดังต่อไปนี้ 

0.80 - 1.00 คือ ความน่าเชื่อถือสูงมาก 
0.70 - 0.79 คือ ความน่าเชื่อถือสูง 
0.50 - 0.69 คือ ความน่าเชื่อถือปานกลาง 
0.30 - 0.49 คือ ความน่าเชื่อถือต่ า 
< 0.30 คือ ความน่าเชื่อถือต่ ามาก 

โดยผลการหาความเชื่อมั่นของแบบวัดผลสัมฤทธิ์ด้านพุทธิพิสัย เรื่องการสร้างเว็บไซต์
ด้วยภา HTML5 มีค่าเท่ากับ 0.879 

5.12 น าแบบทดสอบไปใช้งาน ดังทีแ่สดงในภาคผนวก ข.6 
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ภาพที่ 3.5 ขั้นตอนการสร้างแบบผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัย  
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6 การสร้างแบบวัดผลสัมฤทธิ์ด้านทักษะพิสัย 
แบบวัดผลสัมฤทธิ์ทางการเรียนด้านทักษะ เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ซึ่ง

ผู้วิจัยได้ด าเนินการดังนี้ 
6.1 ศึกษาและรวบรวมข้อมูลเกี่ยวกับการออกแบบทดสอบวัดผลสัมฤทธิ์ทางการเรียน

ด้านทักษะ 
6.2 วิเคราะห์เนื้อหาสาระหรือผลการเรียนรู้ที่ต้องการวัด 
6.3 สร้างแบบวัดผลการเรียนรู้ด้านทักษะ ให้สอดคล้องกับผลการเรียนรู้ด้านทักษะ

พิสัยตามแนวคิดของกมลวรรณ ตั้งธนกานนต์ (2559: 4-39) แต่ได้ใช้ถึงระดับที่ 4 การเตรียมความ
พร้อมและการเลียนแบบ การฝึกปฏิบัติ และการปฏิบัติด้วยความช านาญ โดยใช้เกณฑ์การประเมิน
แบบรูบริก มีลักษณะเป็นใบงานให้ท าชิ้นงานใหญ่ 1 เว็บไซต์ ดังแสดงในภาคผนวก ข.7 

6.4 น าแบบวัดผลการเรียนรู้ด้านทักษะที่ได้ ไปเสนออาจารย์ที่ปรึกษาและอาจารย์ที่
ปรึกษาร่วม เพ่ือท าการปรับปรุงตามค าแนะน า 

6.5 น าแบบวัดผลการเรียนรู้ด้านทักษะที่ได้ ไปเสนอผู้ทรงคุณวุฒิทั้ง 3 ท่าน ให้ท าการ
ตรวจสอบ ดังรายนามต่อไปนี้ 

รองศาสตราจารย์ ดร. ไพฑูรย์ พิมดี 
ภาควิชาครุศาสตร์อุตสาหกรรม 
คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี 
สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 

รองศาสตราจารย์ ดร. บุญจันทร์ สีสันต์ 
ภาควิชาครุศาสตร์อุตสาหกรรม 
คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี 
สถาบันเทคโนโลยีพระจอมเกล้าเจ้าคุณทหารลาดกระบัง 

นายสราวุธ วงษ์จ ู
ครูวิชาคอมพิวเตอร์ 
กลุ่มสาระการงานอาชีพและเทคโนโลยี 
โรงเรียนศรัทธาสมุทร จังหวัดสมุทรสงคราม 

6.6 น าแบบวัดผลการเรียนรู้ด้านทักษะที่ได้รับการตรวจสอบจากผู้ทรงคุณวุฒแิล้ว มา
ท าการปรับปรุงแก้ไข  

6.7 น าแบบวัดผลการเรียนรู้ด้านทักษะ เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 ไป
ทดลองใช้กับนักเรียนชั้นมัธยมศึกษาปีที่ 6 โรงเรียนศรัทธาสมุทร ปีการศึกษา 2560 ซึ่งผ่านการเรียน
วิชาการสร้างเว็บไซต์ จ านวน 3 คน 

6.8 หาผู้ประเมิน 2 คน มาให้คะแนนจากผลงานของนักเรียนแต่ละคน โดยใช้แบบวัด
เดียวกันในการให้คะแนน 

6.9 น าคะแนนทั้ง 2 ชุด มาหาความสัมพันธ์ระหว่างผู้ประเมิน 2 คน โดยใช้สูตรหา
ดัชนีความสอดคล้องระหว่างผู้ประเมิน (Rater Agreement Index : RAI) (สุรชัย มีชาญ. 2547 : 
113-126)  
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RAI = 1 - 
∑ ∑ |R1nk - R2nk|N

n=1
K
k=1

KN(I - 1)
 

 
RAI แทน ดัชนีความสอดคล้องระหว่างผู้ประเมิน 
R1nk แทน คะแนนที่ได้จากผู้ประเมินคนที่ 1 ของนักเรียนคนที่ n เกณฑ์ที่ k 

( n = 1, 2, 3, ..., N และ k = 1, 2, 3, ..., K ) 
R2nk แทน คะแนนที่ได้จากผู้ประเมินคนที่ 2 ของนักเรียนคนที่ n เกณฑ์ที่ k 

( n = 1, 2, 3, ..., N และ k = 1, 2, 3, ..., K ) 
N แทน จ านวนของนักเรียนทั้งหมด 
K แทน จ านวนของเกณฑ์การประเมินทั้งหมด 
I แทน จ านวนของคะแนนทั้งหมดที่เป็นไปได ้

โดยค่าดัชนีความสอดคล้องระหว่างผู้ประเมิน (RAI) ควรมีค่าตั้งแต่ 0.5 ขึ้นไป จึงจะถือว่า
ผ่านเกณฑ์ ซึ่งผลการหาดัชนีความสอดคล้องระหว่างผู้ประเมินของแบบวัดผลสัมฤทธิ์ด้านทักษะพิสัย 
เรื่องการสร้างเว็บไซต์ด้วยภา HTML5 มีค่าเท่ากับ 0.73 ซึ่งถือว่ามีความสอดคล้องสูง 
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ภาพที่ 3.6 ขั้นตอนการสร้างแบบวัดผลสัมฤทธิ์ทางการเรียนด้านทักษะพิสัย  
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3.3 การเก็บรวบรวมข้อมูล 
 

3.3.1 รูปแบบการทดลอง 
ผลสัมฤทธิ์ทางการเรียนด้านความรู้และทักษะของนักเรียนด้วยการจัดการเรียนโดยใช้การ

ออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์ วัดตามแบบการทดลองแท้ แบบมีกลุ่มทดลองและกลุ่ม
ควบคุมท่ีได้จากการสุ่ม มีการวัดเฉพาะหลังให้สิ่งทดลอง (Randomized Control Group Posttest-
Only Design) (พรรณี ลีกิจวัฒนะ. 2559: 299-300) ดังแผนภาพในตารางที่ 3.1 

 
ตารางท่ี 3.1 แผนภาพการทดลองแท้ แบบมีกลุ่มทดลองและกลุ่มควบคุมที่ได้จากการสุ่ม มีการวัด

เฉพาะหลังให้สิ่งทดลอง ใช้วัดผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัย และทักษะพิสัย 

แผนภาพการทดลอง 
กลุ่ม วัดก่อน สิ่งทดลอง วัดหลัง 
E - X1 T1T2 
C - X2 T3T4 

 
ความหมายของสัญลักษณ์ที่ใช้ในแผนภาพการทดลอง 

 E แทน  นักเรยีนกลุ่มทดลอง 
 C แทน นักเรียนกลุ่มควบคุม 
 X1 แทน  การจัดการเรียนการสอนโดยใช้การออกแบบเป็นฐาน 
 X2 แทน การจัดการเรียนการสอนแบบปกติ 
 T1 แทน ผลการวัดด้านความรู้ หลังเรียนของนักเรียนกลุ่มทดลอง 
 T2 แทน ผลการวัดด้านทักษะ หลังเรียนของนักเรียนกลุ่มทดลอง 
 T3 แทน ผลการวัดด้านความรู้ หลังเรียนของนักเรียนกลุ่มควบคุม 
 T4 แทน ผลการวัดด้านทักษะ หลังเรียนของนักเรียนกลุ่มควบคุม 

 

3.3.2 ขั้นตอนการรวบรวมข้อมูล 
การด าเนินการทดลองและการเก็บรวบรวมข้อมูล ผู้วิจัยได้น าการจัดการเรียนรู้โดยใช้การ

ออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ตามขั้นตอน
ต่อไปนี้ 

1. ติดต่องานบัณฑิตศึกษา คณะครุศาสตร์อุตสาหกรรมและเทคโนโลยี สถาบันเทคโนโลยี 
พระจอมเกล้าเจ้าคุณทหารลาดกระบัง เพ่ือขอหนังสืออนุญาต 

2. น าหนังสือไปให้ผู้อ านวยการโรงเรียนศรัทธาสมุทร 
3. แจ้งนักเรียนกลุ่มทดลองให้ทราบถึงการทดลอง 
4. อธิบายวิธีการทดลองให้นักเรียนกลุ่มทดลองทราบ 
5. ให้นักเรียนกลุ่มทดลองเรียนด้วยแผนการจัดการเรียนรู้ที่พัฒนาขึ้นร่วมกับบทเรียน

ออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 และให้นักเรียนกลุ่มควบคุมให้เรียนด้วย
แผนการจัดการเรียนรู้แบบปกติ 

6. นักเรียนกลุ่มทดลองและกลุ่มควบคุมท าแบบทดสอบหลังเรียน 
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7. ผู้วิจัยน าข้อมูลที่ได้ไปวิเคราะห์หาผลสัมฤทธิ์ทางการเรียนเฉลี่ยของนักเรียนต่อไป 
 

3.3.3 การเอาการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานมาประยุกต์ใช้ 
เนื่องจากการสอนสร้างเว็บไซต์โดยให้ใช้ Source Code อย่างเดียว ยังยากเกินไปส าหรับ

นักเรียน จึงได้น าโปรแกรมประเภท Web Editor เข้ามาเพ่ือให้เข้าใจการสร้างเว็บไซต์ได้ง่ายขึ้น โดย
ให้นักเรียนทดลองเขียนเว็บไซต์โดยใช้โปรแกรม นอกจากการสอนวิธีใช้โปรแกรมเบื้องต้นแล้วก็ได้
สอนวิธีในการสร้างเว็บไซต์ไปพร้อมกับอธิบายความหมาย Source Code เพ่ือให้นักเรียนได้เข้าใจ
และสามารถน าไปใช้สร้างเว็บไซต์ตามแบบฝึกหัดและค าสั่งได้ โดยสามารถน าเอาแนวคิดกระบวนการ
คิดย้อนกลับ 6 ขั้นตอนครึ่ง มาประยุกต์ใช้ ดังต่อไปนี้ 

ขั้นที่ 1 สิ่งที่จะสอน - วิธีสร้างเว็บไซต์ด้วย Source Code และโปรแกรม Web Editor 
ขั้นที่ 2 ระบุปัญหา - การสร้างเว็บไซต์ด้วย Source Code เป็นสิ่งที่นักเรียนไม่ค่อยเข้าใจ 
ขั้นที่ครึ่ง ความท้าทายที่ไม่เคยเห็นมาก่อน 

ในขณะนั้นของนักเรียนชั้นมัธยมศึกษาปีที่ 6 เป็นสถานการณ์ที่ให้ สมัครเข้า
มหาวิทยาลัยระบบ TCAS รอบแรก โดยเป็นการสัมภาษณ์ 

นักเรียนสามารถน าเสนอตัวเองในการสัมภาษณ์ โดยการสร้างหน้าเว็บไวต์ที่เป็น
การแสดงข้อมูลของนักเรียน เพ่ือน าไปใช้ในการประกอบการน าเสนอตอนสอบสัมภาษณ์ อาจจะเริ่ม
โดยการออกแบบหน้าเว็บไซต์ให้คล้ายกับรูปแบบ Portfolio ก่อน 

ขั้นที่ 3 ตั้งเกณฑ์การประเมิน 
 
ตารางท่ี 3.2 เกณฑ์การประเมินของวิชา การสร้างเว็บไวต์ด้วยภาษา HTML5 

ไม่ต้องการ จ าเป็น 
- ภาษา CSS - ไฟล์ภาษา HTML รวมทั้งไฟล์ที่เกี่ยวข้อง 
- ภาษา Javascript - การออกแบบและตกแต่งหน้าเว็บไซต์  
- งานที่ใหญ่เกินไปจนท าเสร็จในคาบเรียนไม่ได้ - การใส่รูปภาพที่เกี่ยวข้องกับเนื้อหา 
- การเชื่อมต่อตัว Server - การเชื่อมโยงไปแหล่งข้อมูลต่างๆที่เกี่ยวข้อง 
 - การใช้ตารางในหน้าเว็บไซต์ 

 
ขั้นที่ 4 ให้ลองท าก่อน - ให้ลองใช้งานโปรแกรม Web Editor สร้างเว็บไซต์ 
ขัน้ที่ 5 สอนตามบทเรียน - น าบทเรียนออนไลน์มาให้นักเรียนท าความเข้าใจในการสร้าง

เว็บไซต์ด้วย Source Code โดยการใช้งานโปรแกรม Web Editor 
ขั้นที่ 6 ให้กลับมาปรับงาน - ให้นักเรียนลองใช้งานโปรแกรม Web Editor ปรับปรุง

เว็บไซต์ที่สร้างไว้ก่อนหน้า แล้วลองให้ท าตามข้อก าหนดในแบบฝึกหัด 
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3.4 การวิเคราะห์ข้อมูล 
 

การวิจัยครั้งนี้ ผู้วิจัยได้ด าเนินการวิเคราะห์ข้อมูลด้วยโปรแกรมสถิติส าเร็จรูป เพ่ือวิเคราะห์
ข้อมูลตามวัตถุประสงค์และสมมุติฐานของการวิจัย ดังนี้ 

 

3.4.1 การวิเคราะห์หาคุณภาพของแผนการจัดการเรียนรู้ที่พัฒนาขึ้น หาคุณภาพจาก
คะแนนที่ได้จากแบบประเมินคุณภาพแผนการจัดการเรียนรู้โดยผู้ทรงคุณวุฒิ ซ่ึงใช้สูตรหาค่าเฉลี่ยและ
ส่วนเบี่ยงเบนมาตรฐาน ดังนี้ 

1. การหาค่าเฉลี่ย (พรรณี ลีกิจวัฒนะ. 2559: 245) 
 

x ̅=
∑X

n
 

 

เมื่อ x ̅ หมายถึง คะแนนเฉลี่ย 
 ∑X หมายถึง ผลรวมของคะแนนในชุดข้อมูล 
 n หมายถึง จ านวนข้อมูลทั้งหมด 

2. การหาส่วนเบี่ยงเบนมาตรฐาน (พรรณี ลีกิจวัฒนะ. 2559: 248) 
 

S =√
∑(X-X̅)2

n-1
 

 
เมื่อ S หมายถึง ส่วนเบี่ยงเบนมาตรฐาน 
 X หมายถึง คะแนนในแต่ละชุดข้อมูล 
 X̅ หมายถึง ค่าเฉลี่ยของคะแนน 
 n หมายถึง จ านวนข้อมูลทั้งหมด 

เกณฑ์การแปลความหมายของค่าเฉลี่ยคุณภาพของบทเรียนออนไลน์  
(พรรณี ลีกิจวัฒนะ. 2559: 179) ดังต่อไปนี้  

4.50 - 5.00 คือ ดีมาก 
3.50 - 4.49 คือ ดี 
2.50 - 3.49 คือ ปานกลาง 
1.50 - 2.49 คือ พอใช้ 
1.00 - 1.49 คือ ควรปรับปรุง 

ในการประเมินนั้นจะต้องได้เกณฑ์ค่าเฉลี่ย (x̅) ตั้งแต่ 3.50 ขึ้นไป จึงจะถือว่าผ่านเกณฑ์ 
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3.4.2 การวิเคราะห์หาคุณภาพของบทเรียนออนไลน์ หาคุณภาพจากคะแนนที่ได้จาก

แบบประเมินคุณภาพบทเรียนออนไลน์ทั้งด้านเนื้อหาและเทคนิคการผลิตสื่อโดยผู้ทรงคุณวุฒิ ซึ่งใช้
สูตรหาค่าเฉลี่ยและส่วนเบี่ยงเบนมาตรฐาน ดังนี้ 

1. การหาค่าเฉลี่ย (พรรณี ลีกิจวัฒนะ. 2559: 245) 
 

x ̅=
∑X

n
 

 

เมื่อ x ̅ หมายถึง คะแนนเฉลี่ย 
 ∑X หมายถึง ผลรวมของคะแนนในชุดข้อมูล 
 n หมายถึง จ านวนข้อมูลทั้งหมด 

2. การหาส่วนเบี่ยงเบนมาตรฐาน (พรรณี ลีกิจวัฒนะ. 2559: 248) 
 

S =√
∑(X-X̅)2

n-1
 

 
เมื่อ S หมายถึง ส่วนเบี่ยงเบนมาตรฐาน 
 X หมายถึง คะแนนในแต่ละชุดข้อมูล 
 X̅ หมายถึง ค่าเฉลี่ยของคะแนน 
 n หมายถึง จ านวนข้อมูลทั้งหมด 

เกณฑ์การแปลความหมายของค่าเฉลี่ยคุณภาพของบทเรียนออนไลน์  
(พรรณี ลีกิจวัฒนะ. 2559: 179) ดังต่อไปนี้  

4.50 - 5.00 คือ ดีมาก 
3.50 - 4.49 คือ ดี 
2.50 - 3.49 คือ ปานกลาง 
1.50 - 2.49 คือ พอใช้ 
1.00 - 1.49 คือ ควรปรับปรุง 

ในการประเมินนั้นจะต้องได้เกณฑ์ค่าเฉลี่ย (x̅) ตั้งแต่ 3.50 ขึ้นไป จึงจะถือว่าผ่านเกณฑ์ 
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3.4.3 การค านวณหาประสิทธิภาพของบทเรียนออนไลน์ หาประสิทธิภาพบทเรียน

ออนไลน์ จากคะแนนแบบฝึกหัดระหว่างเรียนและคะแนนแบบทดสอบหลังเรียน ตามเกณฑ์ที่ตั้งไว้ 
80/80 โดยใช้สูตร E1/E2 ( ชัยยงค์ พรหมวงศ์และคณะ. 2550 : 138 ) ดังนี้ 

 

E1 =
∑x1

NA
×100  E2 =

∑x2

NB
×100  

 
เมื่อ  E1  หมายถึง ประสิทธิภาพของกระบวนการ  

E2  หมายถึง ประสิทธิภาพของผลลัพธ์  
∑x1 หมายถึง คะแนนรวมของแบบฝึกหัดหรือกิจกรรมในบทเรียน 
∑x2 หมายถึง คะแนนรวมของแบบทดสอบหลังเรียน 
A  หมายถึง คะแนนเต็มของแบบฝึกหัดหรือกิจกรรมในบทเรียน  
B  หมายถึง คะแนนเต็มของแบบทดสอบหลังเรียน  
N  หมายถึง จ านวนนักเรียนทั้งหมด 

 

3.4.4 การเปรียบเทียบผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัยและทักษะพิสัย หา
ค่าเฉลี่ยและส่วนเบี่ยงเบนมาตรฐานของคะแนนที่ได้จากแบบทดสอบวัดผลการเรียน หลังจากนั้นจึง
วิเคราะห์หาความแตกต่างระหว่างคะแนนระหว่างด้านพุทธิพิสัยและด้านทักษะพิสัย โดยใช้สูตร ดังนี้ 

1. การหาค่าเฉลี่ย (พรรณี ลีกิจวัฒนะ. 2559: 245) 
 

x ̅=
∑X

n
 

 

เมื่อ x ̅ หมายถึง คะแนนเฉลี่ย 
 ∑X หมายถึง ผลรวมของคะแนนในชุดข้อมูล 
 n หมายถึง จ านวนข้อมูลทั้งหมด 

2. การหาส่วนเบี่ยงเบนมาตรฐาน (พรรณี ลีกิจวัฒนะ. 2559: 248) 
 

S =√
∑(X-X̅)2

n-1
 

 
เมื่อ S หมายถึง ส่วนเบี่ยงเบนมาตรฐาน 
 X หมายถึง คะแนนในแต่ละชุดข้อมูล 
 X̅ หมายถึง ค่าเฉลี่ยของคะแนน 
 n หมายถึง จ านวนข้อมูลทั้งหมด  
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สถิติการวิเคราะห์ความแปรปรวนพหุคูณ (MANOVA) โดยใช้สูตรของ Wilk’s Lambda 

( ฉัตรศิริ ปิยะพิมลสิทธิ์. 2548: 12 - 17 ) ดังนี้ 
 

∧ = ∏
1

1+λi

S

i=1

 

 
 

เมื่อ  ∏  หมายถึง ผลคูณแลมด้าของ Wilk’s จะแสดงอัตาส่วนของความ
แปรปรวนคลาดเคลื่อนกับความแปรปรวนรวมส าหรับ
แต่ละตัวแปร  

S  หมายถึง ความแปรปรวน 
 



 

 
 

บทท่ี 4 
ผลการวิเคราะห์ข้อมูล 

 
 ในงานวิจัย เรื่อง ผลการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์ที่
มีต่อผลสัมฤทธิ์ทางการเรียน เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ของชั้นมัธยมศึกษาปีที่ 6 
ผู้วิจัยไดด้ าเนินการเก็บรวบรวมข้อมูล แล้วน ามาหาผลการวิเคราะห์ข้อมูล ไดด้ังนี้ 
 
4.1 ผลการพัฒนาแผนการจัดการเรียนรู้ 

 
ผู้วิจัยได้พัฒนาแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน เรื่อง การสร้างเว็บไซต์

ด้วยภาษา HTML5 ของชั้นมัธยมศึกษาปีที่ 6 จ านวน 1 แผน ซึ่งแทนหน่วยการเรียนรู้ 1 หน่วยที่ใช้ใน
การเรียนการสอนวิชา การสร้างเว็บไซต์ โดยจะแบ่งเนื้อหาออกเป็น 6 หัวข้อ ได้แก่ 

1. การเริ่มต้นใช้งานโปรแกรมประเภท Web Editor 
2. การเริ่มต้นสร้างไฟล์เว็บด้วยภาษา HTML5 
3. การสร้างและปรับแต่งรูปแบบหน้าเว็บ 
4. การใส่ภาพเพ่ิมเติมไปในหน้าเว็บ 
5. การสร้างลิงค์เชื่อมโยงในรูปแบบต่างๆ บนหน้าเว็บ 
6. การสร้างตารางและการจัดรูปแบบหน้าเว็บ 
โดยมีระยะเวลาในการใช้แผนทั้งหมด 5 สัปดาห์ ( 10 คาบ ) ซึ่งผลการวิเคราะห์หาคุณภาพ

ของแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ที่
ได้จากประเมินของผู้ทรงคุณวุฒิ โดยใช้แบบประเมินตามแนวคิดของ สุวิทย์ มูลค า และคณะ (2551: 
58-64) แสดงผลดังตารางที่ 4.1 
 

ตารางท่ี 4.1 ผลวิเคราะห์หาคุณภาพแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน เรื่อง การ
สร้างเว็บไซต์ด้วยภาษา HTML5 ของชั้นมัธยมศึกษาปีที่ 6 

รายการประเมิน x ̅ S ระดับคุณภาพ 
1. ด้านจุดประสงค์การจัดการเรียนรู้ 4.50 0.55 ดีมาก 
1.1) ความถูกต้องของจุดประสงค์กับเนื้อหา 4.67 0.58 ดีมาก 
1.2) ความสอดคล้องของจุดประสงค์กับเนื้อหา 4.33 0.58 ดี 
2. ด้านเนื้อหาสาระ 4.56 0.53 ดีมาก 
2.1) ความถูกต้องของเนื้อหา 4.67 0.58 ดีมาก 
2.2) ความครบถ้วนสมบูรณ์ของเนื้อหา 4.67 0.58 ดีมาก 
2.3) ความชัดเจนของเนื้อหา 4.33 0.58 ดี 
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ตารางท่ี 4.1 (ต่อ) 

รายการประเมิน x ̅ S ระดับคุณภาพ 
3. ด้านกิจกรรมการเรียนรู้ 4.33 0.82 ดี 
3.1) ความน่าสนใจของกิจกรรมการเรียนรู้ 
3.2) ความเหมาะสมของกิจกรรมการเรียนรู้ตามจุดประสงค์ 

4.00 
4.67 

1.00 
0.58 

ดี 
ดีมาก 

4. ด้านสื่อการเรียนรู้ 4.67 0.58 ดีมาก 
4.1) ความความเหมาะสมของสื่อการเรียนรู้ 4.67 0.58 ดีมาก 
5. ด้านการวัดและประเมินผล 4.33 0.82 ด ี
5.1) ความถูกต้องของการวัดและประเมินผล 4.00 1.00 ดี 
5.2) ความเหมาะสมของการวัดและประเมินผล 4.67 0.58 ดีมาก 
6. ด้านองค์ประกอบของแผนการจัดการเรียนรู้ 4.33 0.82 ด ี
6.1) ความครบถ้วนขององค์ประกอบแผนการจัดการเรียนรู้ 4.67 0.58 ดีมาก 
6.2) ความสอดคล้องสัมพันธ์กันขององค์ประกอบแผนการ

จัดการเรียนรู้ 
4.00 1.00 ดี 

โดยรวม 4.44 0.65 ด ี
 

จากตารางที่ 4.1 พบว่า แผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน เรื่อง การสร้าง
เว็บไซต์ด้วยภาษา HTML 5 ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 6 มีคุณภาพโดยรวมอยู่ในระดับดี  
( x ̅ = 4.44, S = 0.65 ) เมื่อพิจารณาเป็นรายด้าน พบว่า 4) ด้านสื่อการเรียนรู้ เป็นด้านที่มีค่าเฉลี่ย
สูงสุดซึ่งอยู่ในระดับดีมาก ( x ̅ = 4.67, S = 0.58 ) ส่วน 3) ด้านกิจกรรมการเรียนรู้ 5) ด้านการวัด
และประเมินผล และ 6) ด้านองค์ประกอบของแผนการจัดการเรียนรู้ เป็นด้านที่มีค่าเฉลี่ยต่ าสุดซึ่งอยู่
ในระดับดี ( x ̅ = 4.33, S = 0.82 ) 
 
4.2 ผลการพัฒนาบทเรียนออนไลน์ 

 
ผู้วิจัยได้พัฒนาบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ของชั้น

มัธยมศึกษาปีที่ 6 ซึ่งใช้ควบคู่กับแผนการจัดการเรียนรู้ที่พัฒนาขึ้นในหน่วยการเรียนรู้ 1 หน่วย 
ส าหรับวิชาการสร้างเว็บไซต์ มีการทดสอบวัดผลการพัฒนาบทเรียนออนไลน์จะแบ่งออกเป็น 2 ส่วน 
คือ การทดสอบหาคุณภาพกับประสิทธิภาพ โดยจะแบ่งเนื้อหาออกเป็น 6 ส่วน ได้แก่ 

1. การเริ่มต้นใช้งานโปรแกรมประเภท Web Editor 
2. การเริ่มต้นสร้างไฟล์เว็บด้วยภาษา HTML5 
3. การสร้างและปรับแต่งรูปแบบหน้าเว็บ 
4. การใส่ภาพเพ่ิมเติมไปในหน้าเว็บ 
5. การสร้างลิงค์เชื่อมโยงในรูปแบบต่างๆ บนหน้าเว็บ 
6. การสร้างตารางและการจัดรูปแบบหน้าเว็บ 
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4.2.1 ผลการวิเคราะห์หาคุณภาพของบทเรียนออนไลน์ 
การหาคุณภาพของบทเรียนออนไลน์ตามแนวคิดของ ไพโรจน์ ตีรณธนากุล และคณะ 

(2546: 197-202) ต้องแบ่งออกเป็น 2 ด้าน คือ คุณภาพด้านเนื้อหา และคุณภาพด้านเทคนิคการผลิต
สื่อ โดยผู้เชี่ยวชาญด้านละ 3 ท่าน ซึ่งแสดงผลดังในตารางที่ 4.2 และ 4.3 ตามล าดับ 

1.  ผลการวิเคราะห์หาคุณภาพของบทเรียนออนไลน์ด้านเนือ้หา 
 
ตารางท่ี 4.2 ผลวิเคราะห์หาคุณภาพบทเรียนออนไลน์ด้านเนื้อหา เรื่อง การสร้างเว็บไซต์ด้วยภาษา 

HTML5 ของชั้นมัธยมศึกษาปีที่ 6 
รายการประเมิน x ̅ S ระดับคุณภาพ 

1. ความเหมาะสมของเนื้อหาในบทเรียน 4.67 0.58 ดีมาก 
2. ความสอดคล้องระหว่างวัตถุประสงค์กับเนื้อหาในบทเรียน 4.33 0.58 ดี 
3. ความยากง่ายของเนื้อหาในบทเรียนที่เหมาะสมกับนักเรียน 4.33 0.58 ดี 
4. ความถูกต้องของเนื้อหาในบทเรียน 4.67 0.58 ดีมาก 
5. ความชัดเจนของภาษาที่ใช้ในตัวบทเรียน 4.67 0.58 ดีมาก 
6. ความเหมาะสมของจ านวนตัวอย่างในบทเรียน 4.33 0.58 ดี 
7. ความเหมาะสมของปริมาณข้อสอบหรือแบบทดสอบในบทเรียน 4.67 0.58 ดีมาก 
8. รูปภาพสามารถสื่อความหมายท่ีเกี่ยวข้องกับเนื้อหาได้อย่างชัดเจน 4.33 0.58 ดี 
9. ความสอดคล้องของรูปภาพหรือสื่อประกอบกับเนื้อหาในบทเรียน 4.67 0.58 ดีมาก 

โดยรวม 4.52 0.51 ดีมาก 
 

จากตารางที่ 4.2 พบว่าคุณภาพด้านเนื้อหาของบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์
ด้วยภาษา HTML 5 โดยรวมอยู่ในระดับดีมาก ( x ̅ = 4.52, S = 0.51 ) เมื่อพิจารณาเป็นรายด้าน 
พบว่า มีหัวข้อในรายการประเมินท่ีมีค่าเฉลี่ยสูงสุด ได้แก่ ข้อ 1) ความเหมาะสมของเนื้อหาในบทเรียน  
ข้อ 4) ความถูกต้องของเนื้อหาในบทเรียน ข้อ 5) ความชัดเจนของภาษาที่ใช้ในตัวบทเรียน  
ข้อ 7) ความเหมาะสมของปริมาณข้อสอบหรือแบบทดสอบในบทเรียน และข้อ 9) ความสอดคล้อง
ของรูปภาพหรือสื่อประกอบกับเนื้อหาในบทเรียน โดยมีคุณภาพในแต่ละข้ออยู่ในระดับดีมาก  
( x ̅ = 4.67, S = 0.58 ) ส่วนหัวข้อในรายการประเมินที่มีค่าเฉลี่ยต่ าสุด ได้แก่ ข้อ 2) ความสอดคล้อง
ระหว่างวัตถุประสงค์กับเนื้อหาในบทเรียน ข้อ 3) ความยากง่ายของเนื้อหาในบทเรียนที่เหมาะสมกับ
นักเรียน ข้อ 6) ความจ าเป็นและความเหมาะสมของตัวอย่างในบทเรียน และข้อ 8) รูปภาพสามารถ
สื่อความหมายท่ีเกี่ยวข้องกับเนื้อหาได้อย่างชัดเจน โดยมีคุณภาพอยู่ในระดับดี ( x ̅ = 4.33, S = 0.58 ) 
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2.  ผลการวิเคราะห์หาคุณภาพของบทเรียนออนไลน์ด้านเทคนิคการผลิตสื่อ 

 
ตารางท่ี 4.3 ผลวิเคราะห์หาคุณภาพบทเรียนออนไลน์ด้านเทคนิคการผลิตสื่อ เรื่อง การสร้างเว็บไซต์

ด้วยภาษา HTML5 ของชั้นมัธยมศึกษาปีที่ 6 
รายการประเมิน x ̅ S ระดับคุณภาพ 

1. ด้านตัวอักษร 4.17 0.39 ดี 
1.1) ความเหมาะสมของขนาดตัวอักษร 4.00 0.00 ดี 
1.2) ความชัดเจนและอ่านง่ายของรูปแบบตัวอักษร 4.33 0.58 ดี 
1.3) ความเหมาะสมของสีตัวอักษรและสีของพ้ืนที่ใช้ 4.33 0.58 ดี 
1.4) ความถูกต้องของข้อความตามหลักภาษา 4.00 0.00 ดี 
2. ด้านภาพนิ่ง 4.50 0.52 ดีมาก 
2.1) ความเหมาะสมของขนาดภาพ 4.67 0.58 ดีมาก 
2.2) ความเหมาะสมของสี 4.00 0.00 ดี 
2.3) ความชัดเจนของภาพ 4.67 0.58 ดีมาก 
2.4) ความเหมาะสมของรูปภาพที่ใช้ในการสื่อความหมาย 4.67 0.58 ดีมาก 
3. ด้านเสียง  4.00 0.00 ดี 
3.1) ความเหมาะสมของน้ าเสียงที่ใช้ในการบรรยาย 4.00 0.00 ดี 
3.2) ความชัดเจนของเสียงบรรยาย 4.00 0.00 ดี 
4. ด้านปฏิสัมพันธ์  4.11 0.33 ดี 
4.1) ความง่ายและสะดวกในการควบคุมบทเรียน 4.00 0.00 ดี 
4.2) ความเหมาะสมของการเชื่อมโยงเนื้อหาภายในหน่วยการเรียน 4.00 0.00 ดี 
4.3) ความเหมาะสมของการเชื่อมโยงระหว่างบทเรียนแต่ละหน่วย 

การเรียน 
4.33 0.58 ดี 

5. ด้านแบบทดสอบ 3.83 0.41 ดี 
5.1) ความเหมาะสมของรูปแบบแบบทดสอบและแบบฝึกหัดท้ายหน่วย 3.67 0.58 ดี 
5.2) ความเหมาะสมของรูปแบบการรายงานผลการทดสอบและ

แบบฝึกหัดท้ายหน่วย 
4.00 0.00 ดี 

โดยรวม 4.18 0.44 ดี 
 

จากตารางที่ 4.3 พบว่าคุณภาพด้านเทคนิคการผลิตสื่อของบทเรียนออนไลน์ เรื่อง การ
สร้างเว็บไซต์ด้วยภาษา HTML 5 โดยรวมอยู่ในระดับดี ( x ̅ = 4.18, S = 0.44 ) เมื่อพิจารณาเป็นราย
ด้าน พบว่า มีรายการประเมินที่มีค่าเฉลี่ยสูงสุด คือ 2) ด้านภาพนิ่ง ซึ่งอยู่ในระดับดีมาก ( x ̅ = 4.50,  
S = 0.52 ) ส่วนหัวข้อในรายการประเมินที่มีค่าเฉลี่ยต่ าสุด คือ 5) ด้านแบบทดสอบ ซึ่งอยู่ในระดับดี  
( x ̅ = 3.83, S = 0.41 ) 
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จากตารางที่ 4.2 กับ 4.3 สามารถสรุปได้ว่า บทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วย
ภาษา HTML 5 มีคุณภาพโดยรวมอยู่ในระดับดี ( x ̅ = 4.31, S = 0.49 ) เมื่อพิจารณาเป็นรายด้าน 
พบว่า คุณภาพด้านเนื้อหาเป็นด้านที่มีค่าเฉลี่ยสูงสุดซึ่งอยู่ในระดับดีมาก ( x ̅ = 4.52, S = 0.51 ) 
ส่วนคุณภาพด้านเทคนิคการผลิตสื่อเป็นด้านที่มีค่าเฉลี่ยต่ าสุดซึ่งอยู่ในระดับดี ( x ̅ = 4.18, S = 
0.44 ) 
 

4.2.2 ผลการวิเคราะห์หาประสิทธิภาพของบทเรียนออนไลน์ 
การหาประสิทธิภาพของบทเรียนออนไลน์ตามแนวคิดของ ชัยยงค์ พรหมวงศ์ (2556: 7-

20) แสดงผลดังในตารางที่ 4.4  
 
ตารางท่ี 4.4 ผลวิเคราะห์หาประสิทธิภาพบทเรียนออนไลน์ด้านเทคนิคการผลิตสื่อ เรื่อง การสร้าง

เว็บไซต์ด้วยภาษา HTML5 ของชั้นมัธยมศึกษาปีที่ 6 

คะแนนช่วง 
จ านวน
นักเรียน 

คะแนนเต็ม x ̅ ร้อยละ 

ระหว่างเรียน ( E1 ) 39 20 16.05 80.26 
หลังเรียน ( E2 ) 39 20 16.31 81.54 

 
จากตารางที่ 4.4 พบว่า ประสิทธิภาพของบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วย

ภาษา HTML 5 มีค่า E1/E2 เท่ากับ 80.26/81.54 ซึ่งมากกว่าเกณฑ์ที่ก าหนดไว้ คือ 80/80 
 
4.3 ผลการเปรียบเทียบผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัยและทักษะพิสัย 

 
ผู้วิจัยได้วิเคราะห์ข้อมูลโดยใช้สถิติพ้ืนฐาน เพ่ือแสดงค่าเฉลี่ย ส่วนเบี่ยงเบนมาตรฐาน และ

ค่าสถิติความแปรปรวนพหุคูณของผลสัมฤทธิ์ทางการเรียนระหว่างด้านพุทธิพิสัยและทักษะพิสัยหลัง
เรียน จ าแนกตามกลุ่มโดยแบ่งเป็นกลุ่มทดลองและกลุ่มควบคุม เรื่อง การสร้างเว็บไซต์ด้วยภาษา 
HTML 5 ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 6 
 
ตารางที่ 4.5 ผลการวิเคราะห์ความแปรปรวนพหุคูณของคะแนนเฉลี่ยของผลสัมฤทธิ์ด้านพุทธิพิสัย

และทักษะพิสัยระหว่างกลุ่มทดลองกับกลุ่มควบคุม และการทดสอบข้อตกลงเบื้องต้น 
ตัวแปรอิสระ ชื่อสถิติ Value F Sig. 

กลุ่ม 

Pillai’s Trace .256 13.426 .000 * 
Wilks’ Lambda .744 13.426 .000 * 
Hotelling’s Trace .344 13.426 .000 * 
Roy’s Largest Root .344 13.426 .000 * 

Box’s M test : 2.416, F = .783, Sig. = .503 
Bartlett’s Test of Sphericity : 43.946, Sig. = .000 
Correlation : r = .244, Sig. = .028 

* Sig. < .05 
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จากตารางที่ 4.5 ผู้วิจัยได้ท าการทดสอบข้อตกลงเบื้องต้น ในการวิเคราะห์ความแปรปรวน
พหุคูณ การทดสอบความสัมพันธ์ของตัวแปร โดยใช้สถิติ Bartlett’s Test of Sphericity และ
ความสัมพันธ์นั้นจะต้องไม่สัมพันธ์กันจนเกิดภาวะสัมพันธ์ร่วมเชิงเส้นพหุ ( Multicollinearity ) ซึ่ง
ผลการทดสอบพบว่าตัวแปรตามมีความสัมพันธ์กันอย่างมีนัยส าคัญทางสถิติที่ระดับ .05 ( r = .244,  
Sig. = .028 ) และได้ทดสอบเมทริกซ์ความแปรปรวน - ความแปรปรวนร่วม ( Variance - 
Covariance Matrices ) ของกลุ่มตัวอย่าง โดยใช้สถิติ Box’s M test ผลการทดสอบ พบว่า เมทริกซ์
ความแปรปรวน - ความแปรปรวนร่วมของกลุ่มตัวอย่างในแต่ละกลุ่มไม่แตกต่างกันอย่างมีนัยส าคัญ
ทางสถิติท่ีระดับ .05 ( Box’s M test : 2.416, F = .783, Sig. = .503 ) ซึ่งผ่านข้อตกลงเบื้องต้น ส่วน
การพิจารณากลุ่มตัวอย่างที่มีขนาดเหมาะสมกับการวิเคราะห์ข้อมูลตามกฎแห่งความชัดเจน ( Rule 
of Thumb ) ตามข้อเสนอของ Hair et.al. (1998) ที่เสนอว่านักสถิติวิเคราะห์ตัวแปรพหุนิยมใช้
ขนาดกลุ่มตัวอย่าง 10-20 คน ต่อตัวแปรในการวิจัย 1 ตัวแปร ดังนั้นขนาดตัวอย่างที่เหมาะสมและ
เพียงพอส าหรับงานวิจัยนี้ 20 X 2 = 40 ถึง 30 X 2 = 60 ซึ่งผู้วิจัยได้เลือกเก็บข้อมูลทั้งสิ้น 80 คน 
โดยเพิ่มจ านวนกลุ่มตัวอย่างคิดเป็นร้อยละ 33.33 ดังนั้นสามารถท่ีจะวิเคราะห์ความแปรปรวนพหุคูณ
ได้ทั้งนี้ได้ท าการตรวจสอบความแตกต่างของคะแนนเฉลี่ยของผลสัมฤทธิ์ด้านพุทธิพิสัยและทักษะ
พิสัยระหว่างกลุ่มทดลองกับกลุ่มควบคุม โดยใช้ Wilk’s Lambda พบว่านักเรียนกลุ่มทดลองที่ได้ใช้
แผนการจัดการเรียนรู้ที่พัฒนาขึ้นร่วมกับบทเรียนออนไลน์มีคะแนนเฉลี่ยของผลสัมฤทธิ์ด้านพุทธิพิสัย
และทักษะพิสัยอย่างน้อย 1 ตัวแปร แตกต่างจากกลุ่มควบคุมที่ได้ใช้แผนการจัดการเรียนรู้แบบปกติ 
อย่างมีนัยส าคัญทางสถิติท่ีระดับ .05 
 
ตารางท่ี 4.6 ผลการวิเคราะห์ข้อมูลโดยใช้สถิติพ้ืนฐานของผลสัมฤทธิ์ทางการเรียนหลังเรียนด้านพุทธิ

พิสัยและทักษะพิสัย จ าแนกตามกลุ่มโดยแบ่งเป็นกลุ่มทดลองและกลุ่มควบคุม เรื่อง
การสร้างเว็บไซต์ด้วยภาษา HTML 5 ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 6 

กลุ่ม 
จ านวน 
นักเรียน 

พุทธิพิสัย ทักษะพิสัย 
คะแนนเต็ม 40 คะแนน คะแนนเต็ม 20 คะแนน 
x ̅ S F x ̅ S F 

กลุ่มทดลอง 42 27.36 4.72 
13.41* 

16.31 2.25 
16.53* 

กลุ่มควบคุม 39 23.38 5.59 14.25 2.74 
    * Sig. < .05 

 
จากตารางที่ 4.6 พบว่า ผลสัมฤทธิ์ทางการเรียนทั้งด้านพุทธิพิสัยและทักษะพิสัยวัด

ระหว่างกลุ่มทดลองและกลุ่มควบคุม โดยกลุ่มทดลองที่ได้เรียนตามแผนการจัดการเรียนรู้ที่พัฒนาขึ้น
มีค่าเฉลี่ยหลังเรียนสูงกว่ากลุ่มควบคุมที่เรียนด้วยแผนการจัดการเรียนรู้แบบปกติ เมื่อพิจารณาในแต่
ละด้าน พบว่า ผลสัมฤทธิ์ทางการเรียนทั้งด้านพุทธิพิสัยของกลุ่มทดลอง ( x ̅= 27.36, S = 4.72 )  
สูงกว่ากลุ่มควบคุม ( x ̅= 23.38, S = 5.59 ) เช่นเดียวกับผลสัมฤทธิ์ทางการเรียนทั้งด้านทักษะพิสัย
ของกลุ่มทดลอง ( x ̅= 16.31, S = 2.25 ) สูงกว่ากลุ่มควบคุม ( x ̅= 14.25, S = 2.74 ) อย่างมี
นัยส าคัญทางสถิติที่ระดับ .05 



 

 
 

บทท่ี 5 
สรุปผลการวิจัย อภิปรายผล และข้อเสนอแนะ 

 
ในงานวิจัย เรื่อง ผลการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์

ที่มีต่อผลสัมฤทธิ์ทางการเรียน เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ของชั้นมัธยมศึกษาปีที่ 6 
โดยมีการสรุปสาระส าคัญในการวิจัย ไดด้ังนี้ 
 
5.1 สรุปผลการวิจัย 

 
5.1.1 วัตถุประสงค์ของการวิจัย 
1. เพ่ือพัฒนาแผนจัดการเรียนรู้ที่มีการออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์ เพ่ือ

ส่งเสริมการพัฒนาผลสัมฤทธิ์ทางการเรียนรู้ด้านความรู้และทักษะ เรื่อง การสร้างเว็บไซต์ด้วยภาษา 
HTML5 ของชั้นมัธยมศึกษาปีที่ 6 

2. เพ่ือพัฒนาบทเรียนออนไลน์ เรื่อง “การสร้างเว็บไซต์ด้วยภาษา HTML5” ให้มีคุณภาพ
และประสิทธิภาพ 

3. เพ่ือเปรียบเทียบผลสัมฤทธิ์ทางการเรียนด้านความรู้และทักษะ เรื่อง การสร้างเว็บไซต์
ด้วยภาษา HTML5 ด้วยการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์ 
ระหว่างกลุ่มที่เรียนด้วยแผนการจัดการเรียนรู้ที่พัฒนาขึ้นกับกลุ่มที่เรียนด้วยแผนการจัดการเรียนรู้
แบบปกต ิ
 

5.1.2 สมมุติฐานของการวิจัย 
นักเรียนที่เรียนด้วยการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์ 

จะมีผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัยและทักษะพิสัย เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 
สูงกว่ากลุ่มที่เรียนด้วยแผนการจัดการเรียนรู้แบบปกติ 
 

5.1.3 ประชากรและกลุ่มตัวอย่าง 
ประชากร คือ นักเรียนระดับมัธยมศึกษาชั้นปีที่ 6 ภาคเรียนที่ 2 ปีการศึกษา 2561 ของ

โรงเรียนศรัทธาสมุทร จ านวน 8 ห้องเรียน คิดเป็น 298 คน 
กลุ่มตัวอย่าง คือ นักเรียนระดับมัธยมศึกษาชั้นปีที่ 6 ภาคเรียนที่ 2 ปีการศึกษา 2561 

ของโรงเรียนศรัทธาสมุทร โดยท าการเลือกด้วยวิธีการสุ่มตัวอย่างแบบแบ่งกลุ่ม (Cluster Random 
Sampling) เริ่มจากแบ่งนักเรียนตามห้อง ท าการสุ่มห้องเรียนจ านวน 3 ห้อง น ามาจัดเป็นกลุ่มหา
ประสิทธิภาพ 1 กลุ่ม และกลุ่มตัวอย่าง 2 กลุ่ม ได้แก ่

1. กลุ่มท่ีใช้ในการหาประสิทธิภาพของบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา 
HTML5 จ านวน 39 คน 

2. กลุ่มทดลองท่ีเรียนตามแผนการจัดการเรียนรู้ที่พัฒนาขึ้น จ านวน 42 คน 
3. กลุ่มควบคุมท่ีเรียนตามแผนการจัดการเรียนรู้แบบปกติ จ านวน 39 คน 
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5.1.4 เครื่องมือที่ใช้ในการวิจัย 
1. แผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน จ านวน 5 สัปดาห์ มีคุณภาพ

โดยรวมอยู่ในระดับดี ( x ̅ = 4.44, S = 0.65 ) 
2. แบบประเมินคุณภาพของแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน มีลักษณะ

เป็นมาตราส่วนประมาณค่า (Rating Scale) 5 ระดับ จ านวน 10 ข้อ ซึ่งประกอบไปด้วยการประเมิน 
5 ด้าน ได้แก่ (1) จุดประสงค์การจัดการเรียนรู้ (2) เนื้อหาสาระ (3) กิจกรรมการจัดการเรียนรู้(4) สื่อ
การจัดการเรียนรู้ และ (5) การวัดและประเมินผล 

3. บทเรียนออนไลน์ เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 เป็นเว็บไซต์ที่น าเสนอ
เนื้อหาไว้เป็นส่วนที่สามารถเข้าไปเปิดเรียนรู้ได้ตามความต้องการ มีองค์ประกอบ คือ เนื้อหา 
แบบฝึกหัด แบบทดสอบ และแบบประเมิน มีคุณภาพโดยรวมอยู่ในระดับดี ( x ̅ = 4.31, S = 0.49 ) 
เมื่อพิจารณาเป็นรายด้าน พบว่า คุณภาพด้านเนื้อหาอยู่ในระดับดีมาก ( x ̅ = 4.52, S = 0.51 ) ส่วน
คุณภาพด้านเทคนิคการผลิตสื่ออยู่ในระดับดี ( x ̅ = 4.18, S = 0.44 ) 

4. แบบประเมินคุณภาพของบทเรียนออนไลน์ มีลักษณะเป็นมาตราส่วนประมาณค่า 
(Rating Scale) 5 ระดับ ซึ่งประกอบด้วยการประเมิน 2 ด้าน ได้แก่ (1) ด้านเนื้อหา 9 ข้อ และ (2) 
ด้านเทคนิคการผลิตสื่อ จ านวน 15 ข้อ 

5. แบบวัดผลสัมฤทธิ์ด้านพุทธิพิสัย เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 เป็น
แบบทดสอบปรนัยเลือกตอบ 4 ตัวเลือก จ านวน 40 ข้อ ตอบถูกได้ 1 คะแนน ตอบผิดได้ 0 คะแนน 
ใช้เวลาท าแบบทดสอบ 50 นาที มีความเที่ยงตรงเชิงเนื้อหาจากการตรวจสอบโดยผู้ทรงคุณวุฒิ 
จ านวน 3 ท่าน ได้ค่าดัชนีความสอดคล้อง ( IOC) เท่ากับ 1.00 ทุกข้อ มีค่าความยากง่าย (p) ตั้งแต่ 
0.20 - 0.80 มีค่าอ านาจจ าแนก (r) ตั้งแต่ 0.27 - 1.00 และมีค่าความเชื่อม่ันเท่ากับ 0.879 

6. แบบวัดผลสัมฤทธิ์ด้านทักษะพิสัย เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 เป็นชิ้นงาน
ใหญ่ 1 ชิ้น ตรวจให้คะแนนโดยใช้เกณฑ์การประเมินแบบแยกส่วน มีค่าดัชนีความสอดคล้องระหว่างผู้
ประเมิน (Rater Agreement Index : RAI) เท่ากับ 0.73 ถือว่ามีความสอดคล้องสูง 

 

5.1.5 การด าเนินการทดลองและเก็บข้อมูล 
1. น าบทเรียนออนไลน์ที่พัฒนาขึ้น ไปทดลองใช้กับนักเรียนกลุ่มตัวอย่าง 1 กลุ่ม เพ่ือหา

ประสิทธิภาพของบทเรียน 
2. จัดการเรียนรู้ระหว่างนักเรียนกลุ่มทดลอง 2 กลุ่ม โดยกลุ่มแรกใช้แผนการจัดการเรียนรู้

ที่พัฒนาขึ้นกับกลุ่มทดลอง และอีกกลุ่มใช้แผนการจัดการเรียนรู้แบบปกติ 
3. ท าการทดสอบนักเรียนทั้ง 2 กลุ่ม โดยใช้แบบทดสอบวัดผลสัมฤทธิ์ทั้งด้านพุทธิพิสัย

และทักษะพิสัยที่เหมือนกัน 
4. น าผลที่ได้ไปวิเคราะห์หาข้อมูลทางสถิติ เพ่ือหาประสิทธิภาพของบทเรียน และ

เปรียบเทียบวัดผลสัมฤทธิ์ทั้งด้านพุทธิพิสัยและทักษะพิสัย เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 
ระหว่างนักเรียนทั้ง 2 กลุ่ม และน ามาใช้ในการสรุปผลการวิจัย 
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5.1.6 การวิเคระห์ข้อมูล 
1. วิเคราะห์หาคุณภาพแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน เรื่อง การสร้าง

เว็บไซต์ด้วยภาษา HTML5 ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 6 โดยการหาค่าเฉลี่ย (x)̅ และส่วน
เบี่ยงเบนมาตรฐาน (S) 

2. การวิเคราะห์หาคุณภาพของบทเรียนออนไลน์  เรื่องการสร้างเว็บไซต์ด้วยภาษา 
HTML5 โดยการหาค่าเฉลี่ย (x)̅ และส่วนเบี่ยงเบนมาตรฐาน (S) ซึ่งได้ก าหนดระดับคุณภาพของ
แผนการจัดการเรียนรู้เช่นเดียวกับแผนการจัดการเรียนรู้ 

3.  การค านวณหาประสิทธิภาพของบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา 
HTML5 ตามเกณฑ์ที่ตั้งไว้ 80/80 โดยใช้สูตร E1/E2 ซึ่งการหาประสิทธิภาพระหว่างเรียน ได้จากการ
ท าแบบฝึกหัดระหว่างเรียนตามแผนการจัดการเรียนรู้ ส่วนการหาประสิทธิภาพหลังเรียน ได้จากการ
ท าแบบทดสอบท้ายหน่วยหลังจากเรียนตามแผนการจัดการเรียนรู้แล้ว 

4.  การเปรียบเทียบค่าเฉลี่ยผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัยและทักษะพิสัย โดยการ
หาค่าเฉลี่ย (x)̅ ส่วนเบี่ยงเบนมาตรฐาน (S) และใช้สถิติการวิเคราะห์ความแปรปรวนพหุคูณ 
(MANOVA) โดยใช้สูตรของ Wilk’s Lambda 
 

5.17 สรุปผลการวิจัย 
จากผลการวิจัย เรื่อง ผลการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานร่วมกับบทเรียน

ออนไลน์ที่มตี่อผลสัมฤทธิ์ทางการเรียน เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 ของชั้นมัธยมศึกษา 
ปีที่ 6 โรงเรียนศรัทธาสมุทร ผู้วิจัยได้สรุปผลการวิจัย ดังนี้ 

1. แผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน มีคุณภาพโดยรวมอยู่ในระดับดี  
( x ̅ = 4.44, S = 0.65 ) 

2. บทเรียนออนไลน์ เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 มีคุณภาพโดยรวมอยู่ใน
ระดับดี ( x ̅ = 4.31, S = 0.49 ) เมื่อพิจารณาเป็นรายด้าน พบว่า คุณภาพด้านเนื้อหาอยู่ในระดับ 
ดีมาก ( x ̅ = 4.52, S = 0.51 ) ส่วนคุณภาพด้านเทคนิคการผลิตสื่ออยู่ ในระดับดี (  x ̅ = 4.18,  
S = 0.44 ) ส่วนประสิทธิภาพของบทเรียนออนไลน์ มีประสิทธิภาพ E1/E2 เท่ากับ 80.26/81.54 ซึ่ง
มากกว่าเกณฑ์ท่ีก าหนดไว้ คือ 80/80 

3. ผลสัมฤทธิ์ทางการเรียนทั้งด้านพุทธิพิสัยและทักษะพิสัยวัดระหว่างกลุ่มทดลองและ
กลุ่มควบคุม โดยกลุ่มทดลองที่ได้เรียนตามแผนการจัดการเรียนรู้ที่พัฒนาขึ้นมีค่าเฉลี่ยหลังเรียนสูง
กว่ากลุ่มควบคุมที่เรียนด้วยแผนการจัดการเรียนรู้แบบปกติ เมื่อพิจารณาในแต่ละด้าน พบว่า 
ผลสัมฤทธิ์ทางการเรียนทั้ งด้านพุทธิ พิสัยของกลุ่มทดลอง (  x ̅= 27.36, S = 4.72 ) สูงกว่า 
กลุ่มควบคุม  ( x ̅= 23.38, S = 5.59 ) เช่นเดียวกับผลสัมฤทธิ์ทางการเรียนทั้งด้านทักษะพิสัยของ
กลุ่มทดลอง ( x ̅= 16.31, S = 2.25 ) สูงกว่ากลุ่มควบคุม ( x ̅= 14.25, S = 2.74 ) อย่างมีนัยส าคัญ
ทางสถิติท่ีระดับ .05 
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5.2 อภิปรายผล 
 

5.2.1 การพัฒนาแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน เรื่อง การสร้าง
เว็บไซต์ด้วยภาษา HTML5 ส าหรับนักเรียนชั้นมัธยมศึกษาปีท่ี 6 

การพัฒนาแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน เรื่อง การสร้างเว็บไซต์ด้วย
ภาษา HTML5 ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 6 ซึ่งได้รับการประเมินคุณภาพของแผนการจัดการ
เรียนรู้จากผู้ทรงคุณวุฒิทั้ง 3 ท่านอยู่ในระดับดีมาก ( x ̅= 4.44, S = 0.65 ) เนื่องจากผู้วิจัยได้พัฒนา
แผนการจัดการเรียนรู้โดยมีองค์ประกอบหลักตามแนวทางของโรงเรียนศรัทธาสมุทร (2560: 
ออนไลน์) ซึ่งเป็นรูปแบบที่ทางโรงเรียนได้น ามาใช้จริงในการเรียนการสอน ซึ่งผู้วิจัยได้น ามาใช้ในการ
พัฒนาแผนการจัดการเรียนรู้ในรายวิชาการสร้างเว็บไซต์ที่ใช้ในการวิจัยจ านวน 1 หน่วยการเรียนรู้ 
โดยแบ่งออกเป็น 5 สัปดาห์ ( 10 คาบ ) ส าหรับรูปแบบในการจัดการเรียนรู้ ไดใ้ช้กรอบแนวคิดในการ
ออกแบบและพัฒนาการจัดการเรียนรู้ของ Doreen Nelson (1980: ออนไลน์) เป็นกระบวนการคิด
ย้อนกลับ 6 ขั้นตอนครึ่ง (The 6 ½ Steps of Backwards Thinking) ซ่ึงเป็นแนวคิดท่ีเน้นให้นักเรียน
สามารถแก้ไขปัญหาโดยใช้ความรู้ที่มีหรือได้เรียนรู้มาออกแบบเครื่องมือหรือวิธีแก้ไขปัญหาตาม
ความคิดของตนเอง ที่สามารถน ามาพัฒนาปรับแก้ไขข้อผิดพลาดหรือท าให้ดีขึ้นได้ตลอด เห็นได้จาก
การที่นักเรียนได้ออกแบบเว็บไซต์ตามรูปแบบที่ตนได้คิดเอาไว้จนท าให้งานเว็บไซต์ของนักเรียนแต่ละ
คนแสดงความคิดสร้างสรรค์ของตนเองที่สะท้อนความเป็นเอกลักษณ์ของเขา ซึ่งสอดคล้องกับ
งานวิจัยของ สายใจ ตะพองมาตร (2558: 417-430) ที่ได้ศึกษาเกี่ยวกับการพัฒนาแผนการจัดการ
เรียนรู้แบบซินเนคติกส์โดยใช้แนวคิดของศิลปินที่มีชื่อเสียงเพ่ือส่งเสริมความคิดสร้างสรรค์ของ
นักเรียนระดับมัธยมศึกษาตอนปลาย จากผลการวิจัยที่ว่าแผนการจัดการเรียนรู้ที่พัฒนาขึ้น มีคุณภาพ
อยู่ในระดับด ี( x ̅= 4.39, S = 0.20 ) 

 

5.2.2 การพัฒนาบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 
1. การประเมินคุณภาพบทเรียนออนไลน์ เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 
บทเรียนออนไลน์ได้รับการประเมินคุณภาพโดยรวมจากผู้ทรงคุณวุฒิทั้ง 6 ท่านอยู่ในระดับ

ดี ( x ̅= 4.31, S = 0.49 ) เมื่อพิจารณาเพ่ิมเติม คุณภาพของบทเรียนออนไลน์ในด้านเนื้อหาอยู่ใน
ระดับดีมาก ( x ̅= 4.52, S = 0.51 ) เนื่องจากผู้วิจัยได้พัฒนาเนื้อหาของบทเรียนออนไลน์โดยใช้กรอบ
แนวคิดของ ไพโรจน์ ตีรณธนากุล และคณะ (2546: 197-202) ที่ตรวจสอบตั้งแต่จุดประสงค์การ
เรียนรู้ เนื้อหาสาระ กิจกรรมการเรียนรู้ สื่อ รวมทั้งวิธีการวัดและการประเมิน ที่สอดคล้องกันอย่างมี
คุณภาพ ส่วนคุณภาพของบทเรียนออนไลน์ในด้านเทคนิคการผลิตสื่ออยู่ในระดับดี (  x ̅= 4.18,  
S = 0.44 ) เนื่องจากผู้วิจัยได้พัฒนาบทเรียนออนไลน์โดยใช้แนวคิด ADDIE Model (มนต์ชัย เทียน
ทอง. 2545: 131-136) ซึ่งมี 5 ขั้นตอนมาเป็นเกณฑ์ให้สามารถออกแบบบทเรียนออนไลน์ได้อย่างมี
ระบบและสอดคล้องอย่างมีคุณภาพ ซึ่งสอดคล้องกับงานวิจัยของศุภวิชญ์ นามบุตร (2561: 72-80) ที่
ได้ศึกษาเกี่ยวกับการพัฒนาแผนการจัดการการเรียนรู้แบบสาธิตร่วมกับแหล่งเรียนรู้ออนไลน์ เรื่อง 
การเชื่อมต่อเครือข่ายแบบเวิร์กกรุ๊ป ระดับประกาศนียบัตรวิชาชีพ พบว่าบทเรียนออนไลน์มีคุณภาพ
โดยรวมอยู่ ในระดับดี ( x ̅= 4.35, S = 0.58 ) โดยมีคุณภาพในด้านเนื้อหาอยู่ ในระดับดีมาก  
( x ̅= 4.57, S = 0.46 ) และมีคุณภาพในด้านเทคนิคการผลิตสื่ออยู่ในระดับดี ( x ̅= 4.13, S = 0.70 ) 
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2. การหาประสิทธิภาพบทเรียนออนไลน์ เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 
การวิเคราะห์หาประสิทธิภาพของบทเรียนออนไลน์ ได้น าไปทดลองกับกลุ่มตัวอย่างจ านวน 

39 คน โดยใช้สูตร E1/E2 ของ ชัยยงค์ พรหมวงศ์ (2556: 7-20) ซึ่งในที่นี้ E1 คือ ประสิทธิภาพของ
กระบวนการ ส่วน E2 คือ ประสิทธิภาพของผลลัพธ์ ซึ่งผลปรากฏว่า บทเรียนออนไลน์มีประสิทธิภาพ 
E1/E2 เท่ากับ 80.26/81.54 ซึ่งสูงกว่าเกณฑ์ที่ได้ตั้งเอาไว้ คือ 80/80 เนื่องจากการพัฒนาบทเรียน
ออนไลน์อย่างเป็นระบบโดยใช้แนวคิด ADDIE Model (มนต์ชัย เทียนทอง. 2545: 131-136) และ
ผ่านการประเมินคุณภาพทั้งในด้านเนื้อหาและด้านเทคนิคการผลิตสื่อ โดยใช้กรอบแนวคิดของ 
ไพโรจน์ ตีรณธนากุล และคณะ (2546: 197-202) ซึ่งมีคุณภาพโดยรวมอยู่ในระดับดี นอกจากนี้ยังมี
การทดลองกับนักเรียนกลุ่มท่ีเคยผ่านการเรียนเนื้อหาในบทเรียนออนไลน์มาก่อนหน้าแล้ว แบบ 1 คน 
และแบบ 3 คนที่แบ่งเป็นระดับ เก่ง กลาง และอ่อน อย่างละ 1 คน รวมทั้งมีการสัมภาษณ์นักเรียน
หลังจากการใช้งานตัวบทเรียนออนไลน์เพ่ือเป็นข้อมูลในการปรับปรุงและแก้ไขข้อบกพร่องให้สมบูรณ์
ยิ่งขึ้น ไม่ว่าเป็นการจัดเนื้อหาให้น่าสนใจ การอธิบายที่ชัดเจน ให้บทเรียนเหมาะสมกับความต้องการ
ของผู้ใช้ยิ่งขึ้น ซึ่งสอดคล้องกับงานวิจัยของ วรรณกาญจน์ บุญยก (2561: 32-40) ที่ได้ศึกษาเกี่ยวกับ
การพัฒนาบทเรียนออนไลน์ร่วมกับการจัดการเรียนรู้แบบห้องเรียนกลับด้านเพ่ือส่งเสริมผลสัมฤทธิ์
ทางการเรียนเรื่องการน าเสนอด้วยโปรแกรมคอมพิวเตอร์ของนักเรียนชั้นมัธยมศึกษาปีที่ 4 พบว่า
บทเรียนออนไลน์มีประสิทธิภาพ E1/E2 เท่ากับ 85.59/84.67 

 

5.2.3 การเปรียบเทียบผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัยและทักษะพิสัย เรื่องการ
สร้างเว็บไซต์ด้วยภาษา HTML5 ของนักเรียนชั้นมัธยมศึกษาปีท่ี 6 

การเปรียบเทียบผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัยและทักษะพิสัย เรื่องการสร้าง
เว็บไซต์ด้วยภาษา HTML5 ของนักเรียนชั้นมัธยมศึกษาปีที่ 6 ระหว่างนักเรียนกลุ่มที่เรียนด้วย
แผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานร่วมกับบทเรียนออนไลน์และนักเรียนกลุ่มที่เรียน
ด้วยแผนการจัดการเรียนรู้แบบปกติ หลังท าการทดลอง พบว่า นักเรียนกลุ่มทดลองที่เรียนด้วย
แผนการจัดการเรียนรู้ที่พัฒนาขึ้นมีค่าเฉลี่ยของผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัย ( x ̅= 27.36, S 
= 4.72 ) สูงกว่านักเรียนกลุ่มควบคุมที่เรียนด้วยแผนการจัดการเรียนรู้แบบปกติ (  x ̅= 23.38, S = 
5.59 ) เช่นเดียวกันที่นักเรียนกลุ่มทดลองได้ค่าเฉลี่ยของผลสัมฤทธิ์ทางการเรียนด้านทักษะพิสัย ( x ̅= 
16.31, S = 2.25 ) สูงกว่านักเรียนกลุ่มควบคุม ( x ̅= 14.25, S = 2.74 ) อย่างมีนัยส าคัญทางสถิติท่ี
ระดับ .05 เนื่องจากการใช้แผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน เรื่องการสร้างเว็บไซต์
ด้วยภาษา HTML5 ของนักเรียนชั้นมัธยมศึกษาปีที่ 6 ที่มีระดับคุณภาพอยู่ระดับดีมาก ซึ่งผู้วิจัยได้
พัฒนาแผนการจัดการเรียนรู้โดยมีองค์ประกอบหลักตามแนวทางของโรงเรียนศรัทธาสมุทร (2560: 
ออนไลน์) ซึ่งเป็นรูปแบบที่ทางโรงเรียนได้น ามาใช้จริงในการเรียนการสอน ร่วมกับบทเรียนออนไลน์ 
เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 ที่มีระดับคุณภาพอยู่ในระดับดี ซึ่งผ่านการประเมินคุณภาพ
ทั้งในด้านเนื้อหาและด้านเทคนิคการผลิตสื่อโดยใช้กรอบแนวคิดของ ไพโรจน์ ตีรณธนากุล และคณะ 
(2546: 197-202) และมีประสิทธิภาพของบทเรียนออนไลน์ E1/E2 ที่สูงกว่าเกณฑ์ที่ได้ตั้งเอาไว้ ซึ่ง
ผู้วิจัยได้พัฒนาบทเรียนออนไลน์โดยใช้แนวคิด ADDIE Model (มนต์ชัย เทียนทอง. 2545: 131-136) 
จากการที่ผลสัมฤทธิ์ทางการเรียนด้านพุทธิพิสัยและทักษะพิสัย เรื่องการสร้างเว็บไซต์ด้วยภาษา 
HTML5 ของนักเรียนกลุ่มทดลองที่เรียนด้วยแผนการจัดการเรียนรู้ที่พัฒนาขึ้นสูงกว่านักเรียนกลุ่ม
ควบคุมท่ีเรียนด้วยแผนการจัดการเรียนรู้แบบปกติ เป็นไปตามสมมติฐานที่ได้ตั้งเอาไว้ ไดไ้ปสอดคล้อง
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กับงานวิจัยของธิดารัตน์ ภู่พงษา (2561: 63-71) ที่ได้ศึกษาเกี่ยวกับการพัฒนาบทเรียนอีเลิร์นนิ่งตาม
แนวทฤษฎีคอนสตรัคติวิสต์ เรื่องภาษาอังกฤษเพ่ือการสื่อสาร ส าหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 
พบว่านักเรียนที่เรียนด้วยบทเรียนอีเลิร์นนิ่งตามแนวทฤษฎีคอนสตรัคติวิสต์ เรื่องภาษาอังกฤษเพ่ือ
การสื่อสารมีผลสัมฤทธิ์ทางการเรียนสูงกว่านักเรียนที่เรียนด้วยวิธีการสอนแบบปกติอย่างมีนัยส าคัญ
ทางสถิติท่ีระดับ .05 
 

5.3 ข้อเสนอแนะ 
 

5.3.1 ข้อเสนอแนะการน าผลการวิจัยไปใช้ 
1. การจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานสามารถน าไปประยุกต์ใช้กับวิชาอ่ืนที่เน้น

ความคิดสร้างสรรค์ได ้
2. บทเรียนออนไลน์ในงานวิจัยนี้สามารถน าไปใช้สอนนักเรียนในห้องเรียนพิเศษ หรือให้

นักเรียนเข้าไปใช้งานเพื่อให้เรียนรู้เพิ่มเติมด้วยตัวเองหรือสามารถทบทวนบทเรียนได้ทุกท่ีทุกเวลา 
 

5.3.2 ข้อเสนอแนะจากการท าวิจัยครั้งต่อไป 
1. ควรมีการทดลองกับกลุ่มทดลองในระดับการศึกษาอ่ืนๆ เช่น ระดับประถมศึกษา หรือ

อุดมศึกษา เพ่ือศึกษาผลลัพธ์ที่อาจจะเหมือนหรือต่างกันก็ได้ 
2. น าไปวัดผลสัมฤทธิ์ทั้งด้านพุทธิพิสัยและทักษะพิสัยในวิชาอ่ืนเพ่ิมเติม อาจจะเป็นวิชาที่

เน้นในด้านสร้างสรรค์ 
3. วัดเพ่ิมในด้านจิตพิสัยของนักเรียน เนื่องจากการจัดการเรียนรู้โดยใช้การออกแบบ 

เป็นฐาน เป็นการเน้นให้นักเรียนให้ความคิดของตนเองในการออกแบบวิธีแก้ไขปัญหา  
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เครื่องมือที่ใช้ในการวิจัย 

 
ข.1 ตัวอย่างแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน 
ข.2 ตัวอย่างแผนการจัดการเรียนรู้แบบปกติ 
ข.3 แบบประเมินคุณภาพแผนการจัดการเรียนรู้ 
ข.4 บทเรียนออนไลน์ 
ข.5 แบบประเมินคุณภาพบทเรียนออนไลน์ ด้านเนื้อหา 
ข.6 แบบประเมินคุณภาพบทเรียนออนไลน์ ด้านเทคนิคการผลิตสื่อ 
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ข.1 ตัวอย่างแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐาน 
 
กลุ่มสาระการเรียนรู้ การงานอาชีพและเทคโนโลยี ( คอมพิวเตอร์ ) ชั้นมัธยมศึกษาปีท่ี 6 
รหัสวิชา ง30209 วิชา การสร้างเว็บไซต์ จ านวน 1.0 หน่วยกิต 
หน่วยที่ 3 - เรื่อง โปรแกรมประเภท Web Editor เวลาเรียน 10 ชั่วโมง 
ผู้สอน นายอภินัทธ์ อัชชพันธ์ ภาคเรียนที่ 2 ปีการศึกษา 2561 
 
วิธีการสอน / รูปแบบการสอน / เทคนิคการสอนที่ใช้ 

1. บรรยายน า โดยใช้สื่อ Google Site และ Internet 
2. การบริหารจัดการห้องเรียนออนไลน์ Google Classroom 
3. จัดการสอนโดยใช้การออกแบบเป็นฐาน ( Design-Based Learning ) เป็นการให้นักเรียน

ทดลองท างานก่อน แล้วให้ความรู้เพื่อให้น าไปใช้ปรับปรุงตัวงานเพ่ิมเติม 
 
ผลการเรียนรู้ 

มีความรู้เกี่ยวกับการสร้างเว็บไซต์ด้วยโปรแกรม Web Editor และสร้างเว็บไซต์เบื้องต้นได้ 
 
สาระส าคัญ 

1. หลักการใช้โปรแกรมประเภท Web Editor 
2. การสร้างชิ้นงานในโปรแกรมประเภท Web Editor 

- การวางแผนขั้นตอนในการเขียนเว็บไซต์ 
- การจัดรูปแบบข้อความบนเว็บ 
- การแทรกรูปภาพนิ่งและภาพเคลื่อนไหว 
- การสร้างลิงคเ์ชื่อมโยงไฟล์และเว็บไซต์ตามความต้องการได้ 
- การสร้างตาราง และน าตารางมาใช้ในการแสดงข้อมูล ตกแต่ง และจัดหน้าเว็บได้ 
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จุดประสงค์การเรียนรู้ ( ผลการเรียนรู้ที่คาดหวัง ) 

ด้านความรู้ (Knowledge) 
1. อธิบายหลักการเขียนโปรแกรมประเภท Web Editor 
2. อธิบายขั้นตอนการสร้างชิ้นงาน โปรแกรมประเภท Web Editor 

ด้านทักษะกระบวนการ (Process) 
1. สามารถสร้างเว็บไซต์ด้วยโปรแกรม Web Editor 
2. สามารถวางแผนการเขียนเว็บไซต์ด้วยโปรแกรมประเภท Web Editor 
3. สามารถจัดรูปแบบข้อความบนเว็บโปรแกรมประเภท Web Editor 
4. สามารถแทรกรูปภาพนิ่งและภาพเคลื่อนไหวได้ 
5. สามารถสร้างลิงค์เชื่อมโยงไฟล์และเว็บไซต์ตามความต้องการได้ 
6. สามารถสร้างตาราง และน าตารางมาใช้ในการแสดงข้อมูล ตกแต่ง และจัดหน้าเว็บได้ 

ด้านคุณลักษณะอันพึงประสงค์ (Attitude) 
คุณลักษณะอันพึงประสงค์ตามหลักสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศักราช 2551 

 รักชาติ ศาสน์ กษัตริย์  ซื่อสัตย์สุจริต  มีวินัย  ใฝ่เรียนรู้ 
 อยู่อย่างพอเพียง  รักความเป็นไทย  มุ่งม่ันในการท างาน  มีจิต
สาธารณะ 

คุณลักษณะของนักเรียน ตามหลักสูตรโรงเรียนมาตรฐานสากล 
 เป็นเลิศทางวิชาการ  สื่อสาร 2 ภาษา  ล้ าหน้าทาง
ความคิด 
 ผลิตงานอย่างสร้างสรรค์  ร่วมกันรับผิดชอบต่อสังคมโลก 

เอกลักษณ์ของโรงเรียนศรัทธาสมุทร 
 ประพฤติดี มีคุณธรรม 

ด้านการอ่าน คิดวิเคราะห์และเขียน 
 การอ่าน : อ่านหลักการเขียนเว็บไซต์ด้วยโปรแกรม Web Editor  
 การคิดวิเคราะห์ : เลือกใช้เครื่องมือโปรแกรม Dreamweaver สร้างเว็บไซต์ด้วย

โปรแกรม Web Editor 
 การเขียน : สร้างเว็บไซต์ด้วยโปรแกรม Web Editor ผ่านเครือข่ายอินเตอร์เน็ต 
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ด้านสมรรถนะส าคัญของนักเรียน 
 ความสามารถในการสื่อสาร : อธิบายหลักการเขียนโปรแกรมภาษา HTML  
 ความสามารถในการคิด : แสดงความคิดเห็นและเหตุผลหลักการเขียนโปรแกรม

ภาษา HTML  
 ความสามารถในการแก้ปัญหา : กระบวนการท างาน 
 ความสามารถในการใช้ทักษะชีวิต : สามารถน าหลักการ และวิธีการในการน าเสนอข้อมูล

ผ่านเครือข่ายอินเตอร์เน็ต 
 ความสามารถในการใช้เทคโนโลยี : ศึกษาค้นคว้าเพ่ิมเติมจากเครือข่ายอินเตอร์เน็ต  

การบูรณาการ 
 บูรณาการหลักสูตรโรงเรียนมาตรฐานสากล (World-Class Standard School) 
  IS1 - การศึกษาค้นคว้าและสร้างองค์ความรู้ (Research and Knowledge Formation) 
  IS2 - การสื่อสารและการน าเสนอ (Communication and Presentation) 
  IS3 - การน าองค์ความรู้ไปใช้บริการสังคม (Social Service Activity) 
 บูรณาการข้ามกลุ่มสาระการเรียนรู้ (ระบุ) ภาษาต่างประเทศ 
 บูรณาการกับปรัชญาของเศรษฐกิจพอเพียง 
 บูรณาการกับประชาคมอาเซียน 
 บูรณาการอ่ืน ๆ (ระบุ)   

ภาระ / ชิ้นงาน / ร่องรอย / หลักฐานการเรียนรู้ 
1. แบบทดสอบก่อนเรียน ( แบบเลือกตอบ ) 
2. ใบงานที่ 1 บัตรนักเรียน 
3. ใบงานที่ 2 เนื้อเพลง 
4. ใบงานที่ 3 คลังรูปภาพ 
5. แบบทดสอบหลังเรียนส่วนที่ 1 ( แบบเลือกตอบ ) 
6. แบบทดสอบหลังเรียนส่วนที่ 2 ( ชิ้นงาน )



 
 

 

การวัดและการประเมินผล 
ผู้ประเมิน   ครูผู้สอน  นักเรียน  เพ่ือน  ผู้ปกครอง 

 

สิ่งท่ีต้องประเมิน วิธีการวัดผล เครื่องมือที่ใช้ เกณฑ์การประเมิน 

1. ด้านความรู้ 
1.1) อธิบายหลักการเขียนโปรแกรม

ประเภท Web Editor 
1.2) อธิบายขั้นตอนการสร้างชิ้นงาน 

โปรแกรมประเภท Web Editor 

1. ประเมินจากการตอบ
ค าถามในชั้นเรียน 

2. ประเมินจากท า
แบบทดสอบ 

1. แบบสังเกตพฤติกรรม 
2. แบบทดสอบหลังเรียน

ส่วนที่ 1 ( ตัวเลือก ) 

1. ความถูกต้องในการตอบค าถาม 
- ถูกต้อง 50% ขึ้นไป นักเรียนเข้าใจ 
- ถูกต้องน้อยกว่า 50% นักเรียนไม่ค่อยเข้าใจ ต้อง

ทบทวนเพิ่ม 
2. คะแนนในการท าแบบทดสอบ 

- ถูกต้อง 80% ขึ้นไป นักเรียนเข้าใจ 
- ถูกต้อง 50% - 80% นักเรียนเข้าใจเนื้อหาบางส่วน 

แต่ยังต้องทบทวนบ้าง 
- ถูกต้องน้อยกว่า 50% นักเรียนไม่ค่อยเข้าใจ ต้อง

ทบทวนเพิ่ม 
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สิ่งท่ีต้องประเมิน วิธีการวัดผล เครื่องมือที่ใช้ เกณฑ์การประเมิน 

2. ด้านทักษะกระบวนการ 
2.1) สามารถสร้างเว็บไซต์ด้วยโปรแกรม 

Web Editor 
2.2) สามารถวางแผนการเขียนเว็บไซต์

ด้วยโปรแกรมประเภท Web Editor 
2.3) สามารถจัดรูปแบบข้อความบนเว็บ

โปรแกรมประเภท Web Editor 
2.4) สามารถแทรกรูปภาพนิ่งและ

ภาพเคลื่อนไหวได้ 
2.5) สามารถสร้างลิงค์เชื่อมโยงไฟล์และ

เว็บไซต์ตามความต้องการได้ 
2.6) สามารถสร้างตาราง และน าตารางมา

ใช้ในการแสดงข้อมูล ตกแต่ง และจัด
หน้าเว็บได้ 

 

1. ประเมินจากการท า
ใบงาน 

2. ประเมินจากการท า
แบบทดสอบ 

1. ใบงานที่ 1 หน้าประวัติ
ส่วนตัว 

2. ใบงานที่ 2 หน้าเนื้อเพลง 
3. ใบงานที่ 3 หน้าคลัง

รูปภาพ 
4. แบบทดสอบหลังเรียน

ส่วนที่ 2 ( ชิ้นงาน ) 

1. คะแนนในการท าใบงาน 
 - ถูกต้อง 80% ขึ้นไป นักเรียนเข้าใจ 
 - ถูกต้องน้อยกว่า 80% นักเรียนไม่ค่อยเข้าใจ ต้อง

ทบทวนเพิ่ม 
2. คะแนนในการท าแบบทดสอบ 

 - ถูกต้อง 80% ขึ้นไป นักเรียนเข้าใจ 
 - ถูกต้อง 50% - 80% นักเรียนเข้าใจเนื้อหาบางส่วน แต่

ยังต้องทบทวนบ้าง 
 - ถูกต้องน้อยกว่า 50% นักเรียนไม่ค่อยเข้าใจ ต้อง

ทบทวนเพิ่ม 
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สิ่งท่ีต้องประเมิน วิธีการวัดผล เครื่องมือที่ใช้ เกณฑ์การประเมิน 

3. ด้านคุณลักษณะอันพึงประสงค์ 
3.1) ตามหลักสูตรแกนกลางการศึกษาขั้น

พ้ืนฐาน พุทธศักราช 2551 
3.2) คุณลักษณะของนักเรียน ตาม

หลักสูตรโรงเรียนมาตรฐานสากล 
3.3) เอกลักษณ์ของโรงเรียนศรัทธาสมุทร 
3.4) ด้านการอ่าน คิดวิเคราะห์และเขียน 
3.5) ด้านสมรรถนะส าคัญของนักเรียน 
3.6) การบูรณาการ 
 

1. สังเกตพฤติกรรม 
 - การเข้าชั้นเรียน 
 - การส่งงาน 
 - การสร้างชิ้นงาน 
 - การใช้งานโปรแกรม 

1. แบบประเมินพฤติกรรม 
2. ใบงานที่ 1 หน้าประวัติ

ส่วนตัว 
3. ใบงานที่ 2 หน้าเนื้อเพลง 
4. ใบงานที่ 3 หน้าคลัง

รูปภาพ 

1. คะแนนจากการส ารวจ 
 - ให้คะแนน 3 ถ้าอยู่ในระดับ "ดี" 
 - ให้คะแนน 3 ถ้าอยู่ในระดับ "พอใช้" 
 - ให้คะแนน 3 ถ้าอยู่ในระดับ "ปรับปรุง" 
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กิจกรรมการเรียนรู้ ( สัปดาห์ท่ี 1 ) 

ขั้นน า 
1. นักเรียนท าการกล่าวทักทายครูและเตรียมตัวในการเรียน ( 5 นาที ) 
2. นักเรียนลงชื่อรายงานตัวใน Google Classroom ( 10 นาที ) 

ขั้นสอน 
3. นักเรียนเข้าสู่บทเรียนที่ 1 โดยท าการเข้าที่ Google Classroom ในหัวข้อชื่อ “บทเรียนที่ 

1” โดยการเข้าที่เว็บไซต์ การสร้างเว็บไซต์ภาษา HTML 5 เบื้องต้น ( 10 นาที ) 
4. นักเรียนท าการศึกษาเนื้อหาในบทเรียนที่ 1 พร้อมกับการลองท าโดยใช้โปรแกรม Adobe 

Dreamweaver ( 65 นาที ) 
ขั้นสรุป 

5. ครูตรวจสอบการลงชื่อของนักเรียน ( 2 นาที ) 
6. ครตูรวจสอบการท าแบบทดสอบก่อนเรียนของนักเรียน ( 3 นาที ) 
7. ครูเปิดโอกาสให้นักเรียนสอบถามเพ่ิมเติม ( 10 นาที ) 

 
สื่อและแหล่งการเรียนรู้ 

1. Internet 
2. Google Classroom ( URL: https://classroom.google.com/ ) 
3. เว็บไซต์ การสร้างเว็บไซต์ภาษา HTML 5 เบื้องต้น ( URL: gg.gg/sth-html5 ) 
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แบบสังเกตพฤติกรรมการเรียนของนักเรียนเป็นรายบุคคล 
กลุ่มที่ .……. 

ค าชี้แจง ผู้สอนสังเกตการท างานของนักเรียน โดยการท าเครื่องหมายถูก  ลงในช่องที่ตรงกับ 
ความเป็นจริง 

    พฤติกรรม 
 
 
 
 
ชื่อ-สกุล 

ความสนใจ
ในการเรียน 

การมีส่วน
ร่วมแสดง
ความคิดเห็น
ในการ
อภิปราย 

การรับฟัง
ความคิดเห็น
ของผู้อ่ืน 

การตอบ
ค าถาม 

ความ
รับผิดชอบ
ต่องานที่
ได้รับ
มอบหมาย 

รวม
คะ 
แนน 

3 2 1 3 2 1 3 2 1 3 2 1 3 2 1 15 
1 …………                 
2 …………                 
3 …………                 
4 …………                 
5 …………                 
6 …………                 
7 …………                 
8 ………                 
9 …………                 
10 …………                 
 
เกณฑ์การประเมิน 

ให้คะแนน 3 ถ้าอยู่ในระดับดี 
ให้คะแนน 2 ถ้าอยู่ในระดับพอใช้  
ให้คะแนน 1       ถ้าอยู่ในระดับต้องปรับปรุง 

 
 
 ลงชื่อ…………………………………………………………. 
 (…………………………………………..) 
 ผู้ประเมิน 
 วันที่  / /  
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บันทึกผลหลังการจัดการเรียนรู้ 
สัปดาห์ที่   

 

ผลการเรียนรู้ที่เกิดขึ้นกับนักเรียน 
  
  
  
ปัญหา / อุปสรรค 
  
  
  
ข้อเสนอแนะ / แนวทางแก้ไข 
  
  
  
 

  ลงช่ือ  ………………………………..… ผู้สอน 
 (…………………………………………..) 
 วันที่  / /  

        
 

ข้อเสนอแนะ 
  
  
  
 

 ลงช่ือ  …………………………….……………… 
 (…………………………………………..) 
 ต าแหน่ง …………………………….……………… 
 วันที่  / /  
 
 ลงช่ือ  …………………………….………………  ลงช่ือ  …………………………….……………… 
 (…………………………………………..)  (…………………………………………..) 

ต าแหน่ง …………………………….……………… ต าแหน่ง …………………………….……………… 
 วันที่  / /  วันที่  / /  
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ข.2 ตัวอย่างแผนการจัดการเรียนรู้แบบปกติ 
 
กลุ่มสาระการเรียนรู้ การงานอาชีพและเทคโนโลยี ( คอมพิวเตอร์ ) ชั้นมัธยมศึกษาปีท่ี 6 
รหัสวิชา ง30209 วิชา การสร้างเว็บไซต์ จ านวน 1.0 หน่วยกิต 
หน่วยที่ 3 - เรื่อง โปรแกรมประเภท Web Editor เวลาเรียน 10 ชั่วโมง 
ผู้สอน นายอภินัทธ์ อัชชพันธ์ ภาคเรียนที่ 2 ปีการศึกษา 2561 
 
วิธีการสอน / รูปแบบการสอน / เทคนิคการสอนที่ใช้ 

1. บรรยายน า โดยใช้สื่อ Power Point และ Internet 
2. การบริหารจัดการห้องเรียนออนไลน์ Google Classroom 
3. จัดการสอนแบบบรรยาย พร้อมมีการหยุดและตั้งค าถามกับนักเรียนเป็นระยะ 

 
วันที่ใช้สอน  วันที่ 13 - 19 ธันวาคม พ.ศ. 2561 
 
ผลการเรียนรู้ 

3. มีความรู้เกี่ยวกับการสร้างเว็บไซต์ด้วยโปรแกรม Web Editor และสร้างเว็บไซต์เบื้องต้นได้ 
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จุดประสงค์การเรียนรู้ ( ผลการเรียนรู้ที่คาดหวัง ) 

ด้านความรู้ (Knowledge) 
อธิบายหลักการสร้างเว็บไซต์ด้วยโปรแกรม Web Editor 

ด้านทักษะกระบวนการ (Process) 
1. สามารถวางแผนการเขียนเว็บไซต์ด้วยโปรแกรมประเภท Web Editor 
2. สามารถจัดรูปแบบหน้าเว็บด้วยโปรแกรมประเภท Web Editor 

ด้านคุณลักษณะอันพึงประสงค์ (Attitude) 
คุณลักษณะอันพึงประสงค์ตามหลักสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศักราช 2551 

 รักชาติ ศาสน์ กษัตริย์  ซื่อสัตย์สุจริต  มีวินัย  ใฝ่เรียนรู้ 
 อยู่อย่างพอเพียง  รักความเป็นไทย  มุ่งม่ันในการท างาน  มีจิต
สาธารณะ 

คุณลักษณะของนักเรียน ตามหลักสูตรโรงเรียนมาตรฐานสากล 
 เป็นเลิศทางวิชาการ  สื่อสาร 2 ภาษา  ล้ าหน้าทาง
ความคิด 
 ผลิตงานอย่างสร้างสรรค์  ร่วมกันรับผิดชอบต่อสังคมโลก 

เอกลักษณ์ของโรงเรียนศรัทธาสมุทร 
 ประพฤติดี มีคุณธรรม 

ด้านการอ่าน คิดวิเคราะห์และเขียน 
 การอ่าน : อ่านหลักการเขยีนเว็บไซต์ด้วยโปรแกรม Web Editor  
 การคิดวิเคราะห์ : วางแผนออกแบบเว็บไซต์ด้วยโปรแกรม Web Editor  
 การเขียน : เขียนรูปแบบหน้าเว็บด้วยโปรแกรมประเภท Web Editor  

ด้านสมรรถนะส าคัญของนักเรียน 
 ความสามารถในการสื่อสาร : อธิบายหลักการเขียนโปรแกรมภาษา HTML  
 ความสามารถในการคิด : แสดงความคิดเห็นและเหตุผลหลักการเขียนโปรแกรม

ภาษา HTML  
 ความสามารถในการแก้ปัญหา : กระบวนการท างาน 
 ความสามารถในการใช้ทักษะชีวิต : สามารถน าหลักการ และวิธีการในการน าเสนอข้อมูล

ผ่านเครือข่ายอินเตอร์เน็ต 
 ความสามารถในการใช้เทคโนโลยี : ศึกษาค้นคว้าเพ่ิมเติมจากเครือข่ายอินเตอร์เน็ต  
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การบูรณาการ 
 บูรณาการหลักสูตรโรงเรียนมาตรฐานสากล (World-Class Standard School) 
  IS1 - การศึกษาค้นคว้าและสร้างองค์ความรู้ (Research and Knowledge Formation) 
  IS2 - การสื่อสารและการน าเสนอ (Communication and Presentation) 
  IS3 - การน าองค์ความรู้ไปใช้บริการสังคม (Social Service Activity) 
 บูรณาการข้ามกลุ่มสาระการเรียนรู้ (ระบุ) ภาษาต่างประเทศ 
 บูรณาการกับปรัชญาของเศรษฐกิจพอเพียง 
 บูรณาการกับประชาคมอาเซียน 
 บูรณาการอ่ืน ๆ (ระบุ)   
 

ภาระ / ชิ้นงาน / ร่องรอย / หลักฐานการเรียนรู้ 
ไม่มี 

 
การวัดและการประเมินผล 

ผู้ประเมิน 
  ครูผู้สอน  นักเรียน  เพ่ือน  ผู้ปกครอง 
สิ่งท่ีต้องประเมิน วิธีการวัดผล ประเด็นที่ประเมิน เกณฑ์การให้คะแนน ผู้ประเมิน 
1. ด้านความรู้ 1. ประเมินผล

จากค้นคว้าหา
ข้อมูลผ่าน
เครือข่าย
อินเตอร์เน็ต 
 

1. การค้นคว้า
ข้อมูลผ่าน
เครือข่าย
อินเตอร์เน็ต 

1. นักเรียนตอบค าถาม
ในชั้นเรียนได้ ไม่ต่ ากว่า
ร้อยละ 80 
 

ครูผู้สอน 

2. ด้านทักษะ
กระบวนการ 

1. ประเมินจาก
การปฏิบัติ 

1. ขั้นตอน
กระบวนการ
ปฏิบัติงาน 
 

1. นักเรียนปฏิบัติงาน
ได้ตามขั้นตอนและ
กระบวนการ ได้
คะแนนในการ
ปฏิบัติงานไม่น้อยกว่า
ร้อยละ 80 
 

ครูผู้สอน 
เพ่ือน 

3. ด้าน
คุณลักษณะอัน
พึงประสงค์ 
 

1. สังเกต
พฤติกรรม 

1. ประเมินผลจาก
การท างาน 

1. นักเรียนได้คะแนน
จากการประเมินผลงาน
ไม่น้อยกว่าร้อยละ 80 

ครูผู้สอน 
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กิจกรรมการเรียนรู้ ( สัปดาห์ท่ี 8 ) 

ขั้นน า 
1. ครูกล่าวทักทาย 
2. นักเรียนลงชื่อรายงานตัวใน Google Classroom 
3. ครูทบทวนเนื้อหาของสัปดาห์ที่ผ่านมา 
4. ครูและนักเรียนเปิดประเด็นค าถามเกี่ยวกับการจัดหน้าเว็บ 

ขั้นสอน 
5. ครูน าเข้าสู่บทเรียนด้วยเนื้อหาเรื่อง “การจัดเตรียมหน้าเว็บ” โดยใช้สื่อ Power Point 
6. ครแูละนักเรียนถามตอบค าถามเก่ียวกับเรื่องที่เรียน 

ขั้นสรุป 
7. ครูตรวจสอบการลงชื่อของนักเรียน 
8. ครูเปิดโอกาสให้นักเรียนสอบถามเพ่ิมเติม 

 
สื่อและแหล่งการเรียนรู้ 

1. สื่อ Power Point เรื่อง “การจัดเตรียมหน้าเว็บ” ( ใบความรู้ที่ 4 ) 
2. Internet 
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สื่อ Power Point เรื่อง “การจัดเตรียมหน้าเว็บ” ( ใบความรู้ที่ 4 ) 
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แบบสังเกตพฤติกรรมการเรียนของนักเรียนเป็นรายบุคคล 
กลุ่มที่ .……. 

ค าชี้แจง ผู้สอนสังเกตการท างานของนักเรียน โดยการท าเครื่องหมายถูก  ลงในช่องที่ตรงกับ 
ความเป็นจริง 

    พฤติกรรม 
 
 
 
 
ชื่อ-สกุล 

ความสนใจ
ในการเรียน 

การมีส่วน
ร่วมแสดง
ความคิดเห็น
ในการ
อภิปราย 

การรับฟัง
ความคิดเห็น
ของผู้อ่ืน 

การตอบ
ค าถาม 

ความ
รับผิดชอบ
ต่องานที่
ได้รับ
มอบหมาย 

รวม
คะ 
แนน 

3 2 1 3 2 1 3 2 1 3 2 1 3 2 1 15 
1 …………                 
2 …………                 
3 …………                 
4 …………                 
5 …………                 
6 …………                 
7 …………                 
8 ………                 
9 …………                 
10 …………                 
 
เกณฑ์การประเมิน 

ให้คะแนน 3 ถ้าอยู่ในระดับดี 
ให้คะแนน 2 ถ้าอยู่ในระดับพอใช้  
ให้คะแนน 1       ถ้าอยู่ในระดับต้องปรับปรุง 

 
 
 ลงชื่อ…………………………………………………………. 
 (…………………………………………..) 
 ผู้ประเมิน 
 วันที่  / /  
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บันทึกผลหลังการจัดการเรียนรู้ 
สัปดาห์ที่   

 

ผลการเรียนรู้ที่เกิดขึ้นกับนักเรียน 
  
  
  
ปัญหา / อุปสรรค 
  
  
  
ข้อเสนอแนะ / แนวทางแก้ไข 
  
  
  
 

  ลงช่ือ  ………………………………..… ผู้สอน 
 (…………………………………………..) 
 วันที่  / /  

        
 

ข้อเสนอแนะ 
  
  
  
 

 ลงช่ือ  …………………………….……………… 
 (…………………………………………..) 
 ต าแหน่ง …………………………….……………… 
 วันที่  / /  
 
 ลงช่ือ  …………………………….………………  ลงช่ือ  …………………………….……………… 
 (…………………………………………..)  (…………………………………………..) 

ต าแหน่ง …………………………….……………… ต าแหน่ง …………………………….……………… 
 วันที่  / /  วันที่  / /  
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ข.3 แบบประเมินคุณภาพแผนการจัดการเรียนรู้โดยใช้การออกแบบเป็นฐานที่มีต่อ 
ผลสัมฤทธิ์ทางการเรียน เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 ของชั้นมัธยมศึกษาปีที่ 6 

 

ค าชี้แจง กรุณาพิจารณาคุณภาพของแผนการจัดการเรียนรู้ตามรายการประเมิน แล้วตอบโดยการ
ท าเครื่องหมาย ✓ ลงในช่องคะแนนที่ตรงกับความคิดเห็นของท่าน 

 

5 = ดีมาก 4 = ดี 3 = ปานกลาง 2 = พอใช้ 1 = ควร
ปรับปรุง 

 

รายการประเมิน 
คะแนน 

หมายเหตุ 
5 4 3 2 1 

ด้านจุดประสงค์การจัดการเรียนรู้ 

1. ความถูกต้องของจุดประสงค์กบัเนื้อหา             

2. ความสอดคล้องของจุดประสงค์กับเนื้อหา             
ด้านเนื้อหาสาระ 

1. ความถูกต้องของเนื้อหา             
2. ความครบถ้วนสมบูรณ์ของเนื้อหา             
3. ความชัดเจนของเนื้อหา             

ด้านกิจกรรมการเรียนรู ้
1. ความน่าสนใจของกิจกรรมการเรียนรู ้             
2. ความเหมาะสมของกิจกรรมการเรียนรู้ตามจุดประสงค์             

ด้านสื่อการเรียนรู ้
1. ความความเหมาะสมของสื่อการเรียนรู้             

ด้านการวัดและประเมินผล 
1. ความถูกต้องของการวัดและประเมินผล             
2. ความเหมาะสมของการวดัและประเมินผล             

ด้านองค์ประกอบของแผนการจดัการเรียนรู้ 
1. ความครบถ้วนขององค์ประกอบแผนการจดัการเรียนรู้             
2 ความสอดคล้องสัมพันธ์กันขององค์ประกอบแผนการ
จัดการเรียนรู ้

            

 

ข้อเสนอแนะเพิ่มเติม 
  
  
  
 

ลงช่ือ   ผู้ทรงคุณวุฒิ 
( ) 
   /   /    
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ข.4 ตัวอย่างบทเรียนออนไลน์ 

 

 
ภาพที่ ข.1 หน้าแรกของเว็บไซต์ เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 

URL: https://gg.gg/sth-html5  
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ภาพที่ ข.2 หน้าแบบทดสอบตัวเลือกของเว็บไซต์ เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 
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ภาพที่ ข.3 หน้าบทเรียนของเว็บไซต์ เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 
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ภาพที่ ข.4 หน้าบทเรียนของเว็บไซต์ ส่วนเนื้อหา เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 
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ภาพที่ ข.5 หน้าแบบประเมินเว็บไซต์ เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 
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ภาพที่ ข.6 หน้าแบบฝึกหัดท้ายบท เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5  
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ช.5 แบบประเมินคุณภาพบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5  

( ด้านเนื้อหา ) 
 

ค าชี้แจง กรุณาพิจารณาคุณภาพด้านเนื้อหาของบทเรียนออนไลน์ตามรายการประเมิน แล้วตอบ
โดยการท าเครื่องหมาย ✓ ลงในช่องคะแนนที่ตรงกับความคิดเห็นของท่าน 

 

5 = ดีมาก 4 = ดี 3 = ปานกลาง 2 = พอใช้ 1 = ควร
ปรับปรุง 

 

รายการประเมิน 
คะแนน 

หมายเหตุ 
5 4 3 2 1 

1. ความเหมาะสมของเนื้อหาในบทเรียน             

2. ความสอดคล้องระหว่างวัตถุประสงค์กับเนื้อหา
ในบทเรียน 

            

3. ความยากง่ายของเนื้อหาในบทเรียนที่
เหมาะสมกับนักเรียน 

            

4. ความถูกต้องของเนื้อหาในบทเรียน             
5. ความชัดเจนของภาษาที่ใช้ในบทเรียน             

6. ความเหมาะสมของจ านวนตัวอย่างในบทเรียน             

7. ความเหมาะสมของปริมาณข้อสอบหรือ
แบบทดสอบในบทเรียน 

            

8. รูปภาพสามารถสื่อความหมายที่เก่ียวข้องกับ
เนื้อหาได้อย่างชัดเจน 

            

9. ความสอดคล้องของรูปภาพหรือสื่อประกอบ
กับเนื้อหาในบทเรียน 

            

 

ข้อเสนอแนะเพิ่มเติม 
  
  
  
  
 

ลงช่ือ   ผู้ทรงคุณวุฒิ 
( ) 
   /   /    
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ข.6 แบบประเมินคุณภาพบทเรียนออนไลน์ เรื่อง การสร้างเว็บไซต์ด้วยภาษา HTML5 

( ด้านเทคนิคการผลิตสื่อ ) 
 

ค าชี้แจง กรุณาพิจารณาคุณภาพด้านด้านเทคนิคการผลิตสื่อของบทเรียนออนไลน์ตามรายการ
ประเมิน แล้วตอบโดยการท าเครื่องหมาย ✓ ลงในช่องคะแนนที่ตรงกับความคิดเห็นของ
ท่าน 

 

5 = ดีมาก 4 = ดี 3 = ปานกลาง 2 = พอใช้ 1 = ควร
ปรับปรุง 

 

รายการประเมิน 
คะแนน 

หมายเหตุ 
5 4 3 2 1 

ด้านตัวอักษร 
1. ความเหมาะสมของขนาดตัวอักษร             
2. ความชัดเจนและอ่านง่ายของรูปแบบตัวอักษร             
3. ความเหมาะสมของสีตัวอักษรและสีของพ้ืนที่
ใช้ 

            

4. ความถูกต้องของข้อความตามหลักภาษา             
ด้านภาพนิ่ง 

1. ความเหมาะสมของขนาดภาพ             
2. ความเหมาะสมของสี             
3. ความชัดเจนของภาพ             

4. ความเหมาะสมของรูปภาพที่ใช้ในการสื่อ
ความหมาย 

            

ด้านเสียง  
1. ความเหมาะสมของน้ าเสียงที่ใช้ในการบรรยาย             
2. ความชัดเจนของเสียงบรรยาย             

ด้านปฏิสัมพันธ์  
1. ความง่ายและสะดวกในการควบคุมบทเรียน             

2. ความเหมาะสมของการเชื่อมโยงเนื้อหาภายใน
หน่วยการเรียน 

            

3. ความเหมาะสมของการเชื่อมโยงระหว่าง
บทเรียนแต่ละหน่วยการเรียน 
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รายการประเมิน 
คะแนน 

หมายเหตุ 
5 4 3 2 1 

ด้านแบบทดสอบ 

1. ความเหมาะสมของรูปแบบการน าเสนอ
แบบทดสอบและแบบฝึกหัดท้าย 

            

2. ความเหมาะสมของรูปแบบการรายงานผลการ
ทดสอบและแบบฝึกหัดท้ายหน่วย 

            

 
ข้อเสนอแนะเพิ่มเติม 
  
  
  
  
  
  
  
  
  
  
  
 

ลงช่ือ   ผู้ทรงคุณวุฒิ 
( ) 
   /   /   
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ข.7 แบบวัดผลสัมฤทธิ์ด้านพุทธิพิสัย 
 
ผลการเรียนรู้ 
1. มีความรู้เกี่ยวกับการสร้างเว็บไซต์ด้วยภาษา HTML และสร้างเว็บไซต์ภาษา HTML เบื้องต้นได้  

( ข้อที่ 1 - 15 ) 
2. มีความรู้เกี่ยวกับการสร้างเว็บไซต์ด้วยโปรแกรม Web Editor และสร้างเว็บไซต์เบื้องต้นได้  

( ข้อที่ 16 - 40 ) 
 

ค าชี้แจง  ข้อสอบฉบับนี้มีทั้งหมด 40 ข้อ ให้นักเรียนระบายทึบด้วยดินสอ 2B ลงในกระดาษค าตอบ 
ข้อที่เห็นว่าถูกต้องที่สุดเพียงข้อเดียว 

 
 
  
 1. ไฟล์ที่แสดงหน้าเว็บไซต์มีนามสกุลตามข้อใด 

1) .jar 2) .css 
3) .php 4) .html 

 
  2. ข้อใดต่อไปนี้คือลักษณะ Tag ภาษา HTML 

1) html…/html 
2) (html)…(/html) 
3) ?html?…?/html? 
4) <html>…</html> 

 
 3. แท็กใดต่อไปนี้ใช้ในการแสดงชื่อที่แถบหัว

เรื่องบนเว็บเบราเซอร์ 
1) <html> ... </html> 
2) <head> ... </head> 
3) <title> ... </title>  
4) <body> ... </body> 

 
  4. แท็กในข้อใดต่อไปนี้ใช้ในการก าหนดส่วน

เนื้อหาของเว็บ 
1) <html> ... </html> 
2) <head> ... </head> 
3) <title> ... </title>  
4) <body> ... </body> 

 
 

 
  5. แท็ก <table> ใช้ท าอะไรในหน้าเว็บ 

1) แสดงรูปภาพ 2) แสดงลิ้งค์ 
3) ขึ้นบรรทัดใหม่ 4) สร้างตาราง 

 
  6. &nbsp; ใช้ท าอะไรในการเขียนหน้าเว็บ 

1) ขีดเส้นใต้ 2) เว้นช่องว่าง 
3) ปรับตัวอักษร 4) แสดงข้อความ

เลื่อน 
 
  7. การใส่ Attribute ตามข้อใดในแท็ก <font> 

สามารถเปลี่ยนขนาดของตัวอักษรได้ 
1) <font size="..."> 
2) <font text="..."> 
3) <font face="..."> 
4) <font color="..."> 

 
  8. ถ้าจะใส่ข้อมูลต่างๆในหน้าเว็บ จะต้องใส่ใน

ไฟล์ html ในแท็กตามข้อใดต่อไปนี้ 
1) <title> ... </title> 
2) <body> ... </body> 
3) <table> ... </table> 
4) <marquee> ... </marquee> 
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  9. จากแท็กท่ีก าหนดให้ต่อไปนี้ 

<body background="bg.jpg"> 
เป็นแท็กค าสั่งที่ใช้งานบนหน้าเว็บตามข้อใด 
1) ใส่สีพ้ืนหลังของหน้าเว็บ 
2) ใส่สีข้อความบนหน้าเว็บ 
3) ใส่รูปภาพประกอบหน้าเว็บ 
4) ใส่รูปภาพพ้ืนหลังของหน้าเว็บ 

 
10. Attribute ในแท็ก <body> ข้อใดที่

สามารถใส่สีพ้ืนหลังได้ 
1) <body bgcolor="red"> 
2) <body bgcolor="FF0000"> 
3) <body background="bg.jpg">  
4) <body background=images/bg> 

 
11. การใส่ Attribute ตามข้อใดในแท็ก <img> 

สามารถแสดงภาพจากเครื่องคอมพิวเตอร์ได้ 
1) <img src=man.png> 
2) <img src="man.png"> 
3) <img src=images/man.png> 
4) <img src="images/"man.png"> 

 
12. แท็ก <a href="index.html"> … </a>

สามารถสร้าง Hyperlink ที่เกิดผลตามข้อใด 
1) เปิดดูรูปภาพบนเว็บ 
2) เปิดหน้าเว็บไซต์นอก 
3) เปิดหน้าเดิมใหม่อีกครั้ง  
4) เปิดไฟล์ HTML ในเครื่อง 

 
13. แท็ก <a href="panda.gif"> … </a>

สามารถสร้าง Hyperlink ที่เกิดผลตามข้อใด 
1) เปิดดูรูปภาพบนเว็บ 
2) เปิดหน้าเว็บไซต์นอก 
3) เปิดหน้าเดิมใหม่อีกครั้ง  
4) เปิดไฟล์ HTML ในเครื่อง 

 
 

 
14. การสร้าง Hyperlink ตามแท็ก 

<a ref="https://www.facebook.com"> 
… </a> สามารถท าให้เกิดผลตามข้อใดได้ 
1) เปิดดูรูปภาพบนเว็บ 
2) เปิดหน้าเว็บไซต์นอก 
3) เปิดหน้าเดิมใหม่อีกครั้ง  
4) เปิดไฟล์ HTML ในเครื่อง 

 
 

ภาพนี้ใช้ส าหรับ 
ข้อที่ 15 

 
 
 
 
 
15. สมมุติให้นักเรียนสร้างหน้าเว็บขึ้นมา 1 หน้า 

โดยมีรายละเอียดดังภาพด้านบน ในไฟล์ 
html จะต้องเขียนโค๊ดตามข้อใดต่อไปนี้ 
1) <html><body bgcolor="lightblue"> 

ชื่อ-นามสกลุ<br>  ชั้น<br>  เลขที่<br> 
<img src="man.gif"> </body> 
</html> 

2) <html> <body bgcolor="lightblue">
ชื่อ-นามสกลุ<hr>  ชั้น<hr>  เลขที<่hr> 
<img src="man.gif"> </body> 
</html> 

3) <html> <body 
background="bg.png">ชื่อ-นามสกุล
<br>  ชั้น<br>  เลขที่<br><img 
src="man.gif"> </body> 
</html> 

4) <html> <body background="bg.png">
ชื่อ-นามสกลุ<hr>  ชั้น<hr>  เลขที่
<hr><img src="man.gif"> </body> 
</html> 
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16. โปรแกรม Dreamweaver เป็นโปรแกรม

ประเภทใด 
1) Text Editor 2) Web Editor 
3) Image Editor 4) Media Editor 

 
17. ในการสร้างเว็บไซต์ ไฟล์แรกท่ีสร้างต้องมีชื่อ

ตามข้อใดก่อนเสมอ 
1) index.html 2) name.html 
3) home.html 4) www.html 

 
18. ภายในโปรแกรม Adobe Dreamweaver 

CS6 โหมดใดที่ปรับให้แสดงเฉพาะโค๊ดของ
หน้าเว็บ 
1) โหมด Life 2) โหมด Spilt 
3) โหมด Code 4) โหมด Design 

 
19. ภายในโปรแกรม Adobe Dreamweaver 

CS6 โหมดใดที่ปรับให้แสดงทั้งโค๊ดและการ
ออกแบบเว็บ 
1) โหมด Life 2) โหมด Spilt 
3) โหมด Code 4) โหมด Design 

 
20. ภายในโปรแกรม Adobe Dreamweaver 

CS6 โหมดใดที่ปรับให้แสดงทั้งโค๊ดและการ
ออกแบบเว็บ 
1) โหมด Life 2) โหมด Spilt 
3) โหมด Code 4) โหมด Design 

 
21. การเพิ่มรูปภาพบนหน้าเว็บ ในโปรแกรม 

Adobe Dreamweaver CS6 ต้องท า
ตามล าดับการคลิกเมนูตามข้อใด 
1) File > Image 2) Edit > Image 
3) Insert > Image 4) Modify > 

Image 
 
 
 

 
22. การแทรกตารางบนหน้าเว็บ ในโปรแกรม 

Adobe Dreamweaver CS6 ต้องท า
ตามล าดับการคลิกเมนูตามข้อใด 
1) Edit > Table 
2) Insert > Table 
3) Modify > Table 
4) Windows > Table 

 
23. การแทรกลิงค์บนหน้าเว็บ ในโปรแกรม 

Adobe Dreamweaver CS6 ต้องท า
ตามล าดับการคลิกเมนูตามข้อใด 
1) File > Hyperlink 
2) Edit > Hyperlink 
3) View > Hyperlink 
4) Insert > Hyperlink 

 
24. การปรับให้โปรแกรม Adobe 

Dreamweaver CS6 สามารถแสดงผลเป็น
ภาษาไทยได้ ข้อใดเรียงตามล าดับการคลิก
เมนูได้ถูกต้อง 
1) Edit > Page Properties > 

Appearance 
2) Modify > Page Properties > 

Appearance  
3) Edit > Page Properties > 

Title/Encoding  
4) Modify > Page Properties > 

Title/Encoding 
 
25. การท าข้อความให้เป็นหัวข้อในโปรแกรม 

Adobe Dreamweaver CS6 ต้องไปปรับที่
หัวข้อตามข้อใดในแถบ Properties 
1) ID 2) Link 
3) Class 4) Format 
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ภาพนี้ใช้ส าหรับข้อที่ 26 
 
 
 
 
 
 
26. จากรูปภาพด้านบน เมื่อคลิกท่ีรูปภาพแล้ว 

จะปรากฏจุดสีด าทั้ง 3 จุดขึ้น มีไว้ใช้ตามข้อ
ใด 
1) ใส่ขอบในรูปภาพ 
2) ปรับองศารูปภาพ 
3) ปรับขนาดรูปภาพ 
4) ปรับต าแหน่งรูปภาพ 

 
ภาพนี้ใช้ส าหรับข้อที่ 27 
 
 
 
 
27. จากรูปภาพด้านบน เมื่อคลิกท่ีตารางแล้ว 

จะปรากฏจุดสีด าทั้ง 3 จุดขึ้น มีไว้ใช้ตามข้อ
ใด 
1) ปรับองศาตาราง 
2) ปรับขนาดตาราง 
3) ก าหนดขอบตาราง 
4) ปรับต าแหน่งรูปภาพ 

 
28. การปรับตารางในโปรแกรม Dreamweaver 

ที่แถบ Properties ด้านล่างของโปรแกรม 
ข้อใดใช้ในการแยกตาราง 

1)  2)  

3)  4)  
 
 

 
29. การปรับตารางในโปรแกรม Dreamweaver 

ที่แถบ Properties ด้านล่างของโปรแกรม 
ข้อใดใช้ในการปรับต าแหน่งข้อมูลในตาราง 

1)  2)  

3)  4)  
 
30. ภายในโปรแกรม Adobe Dreamweaver 

CS6 เมื่อคลิกโหมด Life หน้าจอฝั่ง Design 
จะแสดงผลตามข้อใด 
1) แสดงผลโหมด Design ที่สามารถแก้

ข้อมูลได้ตามปกติ 
2) แสดงผลโหมด Design แบบปกติ แต่ไม่

สามารถแก้ไขข้อมูลได้ 
3) แสดงผลคล้ายกับการเปิดหน้าเว็บ แต่

ไม่สามารถแก้ไขข้อมูลได้ 
4) แสดงผลคล้ายกับการเปิดหน้าเว็บ ที่ยัง

สามารถแก้ไขได้ตามปกติ 
 
31. การข้ึนบรรทัดใหม่ชิดบรรทัดเดิม ใน

โปรแกรม Dreamweaver จะต้องการกด
ปุ่มบนคีย์บอร์ดตามข้อใดต่อไปนี้ 
1) Enter 2) Ctrl + Enter 
3) Shift + Enter 
4) Ctrl + Shift + Enter 

 
32. การข้ึนบรรทัดใหม่มีช่องว่างระหว่างบรรทัด 

ในโปรแกรม Dreamweaver จะต้องการกด
ปุ่มบนคีย์บอร์ดตามข้อใดต่อไปนี้ 
1) Enter 2) Ctrl + Enter 
3) Shift + Enter 
4) Ctrl + Shift + Enter 
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33. การกดปุ่มระหว่าง “Enter” กับ “Shift + 

Enter” บนคีย์บอร์ด ในโปรแกรม 
Dreamweaver จะท าให้แสดงผลโหมด 
Design ต่างหรือไม่ ตามข้อใด 
1) ไม่ต่างกัน เพราะว่าเป็นการขึ้นบรรทัด

ใหม่แบบธรรมดาบนหน้าเว็บเหมือนกัน 
2) ไม่ต่างกัน เพราะว่าเป็นการสร้างย่อหน้า

ใหม่แทนการข้ึนบรรทัดใหม่บนหน้าเว็บ
เหมือนกัน 

3) ต่างกัน คือ Enter เป็นการขึ้นบรรทัด
ใหม ่ส่วน Shift + Enter เป็นการสร้าง
ย่อหน้าใหม่แทน 

4) ต่างกัน คือ Shift + Enter เป็นการขึ้น
บรรทัดใหม่ ส่วน Enter เป็นการสร้าง
ย่อหน้าใหม่แทน 

 
34. การเว้นวรรค 1 ครั้ง ในโปรแกรม 

Dreamweaver จะต้องการกดปุ่มบน
คีย์บอร์ดตามข้อใดต่อไปนี้ 
1) Spacebar 
2) Ctrl + Spacebar 
3) Shift + Spacebar 
4) Ctrl + Shift + Spacebar 

 
35. การเว้นวรรคหลายๆ ครั้ง ในโปรแกรม 

Dreamweaver จะต้องการกดปุ่มบน
คีย์บอร์ดตามข้อใดต่อไปนี้ 
1) Spacebar 
2) Ctrl + Spacebar 
3) Shift + Spacebar 
4) Ctrl + Shift + Spacebar 

 
 
 
 
 
 

 
36. การปรับตัวอักษรใน Modify > Page 

Properties > Appearance (CSS) 
โปรแกรม Dreamweaver จะท าให้
ตัวอักษรตามข้อใดแสดงผล 
1) ตัวอักษรจ านวนหนึ่งค า 
2) ตัวอักษรในบรรทัดเดียวกัน 
3) ตัวอักษรทั้งหมดในหน้าเว็บ 
4) ตัวอักษรจ านวนหนึ่งย่อหน้า  

 
ภาพนี้ใช้ส าหรับข้อที่ 37 
 
 
 
37. การสร้างตารางให้ได้ตามภาพด้านบน ต้อง

ก าหนดจ านวนแถวและคอลัมน์ในตารางตาม
ข้อใด 
1) แถว 5 ช่อง คอลัมน์ 5 ช่อง 
2) แถว 3 ช่อง คอลัมน์ 3 ช่อง 
3) แถว 3 ช่อง คอลัมน์ 5 ช่อง 
4) แถว 5 ช่อง คอลัมน์ 3 ช่อง 

 
38. การใส่พ้ืนหลังบนหน้าเว็บจาก Properties 

> Appearance (CSS) กับ Appearance 
(HTML) ในโปรแกรม Dreamweaver 
ต่างกันหรือไม่ เพราะเหตุใด 
1) ไม่ต่างกัน เพราะว่าการปรับตัวใดตัว

หนึ่งจะไปขึ้นอีกตัวหนึ่งด้วย 
2) ไม่ต่างกัน เพราะว่าสามารถเลือกปรับได้

ทั้งสีและรูปภาพเหมือนกัน 
3) ต่างกัน คือ ใน CSS เป็นการใส่รูปภาพ

พ้ืนหลัง แต่ใน HTML เป็นการใส่สีพ้ืน
หลัง 

4) ต่างกัน คือ ใน HTML เป็นการใส่
รูปภาพพ้ืนหลัง แต่ใน CSS เป็นการใส่สี
พ้ืนหลัง 
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39. การบันทึกไฟล์ HTML ในโปรแกรม 

Dreamweaver ครั้งต่อไป การเลือก
ระหว่าง Save กับ Save as ต่างกันหรือไม่ 
เพราะเหตุใด 
1) ไม่ต่างกัน เนื่องจากเป็นการสร้างไฟล์

ใหม่เก็บงานที่ท าไว้เป็นครั้งแรก 
2) ไม่ต่างกัน เนื่องจากเป็นการบันทึกลงไป

ในไฟล์ชื่อว่า "untitle_1.html" ทันที 
3) ต่างกัน เพราะ Save จะบันทึกงานซ้ า

ไฟล์เดิม แต่ Save as จะให้สร้างไฟล์
ใหม่ทุกครั้ง 

4) ต่างกัน เพราะ Save as จะบันทึกงาน
ซ้ าไฟล์เดิม แต่ Save จะให้สร้างไฟล์
ใหม่ทุกครั้ง 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
ภาพนี้ใช้ส าหรับข้อที่ 40 

 

 

40. จากสถานการณ์ท่ีให้นักเรียนสร้างหน้าเว็บ
ขึ้นมา 1 หน้า ซึ่งมีรายละเอียดดังภาพ โดย
ใช้โปรแกรม Dreamweaver ต้องท าตาม
ขั้นตอนตามข้อใด 
1) Insert > Table ขนาดแถว 4 คอลัมน์ 5 

เลือกช่องตารางที่แถว 1 ทั้งหมดมาผสาน 
เลือกช่องตารางที่คอลัมน์ 1 ที่เหลือมา
ผสาน 
เลือกช่องตารางที ่2×3 มาผสานแบบ 3×2 

2) Insert > Table ขนาดแถว 5 คอลัมน์ 4 
เลือกช่องตารางที่แถว 1 ทั้งหมดมาผสาน 
เลือกช่องตารางที่คอลัมน์ 1 ที่เหลือมา
ผสาน 
เลือกช่องตารางที่ 3×3 มาผสานแบบ 2×2 

3) Insert > Table ขนาดแถว 4 คอลัมน์ 5 
เลือกช่องตารางที่คอลัมน์ 1 ทัง้หมดมา
ผสาน 
เลือกช่องตารางที่แถว 1 ที่เหลือมาผสาน 
เลือกช่องตารางที ่3×2 มาผสานแบบ 2×3 

4) Insert > Table ขนาดแถว 5 คอลัมน์ 4 
เลือกช่องตารางที่คอลัมน์ 1 ทัง้หมดมา
ผสาน 
เลือกช่องตารางที่แถว 1 ที่เหลือมาผสาน 
เลือกช่องตารางที ่2×2 มาผสานแบบ 3×3 
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ข.8 แบบวัดผลสัมฤทธิ์ด้านทักษะพิสัย 

 
แบบทดสอบ - เว็บไซต์ของเรา ( เดี่ยว ) 

 

 

ชื่อ - นามสกุล   ชั้น   เลขที ่
  
 

 

ค าสั่ง : 1. นักเรียนสร้างแฟ้มใหม่ในหน้า Desktop ตั้งชื่อด้วยเลขชั้น ห้อง เลขที ่เช่น 
“6101” 
: 2. ให้นักเรียนหารูปภาพมาเก็บไว้ในแฟ้มที่สร้าง 
: 3. นักเรียนสร้างไฟล์เว็บ 3 ไฟล์ ได้แก่ 

- ไฟล์ที่ 1 ชื่อ “index.html” เป็นหน้าบัตรนักเรียน 
- ไฟล์ที่ 2 ชื่อ “song.html” เป็นหน้าเนื้อเพลง 
- ไฟล์ที่ 3 ชื่อ “gallery.html” เป็นหน้า Gallery รูปภาพ 1 หมวด 

โดยให้มีรายละเอียดดังนี้ 
- แฟ้มตั้งชื่อถูกต้อง 
- ทั้ง 3 ไฟล์ มีเนื้อหาตามท่ีก าหนด อย่างน้อย 5 บรรทัด 
- มีการตกแต่ง เพ่ิมสีสัน ในช่องตาราง 
- ใน 3 ไฟล์ มีหน้าพ้ืนหลังสี 1 ไฟล์ และมีหน้าพื้นหลังรูปภาพ 1 หน้า 
- มีรูปภาพตรงตามเนื้อหาอย่างน้อย 8 รูป 

 + ภาพคน 1 ภาพ (ไม่จ าเป็นต้องเป็นภาพตัวเอง) 
 + ภาพเคลื่อนไหว 1 ภาพ + ภาพพ้ืนหลัง 1 ภาพ 
 + ภาพตามหมวด 3 ภาพ 
 + ภาพหน้าปกอัลบั้มตรงเพลง 1 ภาพ  
 + ภาพนักร้องหรือวงดนตรีเพลง 1 ภาพ 

- ลิงคส์ามารถเชื่อมโยงไปกลับกันทั้ง 3 หน้าได้ รวมทั้งมีลิงค์ไปยังเว็บไซต์
แหล่งข้อมูล 

 + หน้า song มีลิงค์ไปแหล่งที่หาของเนื้อเพลง 1 ลิงค์ 
 + หน้า gallery มีลิงค์ไปแหล่งที่มาภาพ 3 ลิงค์ และลิงค์คลิกดูภาพ 3 

ลิงค ์
: 4. ให้ส่งภายในคาบเรียน เป็นไฟล์สกุล .rar ทาง Google Classroom 
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ตัวอย่าง 
 

 
ภาพตัวอย่างชิ้นงาน หน้า index.html 

 

 
ภาพตัวอย่างชิ้นงาน หน้า gallery.html 
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ตัวอย่าง (ต่อ) 
 

 
ภาพตัวอย่างชิ้นงาน หน้า song.html 



 
 

 

เกณฑ์การประเมิน ชิ้นงานเว็บไซต์ 
 

ประเด็น 
ครบ ได้ / มี ไม่ได้ / ไม่มี คะแนน 
2 1 0 เต็ม ได้ 

1. การส่งงาน 

  
ใส่ชื่อในงาน และส่งตรงเวลา ใส่ชื่อในงาน แต่ส่งเกินเวลา ไม่ได้ใส่ชื่อในงาน และส่งเกินเวลา 

2   
  ส่งตรงเวลา แต่ไม่ได้ใส่ชื่อในงาน   

2. ไฟล์งาน 
 - ชื่องานตรง ชื่อตรงตามก าหนดครบ บางไฟล์ตั้งชื่อไม่ตรง ไม่ได้ตั้งชื่อไฟล์ตามที่ระบุ 2   

 - ไฟล์มีครบ มีไฟล์ครบตามก าหนด ส่งไฟล์มาเพียงบางส่วน 
ส่งไฟล์มานับรวมแล้ว น้อยกว่า 3 
ไฟล์ 

2   

3. ชิ้นงาน 

 - องค์ประกอบ 
มีองค์ประกอบในงานตามก าหนด
ครบ 

ขาดองค์ประกอบบางอย่างในงาน 
มีองค์ประกอบในงานรวมแล้ว น้อย
กว่า 4 อย่าง 

2   

 - การท างาน 
ไฟล์สามารถท างานได้ตามก าหนด
ครบ 

ไฟล์สามารถท างานได้ แต่ไม่ครบ
ตามก าหนด 

ไฟล์ไม่สามารถท างานได้ตามก าหนด 2   

รวม 10   
 

ช่วงคะแนน ได้ 
0 - 4 ปรับปรุง 
 5 - 7  พอใช้ 
 8 - 10  ดี 

123 
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ภาคผนวก ค 
รายละเอียดการวิเคราะห์ข้อมูล 

 
ค.1 ผลการประเมินคุณภาพของแผนการจัดการเรียนรู้ 
ค.2 ผลการประเมินคุณภาพของบทเรียนออนไลน์ ด้านเนื้อหา 
ค.3 ผลการประเมินคุณภาพของบทเรียนออนไลน์  

ด้านเทคนิคการผลิตสื่อ 
ค.4 ผลการหาประสิทธิภาพของบทเรียนออนไลน์ 
ค.5 ผลการวิเคราะห์เพื่อเลือกข้อสอบ ในแบบทดสอบวัดผล

สัมฤทธิ์ด้านพุทธิพิสัย 
ค.6 ผลการวิเคราะห์ความเชื่อม่ัน (RAI) ของเกณฑ์การประเมิน 

ในแบบทดสอบวัดผลสัมฤทธิ์ด้านทักษะพิสัย 
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ค.1 ผลการประเมินคุณภาพของแผนการจัดการเรียนรู้ 

 
ตารางท่ี ค.1 ผลการวิเคราะห์ของการประเมินคุณภาพของแผนการจัดการเรียนรู้โดยใช้การออกแบบ

เป็นฐาน เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 

รายการประเมิน 
ผู้ทรงคุณวุฒิ ระดับความคิดเห็น ระดับ

คุณภาพ 1 2 3 x ̅ SD 
1. ด้านจุดประสงค์การจัดการเรียนรู้ 4.50 0.55 ดี 
1.1) ความถูกต้องของจุดประสงค์กับ
เนื้อหา 

5 5 4 4.67 0.58 ดีมาก 

1.2) ความสอดคล้องของจุดประสงค์กับ
เนื้อหา 

5 4 4 4.33 0.58 ดี 

2. ด้านเนื้อหาสาระ 4.56 0.53 ดีมาก 
2.1) ความถูกต้องของเนื้อหา 4 5 5 4.67 0.58 ดีมาก 
2.2) ความครบถ้วนสมบูรณ์ของเนื้อหา 4 5 5 4.67 0.58 ดีมาก 
2.3) ความชัดเจนของเนื้อหา 4 4 5 4.33 0.58 ดี 
3. ด้านกิจกรรมการเรียนรู้ 4.33 0.82 ดี 
3.1) ความน่าสนใจของกิจกรรมการเรียนรู้ 5 4 3 4.00 1.00 ดี 
3.2) ความเหมาะสมของกิจกรรมการ
เรียนรู้ตามจุดประสงค์ 

5 5 4 4.67 0.58 ดีมาก 

4. ด้านสื่อการเรียนรู้ 4.67 0.58 ดีมาก 
4.1) ความความเหมาะสมของสื่อการ
เรียนรู้ 

5 5 4 4.67 0.58 ดีมาก 

5. ด้านการวัดและประเมินผล 4.33 0.82 ดี 
5.1) ความถูกต้องของการวัดและ
ประเมินผล 

4 5 3 4.00 1.00 ดี 

5.2) ความเหมาะสมของการวัดและ
ประเมินผล 

5 5 4 4.67 0.58 ดีมาก 

6. ด้านองค์ประกอบของแผนการจัดการเรียนรู้ 4.33 0.82 ดี 
6.1) ความถูกต้องของการวัดและ
ประเมินผล 

5 5 4 4.67 0.58 ดีมาก 

6.2) ความเหมาะสมของการวัดและ
ประเมินผล 

5 4 3 4.00 1.00 ดี 

รวม 4.44 0.65 ดี 
  



126 
 

 

 
ค.2 ผลการประเมินคุณภาพของบทเรียนออนไลน์ ด้านเนื้อหา 

 
ตารางท่ี ค.2 ผลการวิเคราะห์ของการประเมินคุณภาพของบทเรียนออนไลน์ เรื่องการสร้างเว็บไซต์

ด้วยภาษา HTML5 ด้านเนื้อหา 

รายการประเมิน 
ผู้ทรงคุณวุฒิ ระดับความคิดเห็น ระดับ

คุณภาพ 1 2 3 x ̅ S 
1. ความเหมาะสมของเนื้อหาในบทเรียน 5 5 4 4.67 0.58 ดีมาก 

2. ความสอดคล้องระหว่างวัตถุประสงค์กับ
เนื้อหาในบทเรียน 

5 4 4 4.33 0.58 ดี 

3. ความยากง่ายของเนื้อหาในบทเรียนที่
เหมาะสมกับนักเรียน 

5 4 4 4.33 0.58 ดี 

4. ความถูกต้องของเนื้อหาในบทเรียน 5 5 4 4.67 0.58 ดีมาก 
5. ความชัดเจนของภาษาที่ใช้ในตัว
บทเรียน 

5 5 4 4.67 0.58 ดีมาก 

6. ความจ าเป็นและความเหมาะสมของ
ตัวอย่างในบทเรียน 

5 4 4 4.33 0.58 ดี 

7. ความเหมาะสมของปริมาณข้อสอบหรือ
แบบทดสอบในบทเรียน 

5 5 4 4.67 0.58 ดีมาก 

8. รูปภาพสามารถสื่อความหมายที่
เกี่ยวข้องกับเนื้อหาได้อย่างชัดเจน 

4 5 4 4.33 0.58 ดี 

9. ความสอดคล้องของรูปภาพหรือสื่อ
ประกอบกับเนื้อหาในบทเรียน 

5 5 4 4.67 0.58 ดีมาก 

รวม 4.52 0.58 ดีมาก 
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ค.3 ผลการประเมินคุณภาพของบทเรียนออนไลน์ ด้านเทคนิคการผลิตสื่อ 
 
ตารางท่ี ค.3 ผลการวิเคราะห์ของการประเมินคุณภาพของบทเรียนออนไลน์ เรื่องการสร้างเว็บไซต์

ด้วยภาษา HTML5 ด้านเทคนิคการผลิตสื่อ 

รายการประเมิน 
ผู้ทรงคุณวุฒิ ระดับความคิดเห็น ระดับ

คุณภาพ 1 2 3 x ̅ S 
1. ด้านตัวอักษร 4.17 0.29 ดี 
1.1) ความเหมาะสมของขนาดตัวอักษร 4 4 4 4.00 0.00 ดี 

1.2) ความชัดเจนและอ่านง่ายของรูปแบบ
ตัวอักษร 

5 4 4 4.33 0.58 ดี 

1.3) ความเหมาะสมของสีตัวอักษรและสี
ของพ้ืนที่ใช้ 

4 5 4 4.33 0.58 ดี 

1.4) ความถูกต้องของข้อความตามหลัก
ภาษา 

4 4 4 4.00 0.00 ดี 

2. ด้านภาพนิ่ง 4.50 0.43 ดี 
2.1) ความเหมาะสมของขนาดภาพ 5 5 4 4.67 0.58 ดีมาก 
2.2) ความเหมาะสมของสี 4 4 4 4.00 0.00 ดี 
2.3) ความชัดเจนของภาพ 5 5 4 4.67 0.58 ดีมาก 

2.4) ความเหมาะสมของรูปภาพที่ใช้ในการ
สื่อความหมาย 

5 5 4 4.67 0.58 ดีมาก 

3. ด้านเสียง  4.00 0.00 ดี 

3.1) ความเหมาะสมของน้ าเสียงที่ใช้ในการ
บรรยาย 

4 4 4 4.00 0.00 ดี 

3.2) ความชัดเจนของเสียงบรรยาย 4 4 4 4.00 0.00 ดี 
4. ด้านปฏิสัมพันธ์  4.11 0.19 ดี 

4.1) ความง่ายและสะดวกในการควบคุม
บทเรียน 

4 4 4 4.00 0.00 ดี 

4.2) ความเหมาะสมของการเชื่อมโยง
เนื้อหาภายในหน่วยการเรียน 

4 4 4 4.00 0.00 ดี 

4.3) ความเหมาะสมของการเชื่อมโยง
ระหว่างบทเรียนแต่ละหน่วยการเรียน 

5 4 4 4.33 0.58 ดี 
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ตารางท่ี ค.3 (ต่อ) 

รายการประเมิน 
ผู้ทรงคุณวุฒิ ระดับความคิดเห็น ระดับ

คุณภาพ 1 2 3 X S 
5. ด้านแบบทดสอบ 3.83 0.29 ดี 
5.1) ความเหมาะสมของรูปแบบการ

น าเสนอแบบทดสอบและแบบฝึกหัด
ท้าย 

3 4 4 3.67 0.58 ดี 

5.2) ความเหมาะสมของรูปแบบการ
รายงานผลการทดสอบและ
แบบฝึกหัดท้ายหน่วย 

4 4 4 4.00 0.00 ดี 

รวม 4.12 0.24 ดี 
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ค.4 ผลการหาประสิทธิภาพของบทเรียนออนไลน์ 

 
ตารางท่ี ค.4 ผลการวิเคราะห์ของการหาประสิทธิภาพของบทเรียนออนไลน์ เรื่องการสร้างเว็บไซต์

ด้วยภาษา HTML5  

คนที่ 

แบบทดสอบระหว่างเรียน 
รวม 

( เต็ม 20 คะแนน ) 
แบบทดสอบหลังเรียน  
( เต็ม 20 คะแนน ) 

1 2 3 
( เต็ม 5 
คะแนน ) 

( เต็ม 5 
คะแนน ) 

( เต็ม 10 
คะแนน ) 

1 5 5 7 17 14 
2 5 5 9 19 17 
3 5 5 6 16 18 
4 5 5 8 18 18 
5 5 5 8 18 18 
6 5 3 6 14 18 
7 3 5 5 13 16 
8 5 5 7 17 20 
9 5 5 5 15 16 
10 5 5 5 15 15 
11 5 5 5 15 20 
12 5 5 7 17 18 
13 3 5 7 15 10 
14 5 5 8 18 18 
15 3 5 8 16 15 
16 5 5 5 15 18 
17 5 5 8 18 18 
18 5 3 7 15 15 
19 5 5 5 15 13 
20 5 5 7 17 16 
21 5 5 7 17 15 
22 5 5 6 16 14 
23 5 3 7 15 17 
24 3 5 8 16 10 
25 5 5 7 17 17 
26 5 5 6 16 17 
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ตารางท่ี ค.4 (ต่อ) 

คนที่ 

แบบทดสอบระหว่างเรียน 
รวม 

( เต็ม 20 คะแนน ) 
แบบทดสอบหลังเรียน  
( เต็ม 20 คะแนน ) 

1 2 3 
( เต็ม 5 
คะแนน ) 

( เต็ม 5 
คะแนน ) 

( เต็ม 10 
คะแนน ) 

27 5 5 7 17 18 
28 
29 

5 
5 

5 
5 

5 
6 

15 
16 

13 
14 

30 3 5 7 15 14 
31 5 5 5 15 18 
32 5 5 5 15 15 
33 5 5 5 15 18 
34 5 5 7 17 17 
35 5 5 8 18 17 
36 5 5 6 16 17 
37 5 5 7 17 18 
38 5 3 5 13 18 
39 5 5 7 17 18 

รวม 626 636 
 

จากการเก็บรวบรวมข้อมูลดังตารางที่ ค.4 จากกลุ่มตัวอย่างจ านวน 39 คน ( N = 39 ) 
การหาค่าประสิทธิภาพของบทเรียนออนไลน์ เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 จาก
แบบทดสอบระหว่างเรียน 3 ชิ้น ซึ่งมีคะแนนเต็มรวม 20 คะแนน ( A = 20 ) พบว่า ∑x1 = 626 และ
จากแบบทดสอบหลังซึ่งมีคะแนนเต็ม 20 คะแนน ( B = 20 ) พบว่า ∑x2 = 636 น ามาแทนในสูตร 
E1/E2 ได้ดังต่อไปนี้ 
 

ประสิทธิภาพของกระบวนการ ( E1 )  ประสิทธิภาพของผลลัพธ์ ( E2 ) 
   

E1 = 
∑x1

NA
 × 100  E2 = 

∑x2

NB
 × 100 

   

= 
626

(39) (20)
 × 100  = 

636

(39) (20)
 × 100 

   

= 80.26  = 81.54 
 

ได้ค่าประสิทธิภาพ E1/E2 เท่ากับ 80.26/81.54 
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ค.5 ผลการวิเคราะห์เพื่อเลือกข้อสอบ ในแบบทดสอบวัดผลสัมฤทธิ์ด้านพุทธิพิสัย 

 
ตารางท่ี ค.5 ผลการวิเคราะห์ของการประเมินความเที่ยงตรงเชิงเนื้อหาของข้อสอบกับผลการเรียนรู้ 

ของแบบทดสอบวัดผลสัมฤทธิ์ด้านพุทธิพิสัย จากผู้ทรงคุณวุฒิ  

ข้อสอบ 
คะแนนความคิดเห็นของผู้เชี่ยวชาญ 

∑R IOC 
การแปล

ความหมาย คนที่ 1 คนที่ 2 คนที่ 3 
1 0 1 1 2 0.67 สอดคล้อง 
2 0 1 1 2 0.67 สอดคล้อง 
3 1 1 1 3 1.00 สอดคล้อง 
4 1 1 1 3 1.00 สอดคล้อง 
5 0 1 1 2 0.67 สอดคล้อง 
6 1 1 1 3 1.00 สอดคล้อง 
7 1 1 1 3 1.00 สอดคล้อง 
8 1 1 1 3 1.00 สอดคล้อง 
9 1 1 1 3 1.00 สอดคล้อง 
10 1 1 1 3 1.00 สอดคล้อง 
11 1 1 1 3 1.00 สอดคล้อง 
12 1 1 1 3 1.00 สอดคล้อง 
13 1 1 1 3 1.00 สอดคล้อง 
14 1 1 1 3 1.00 สอดคล้อง 
15 1 1 1 3 1.00 สอดคล้อง 
16 1 1 1 3 1.00 สอดคล้อง 
17 1 1 0 2 0.67 สอดคล้อง 
18 0 1 0 1 0.33 ปรับปรุง 
19 0 1 1 2 0.67 สอดคล้อง 
20 1 1 1 3 1.00 สอดคล้อง 
21 1 1 1 3 1.00 สอดคล้อง 
22 1 1 1 3 1.00 สอดคล้อง 
23 1 1 1 3 1.00 สอดคล้อง 
24 1 1 1 3 1.00 สอดคล้อง 
25 0 1 1 2 0.67 สอดคล้อง 
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ตารางท่ี ค.5 (ต่อ) 

ข้อสอบ 
คะแนนความคิดเห็นของผู้เชี่ยวชาญ 

∑R IOC 
การแปล

ความหมาย คนที่ 1 คนที่ 2 คนที่ 3 
26 1 1 1 3 1.00 สอดคล้อง 
27 1 1 1 3 1.00 สอดคล้อง 
28 1 1 1 3 1.00 สอดคล้อง 
29 1 1 0 2 0.67 สอดคล้อง 
30 1 0 0 1 0.33 ปรับปรุง 
31 -1 1 1 1 0.33 ปรับปรุง 
32 1 1 1 3 1.00 สอดคล้อง 
33 0 1 1 2 0.67 สอดคล้อง 
34 1 1 0 2 0.67 สอดคล้อง 
35 0 1 1 2 0.67 สอดคล้อง 
36 1 1 1 3 1.00 สอดคล้อง 
37 1 1 1 3 1.00 สอดคล้อง 
38 0 1 1 2 0.67 สอดคล้อง 
39 1 1 1 3 1.00 สอดคล้อง 
40 0 1 1 2 0.67 สอดคล้อง 
41 0 1 1 2 0.67 สอดคล้อง 
42 0 1 1 2 0.67 สอดคล้อง 
43 1 1 1 3 1.00 สอดคล้อง 
44 1 1 1 3 1.00 สอดคล้อง 
45 1 1 1 3 1.00 สอดคล้อง 
46 1 1 1 3 1.00 สอดคล้อง 
47 1 1 1 3 1.00 สอดคล้อง 
48 1 1 1 3 1.00 สอดคล้อง 
49 1 1 1 3 1.00 สอดคล้อง 
50 1 1 1 3 1.00 สอดคล้อง 
51 0 1 1 2 0.67 สอดคล้อง 
52 1 1 1 3 1.00 สอดคล้อง 
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ตารางท่ี ค.5 (ต่อ) 

ข้อสอบ 
คะแนนความคิดเห็นของผู้เชี่ยวชาญ 

∑R IOC 
การแปล

ความหมาย คนที่ 1 คนที่ 2 คนที่ 3 
53 0 1 0 1 0.33 ปรับปรุง 
54 0 1 0 1 0.33 ปรับปรุง 
55 0 1 0 1 0.33 ปรับปรุง 
56 1 1 1 3 1.00 สอดคล้อง 
57 1 1 1 3 1.00 สอดคล้อง 
58 1 1 1 3 1.00 สอดคล้อง 
59 1 1 0 2 0.67 สอดคล้อง 
60 1 1 0 2 0.67 สอดคล้อง 
61 1 1 0 2 0.67 สอดคล้อง 
62 1 1 1 3 1.00 สอดคล้อง 
63 1 1 0 2 0.67 สอดคล้อง 
64 1 1 0 2 0.67 สอดคล้อง 
65 1 1 1 3 1.00 สอดคล้อง 
66 0 1 1 2 0.67 สอดคล้อง 
67 1 1 1 3 1.00 สอดคล้อง 
68 1 1 1 3 1.00 สอดคล้อง 
69 0 1 1 2 0.67 สอดคล้อง 
70 1 1 1 3 1.00 สอดคล้อง 

 
จากตารางที่ ค.5 แสดงผลการประเมินความเที่ยงตรงเชิงเนื้อหาของข้อสอบกับผลการ

เรียนรู้ของแบบทดสอบวัดผลสัมฤทธิ์ด้านพุทธิพิสัย เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 จาก
ผู้ทรงคุณวุฒิ พบว่า มีข้อสอบที่ผ่านเกณฑ์ตั้งแต่ 0.5 ขึ้นไป จ านวนทั้งสิ้น 64 ข้อ แบ่งเป็นข้อที่มีค่า
ความเที่ยงตรงเชิงเนื้อหาเท่ากับ 1 จ านวน 42 ข้อ กับข้อที่มีค่าความเที่ยงตรงเชิงเนื้อหาเท่ากับ 0.67 
จ านวน 22 ข้อ และมีข้อสอบทีค่วรปรับปรุงแก้ไขเพ่ิมเติม จ านวนทั้งสิ้น 6 ข้อ 
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ตารางท่ี ค.6 ผลการวิเคราะห์หาความยากง่าย (p) และอ านาจจ าแนก (r) ของแบบทดสอบวัด 

ผลสัมฤทธิ์ด้านพุทธิพิสัย เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 

ข้อ 
สอบ 

ตอบ
ถูกใน
กลุ่ม
สูง 
(H) 

ตอบ
ถูกใน
กลุ่ม
ต่ า 
(L) 

ความยากง่าย อ านาจจ าแนก การน า
ข้อสอบไป

ใช้ p แปลความหมาย r แปลความหมาย 

1 19 15 0.89 ง่ายมาก 0.21 จ าแนกได้ปานกลาง ใช้ไม่ได้ 
2* 13 6 0.5 ยากเหมาะสม 0.36 จ าแนกได้สูง ใช้ได้ 
3 16 13 0.76 ค่อนข้างง่าย 0.15 จ าแนกได้ต่ า ใช้ไม่ได้ 
4* 17 6 0.61 ค่อนข้างง่าย 0.56 จ าแนกได้สูงมาก ใช้ได้ 
5 18 14 0.84 ง่ายมาก 0.21 จ าแนกได้ปานกลาง ใช้ไม่ได้ 
6 19 14 0.87 ง่ายมาก 0.26 จ าแนกได้ปานกลาง ใช้ไม่ได้ 
7* 12 7 0.50 ยากเหมาะสม 0.26 จ าแนกได้ปานกลาง ใช้ได้ 
8 19 18 0.97 ง่ายมาก 0.05 จ าแนกได้ต่ ามาก ใช้ไม่ได้ 
9* 18 11 0.76 ค่อนข้างง่าย 0.36 จ าแนกได้สูง ใช้ได้ 
10 19 18 0.97 ง่ายมาก 0.05 จ าแนกได้ต่ ามาก ใช้ไม่ได้ 
11 19 15 0.89 ง่ายมาก 0.21 จ าแนกได้ปานกลาง ใช้ไม่ได้ 
12 19 19 1 ง่ายมาก 0 ไม่มีอ านาจจ าแนก ใช้ไม่ได้ 
13* 13 7 0.53 ยากเหมาะสม 0.31 จ าแนกได้สูง ใช้ได้ 
14 13 10 0.61 ค่อนข้างง่าย 0.15 จ าแนกได้ต่ า ใช้ไม่ได้ 
15 19 18 0.97 ง่ายมาก 0.05 จ าแนกได้ต่ ามาก ใช้ไม่ได้ 
16* 13 7 0.53 ยากเหมาะสม 0.31 จ าแนกได้สูง ใช้ได้ 
16* 13 7 0.53 ยากเหมาะสม 0.31 จ าแนกได้สูง ใช้ได้ 
17* 18 12 0.79 ค่อนข้างง่าย 0.31 จ าแนกได้สูง ใช้ได้ 
18 19 18 0.97 ง่ายมาก 0.05 จ าแนกได้ต่ ามาก ใช้ไม่ได้ 
19* 16 12 0.74 ค่อนข้างง่าย 0.21 จ าแนกได้ปานกลาง ใช้ได้ 
20* 16 10 0.68 ค่อนข้างง่าย 0.31 จ าแนกได้สูง ใช้ได้ 
21 13 10 0.61 ค่อนข้างง่าย 0.15 จ าแนกได้ต่ า ใช้ไม่ได้ 
22* 8 4 0.32 ค่อนข้างยาก 0.21 จ าแนกได้ปานกลาง ใช้ได้ 
23* 13 3 0.42 ยากเหมาะสม 0.51 จ าแนกได้สูงมาก ใช้ได้ 
24 13 10 0.61 ค่อนข้างง่าย 0.15 จ าแนกได้ต่ า ใช้ไม่ได้ 
25 19 15 0.89 ง่ายมาก 0.21 จ าแนกได้ปานกลาง ใช้ไม่ได้ 
26 11 4 0.39 ค่อนข้างยาก 0.36 จ าแนกได้สูง ใช้ได้ 
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ตารางท่ี ค.6 (ต่อ) 

ข้อ 
สอบ 

ตอบ
ถูกใน
กลุ่ม
สูง 
(H) 

ตอบ
ถูกใน
กลุ่ม
ต่ า 
(L) 

ความยากง่าย อ านาจจ าแนก การน า
ข้อสอบไป

ใช้ p แปลความหมาย r แปลความหมาย 

27* 12 6 0.47 ยากเหมาะสม 0.31 จ าแนกได้สูง ใช้ได้ 
28* 16 12 0.74 ค่อนข้างง่าย 0.21 จ าแนกได้ปานกลาง ใช้ได้ 
29* 16 5 0.55 ยากเหมาะสม 0.56 จ าแนกได้สูงมาก ใช้ได้ 
30 9 1 0.26 ค่อนข้างยาก 0.41 จ าแนกได้สูงมาก ใช้ได้ 
31 19 19 1 ง่ายมาก 0 ไม่มีอ านาจจ าแนก ใช้ไม่ได้ 
32* 17 9 0.68 ค่อนข้างง่าย 0.41 จ าแนกได้สูงมาก ใช้ได้ 
33* 16 5 0.55 ยากเหมาะสม 0.56 จ าแนกได้สูงมาก ใช้ได้ 
34* 13 9 0.58 ยากเหมาะสม 0.21 จ าแนกได้ปานกลาง ใช้ได้ 
35 19 14 0.87 ง่ายมาก 0.26 จ าแนกได้ปานกลาง ใช้ไม่ได้ 
36* 13 3 0.42 ยากเหมาะสม 0.51 จ าแนกได้สูงมาก ใช้ได้ 
37* 12 6 0.47 ยากเหมาะสม 0.31 จ าแนกได้สูง ใช้ได้ 
38 19 18 0.97 ง่ายมาก 0.05 จ าแนกได้ต่ ามาก ใช้ไม่ได้ 
39* 13 0 0.34 ค่อนข้างยาก 0.67 จ าแนกได้สูงมาก ใช้ได้ 
40* 18 10 0.74 ค่อนข้างง่าย 0.41 จ าแนกได้สูงมาก ใช้ได้ 
41* 19 9 0.74 ค่อนข้างง่าย 0.51 จ าแนกได้สูงมาก ใช้ได้ 
42* 16 11 0.71 ค่อนข้างง่าย 0.26 จ าแนกได้ปานกลาง ใช้ได้ 
43* 18 11 0.76 ค่อนข้างง่าย 0.36 จ าแนกได้สูง ใช้ได้ 
44* 18 10 0.74 ค่อนข้างง่าย 0.41 จ าแนกได้สูงมาก ใช้ได้ 
45 19 12 0.82 ง่ายมาก 0.36 จ าแนกได้สูง ใช้ไม่ได้ 
46* 13 9 0.58 ยากเหมาะสม 0.21 จ าแนกได้ปานกลาง ใช้ได้ 
47* 18 12 0.79 ค่อนข้างง่าย 0.31 จ าแนกได้สูง ใช้ได้ 
48 18 14 0.84 ง่ายมาก 0.21 จ าแนกได้ปานกลาง ใช้ไม่ได้ 
49* 18 12 0.79 ค่อนข้างง่าย 0.31 จ าแนกได้สูง ใช้ได้ 
50* 18 10 0.74 ค่อนข้างง่าย 0.41 จ าแนกได้สูงมาก ใช้ได้ 
51 19 12 0.82 ง่ายมาก 0.36 จ าแนกได้สูง ใช้ไม่ได้ 
52 18 14 0.84 ง่ายมาก 0.21 จ าแนกได้ปานกลาง ใช้ไม่ได้ 
53 19 15 0.89 ง่ายมาก 0.21 จ าแนกได้ปานกลาง ใช้ไม่ได้ 
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ตารางท่ี ค.6 (ต่อ) 

ข้อ 
สอบ 

ตอบ
ถูกใน
กลุ่ม
สูง 
(H) 

ตอบ
ถูกใน
กลุ่ม
ต่ า 
(L) 

ความยากง่าย อ านาจจ าแนก การน า
ข้อสอบไป

ใช้ p แปลความหมาย r แปลความหมาย 

54 19 9 0.74 ค่อนข้างง่าย 0.51 จ าแนกได้สูงมาก ใช้ได้ 
55 13 6 0.5 ยากเหมาะสม 0.36 จ าแนกได้สูง ใช้ได้ 
56 13 10 0.61 ค่อนข้างง่าย 0.15 จ าแนกได้ต่ า ใช้ไม่ได้ 
57 19 15 0.89 ง่ายมาก 0.21 จ าแนกได้ปานกลาง ใช้ไม่ได้ 
58* 17 10 0.71 ค่อนข้างง่าย 0.36 จ าแนกได้สูง ใช้ได้ 
59* 16 10 0.68 ค่อนข้างง่าย 0.31 จ าแนกได้สูง ใช้ได้ 
60* 13 0 0.34 ค่อนข้างยาก 0.67 จ าแนกได้สูงมาก ใช้ได้ 
61 10 7 0.45 ยากเหมาะสม 0.15 จ าแนกได้ต่ า ใช้ไม่ได้ 
62* 17 6 0.61 ค่อนข้างง่าย 0.56 จ าแนกได้สูงมาก ใช้ได้ 
63* 9 1 0.26 ค่อนข้างยาก 0.41 จ าแนกได้สูงมาก ใช้ได้ 
64* 13 6 0.5 ยากเหมาะสม 0.36 จ าแนกได้สูง ใช้ได้ 
65* 12 4 0.42 ยากเหมาะสม 0.41 จ าแนกได้สูงมาก ใช้ได้ 
66* 17 10 0.71 ค่อนข้างง่าย 0.36 จ าแนกได้สูง ใช้ได้ 
67* 16 11 0.71 ค่อนข้างง่าย 0.26 จ าแนกได้ปานกลาง ใช้ได้ 
68* 15 9 0.63 ค่อนข้างง่าย 0.31 จ าแนกได้สูง ใช้ได้ 
69 15 8 0.61 ค่อนข้างง่าย 0.36 จ าแนกได้สูง ใช้ได้ 
70* 12 5 0.45 ยากเหมาะสม 0.36 จ าแนกได้สูง ใช้ได้ 

หมายเหตุ : เครื่องหมาย * หมายถึงข้อที่เลือกเป็นแบบวัดผลสัมฤทธิ์ทางด้านพุทธิพิสัย 
 

จากตารางที่ ค.6 แสดงผลการวิเคราะห์ความยากง่าย (p) และอ านาจจ าแนก (r) ของ
แบบทดสอบวัดผลสัมฤทธิ์ด้านพุทธิพิสัย ที่ผ่านการประเมินความเที่ยงตรงจากผู้ทรงคุณวุฒิมาแล้ว 
จ านวน 70 ข้อ โดยการน าแบบทดสอบไปทดลองกับนักเรียนกลุ่มทดลองที่เรียนไปก่อนหน้าแล้ว 
จ านวน 39 คน ได้ข้อสอบที่ผ่านการพิจารณาจากการตรวจสอบความยากง่าย (p) ที่มีค่าตั้งแต่ 0.2 - 
0.8 และอ านาจจ าแนก (r) ที่มีค่าตั้งแต่ 0.4 - 1 รวมทัง้สิ้น 45 ข้อ 

ส าหรับค่าความเชื่อมั่นของแบบทดสอบวัดผลสัมฤทธิ์ด้านพุทธิพิสัย ที่ได้ท าการคัดเลือก
ข้อสอบมาจ านวน 40 ข้อ จากข้อสอบทั้งหมด 70 ข้อ มีค่าความเชื่อมั่น เท่ากับ 0.879  ซึ่งมีความ
น่าเชื่อถือสูงมาก 
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หลังจากน าข้อสอบที่ผ่านการวิเคราะห์ความเที่ยงตรง (IOC) ของข้อสอบกับผลการเรียนรู้

จากผู้ทรงคุณวุฒิ ร่วมกับการวิเคราะห์หาความยากง่าย (p) กับอ านาจจ าแนก (r) แล้ว จึงได้ท าการ
เลือกข้อสอบจ านวน 40 ข้อ มาสร้างเป็นแบบทดสอบวัดผลสัมฤทธิ์ด้านพุทธิพิสัยเพ่ือน าไปใช้ในการ
วิจัยต่อไป โดยผู้วิจัยได้ท าการจ าแนกข้อสอบแต่ละข้อตามระดับพฤติกรรมและผลการเรียนรู้ที่ได้ดัง
ตารางที่ ค.7 
 
ตารางท่ี ค.7 ผลการวิเคราะห์ระดับพฤติกรรมของแบบทดสอบวัดผลสัมฤทธิ์ด้านพุทธิพิสัย เรื่องการ

สร้างเว็บไซต์ด้วยภาษา HTML5 ตามผลการเรียนรู้แต่ละข้อ 

หน่วย ผลการเรียนรู้ 

ข้อ
สอ

บ 

ระดับพฤติกรรมพุทธิพิสัย 

รู้-
จ า

 

เข
้าใ

จ 

น า
ไป

ใช
้ 

วิเ
คร

าะ
ห์ 

ปร
ะเม

ิน 

สร
้าง

สร
รค

์ 

2. ออกแบบ
และ
จัดท า
เว็บไซต์
ด้วย
ภาษา 
HTML 

2.1 บอกเกี่ยวกับการสร้าง
เว็บไซต์ด้วยภาษา HTML 
ได้ 

7 7           

2.2 อธิบายการสร้างเว็บไซต์โดย
ใช้ Source Code ภาษา 
HTML ได้ 

7   7         

2.3 สร้างเว็บไซต์ภาษา HTML 
เบื้องต้นได้ 

1     1      

3. โปรแกรม
ประเภท 
Web 
Editor 

3.1 บอกเกี่ยวกับการสร้าง
เว็บไซต์ด้วยโปรแกรม Web 
Editor ได้ 

14 14          

3.2 อธิบายหลักการกับข้ันตอน
ในการสร้างเว็บไซต์ด้วย
โปรแกรมประเภท Web 
Editor ได้ 

10   10        

3.3 สร้างเว็บไซต์เบื้องต้นได้ 1     1      
รวม 40 21 17 2 0 0 0 
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ค.6 ผลการวิเคราะห์ความเชื่อม่ัน (RAI) ของเกณฑ์การประเมิน ในแบบทดสอบวัดผลสัมฤทธิ์ด้าน

ทักษะพิสัย 
 
ตารางท่ี ค.8 คะแนนของแบบทดสอบวัดผลสัมฤทธิ์ด้านทักษะพิสัย ของนักเรียน 3 คน เรื่องการสร้าง

เว็บไซต์ด้วยภาษา HTML5 ตามผลการเรียนรู้แต่ละข้อ 

คนที่ 
คะแนนจากผู้ประเมินคนที่ 1 

ในแต่ละรายการ 
คะแนนจากผู้ประเมินคนที่ 2 

ในแต่ละรายการ 
1 2 3 4 5 1 2 3 4 5 

1 2 2 1 1 2 2 2 2 1 2 
2 2 1 1 1 1 1 1 1 1 1 
3 2 1 0 0 0 1 1 1 0 0 

 
จากข้อมูลในตารางที่ ค.8 สามารถน ามาหาค่าสัมบูรณ์ของคะแนนเบี่ยงเบนได้ตามตารางที่ 

ค.9  
 
ตารางท่ี ค.9 ค่าสัมบูรณ์ของคะแนนเบี่ยงเบน 

คนที่ 
|R1nk - R2nk| 

1 2 3 4 5 ∑ |R1nk - R2nk|N
n=1   

1 0 0 1 0 0 1 
2 1 0 0 0 0 1 
3 1 0 1 0 0 2 

 

5 

 
จากตารางที่ ค.8 ถ้าน าข้อมูลมาแทนค่าต่างๆ ลงในสูตรค านวณ จะได้ 

 

RAI = 1 - 
∑ ∑ |R1nk - R2nk|N

n=1
K
k=1

KN(I - 1)
 

 

= 1 - 
6

(5) (3) (2 - 1)
 
 

= 0.73 
 

ค่าความเชื่อมั่น ( RAI ) ของเกณฑ์การประเมิน ในแบบทดสอบวัดผลสัมฤทธิ์ด้านทักษะ
พิสัย เรื่องการสร้างเว็บไซต์ด้วยภาษา HTML5 เท่ากับ 0.73 
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